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Model and simulate electronic, mechatronic, and electrical power systems

Simscape FElectrical (formerly SimPowerSystems™ and SimFElectronics®) provides
component libraries for modeling and simulating electronic, mechatronic, and electrical
power systems. It includes models of semiconductors, motors, and components for
applications such as electromechanical actuation, smart grids, and renewable energy
systems. You can use these components to evaluate analog circuit architectures, develop
mechatronic systems with electric drives, and analyze the generation, conversion,
transmission, and consumption of electrical power at the grid level.

Simscape Electrical helps you develop control systems and test system-level performance.
You can parameterize your models using MATLAB® variables and expressions, and design
control systems for electrical systems in Simulink®. You can integrate mechanical,
hydraulic, thermal, and other physical systems into your model using components from
the Simscape family of products. To deploy models to other simulation environments,
including hardware-in-the-loop (HIL) systems, Simscape Electrical supports C-code
generation.

Simscape Electrical was developed in collaboration with Hydro-Québec of Montreal.

Key Features

» Libraries of electrical components including sensors, actuators, motors, machines,
passive devices, and semiconductor devices

* Adjustable model fidelity, including nonlinear effects, operational limits, fault
modeling, and temperature-dependent behavior

* SPICE netlist importer for converting SPICE subcircuits of discrete devices to
Simscape models

* Application-specific models, including common AC and DC electric drives, smart grids,
and renewable energy systems

» Ideal switching, discretization, and phasor simulation for faster model execution
* MATLAB based Simscape language for creating custom component models
* Support for C-code generation (with Simulink Coder™)
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Simscape Electrical Block Libraries

Simscape Electrical software includes twelve different top-level libraries. These libraries
allow you to model mechatronic systems, analog circuit architectures, and single- and
multi-phase electrical power systems. You can also develop control algorithms for these
systems within the Simulink environment by using these libraries. All of these libraries,
except Specialized Power Systems, contain blocks developed specifically for extending the
Simscape Foundation domains and are fully compatible with the Simscape technology.
Blocks in the Specialized Power Systems library function in their own domain.

Libraries Compatible with Simscape Technology

All Simscape Electrical libraries, except Specialized Power Systems, contain blocks
specifically developed to:

* Extend the Simscape Electrical domain, a single-phase electrical domain.
* Extend the Simscape Three-Phase Electrical domain, a three-phase electrical domain.

These library blocks are written in the Simscape language and are fully compatible with
the Simscape technology, including local solvers, data logging, statistics and variable
viewers, frequency analysis, and component and library customizations. To configure
Simscape Electrical models composed of these library blocks for local-solver simulation,
use the Solver Configuration block. Many of the blocks in these libraries also work with
other Simscape Foundation domains, such as the Mechanical, Magnetic, and Thermal
domains. When working with the Simscape technology compatible library blocks, you can
use these capabilities:

» Partitioning Solver

* Simscape HDL Workflow Advisor
* Simscape Results Explorer

These libraries include models of high-fidelity, nonlinear, faultable, electrothermal power
electronics. You can use these components to develop mechatronic systems and to build
behavioral models for evaluating analog circuit architectures. The libraries also include
low-fidelity models that are switched linear and optimized for fast simulation. There are
also some models that contain optional ports for thermal analysis.

You can create single-line three-phase diagrams by using the three-phase blocks because
the Three-Phase Electrical domain supports signals that contain all three phases as

1-3
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individual elements in a single vector. You can also model each phase individually, for
example, to inject a single-line-to-ground fault into your circuit, by expanding the three-
phase ports on these blocks into three separate single-phase electrical ports.

The Control library contains Simulink blocks for signal generation, mathematical
transformation, and machine control. You can use these components to develop control
systems for single- and multi-phase electrical power systems.

Through conserving ports of the same domain, you can directly connect the blocks from
these Simscape Electrical libraries to Simscape blocks from:

* Simscape Foundation libraries

* Simscape add-on products, such as Simscape Driveline™, Simscape Multibody™, and
Simscape Fluids™

Through physical signal ports, you can connect the physical blocks from these Simscape
Electrical libraries to:

* Simulink blocks, including blocks from the Control library, by using converter blocks
from the Simscape Utilities library

* Blocks from the Physical Signals library, which is in the Simscape Foundation library.

Specialized Power Systems Library

The Simscape Electrical Specialized Power Systems library contains blocks that use their
own, specialized electrical domain. The library contains models of typical power
equipment such as transformers, electric machines and drives, and power electronics. It
also contains control, measurement, and signal generation models that you can use for
developing power system control algorithms. The Specialized Power Systems
Fundamental Blocks library contains the powergui block, which provides tools for the
steady-state analysis of electrical circuits. To configure Specialized Power Systems models
for continuous-time, discrete-time, or phasor simulation, and to analyze simulation
results, use the powergui block. The powergui block is in the Specialized Power Systems
Fundamental Blocks library.

You can connect Specialized Power Systems blocks to Simulink blocks either:

* Directly, through Simulink signal input and output ports.

* Through measurement blocks from the Measurements sublibrary of the Fundamental
Blocks library.
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Access the Simscape Electrical Block Libraries

You can access the Simscape Electrical libraries from the Simulink Library Browser or
from the MATLAB command prompt.

To display the Electrical library in the Simulink Library Browser, scroll to the Simscape
node. Expand the Simscape node and then the Electrical node. Alternately, at the
MATLAB command prompt, enter this command.

ee lib
%E Sirnulink Library Browser —
C,J Enter search term
Simscape/ Electrical
*  Simscape ~
Foundation Library =
UHilities —/_: _.’_. : - -
Driveline _L. p ﬂ‘ ; ; -
¥ Electrical
C ctors & Refi
con:el ors srenees Connectors & Control Electromechanical  Integrated Circuits
ontro! ) References
Electromechanical
Integrated Circuits
Passive —Wh— -
Semiconductors & Converters - = - T
Sensors & Transducers =~
Sources
Switches & Breakers Passive Semiconductors & Sensors & Sources
Utilities Converters Transducers
Additional Components
Specialized Power Systems A
Fluids. o { 4
Multibody s
Simulink 3D Animation —
Simulink Coder " o o -
Switches & Breakers. Utilities Additicnal Specialized Power
Simulink Coder Support Package for ARM Cortex-based VEX M w Compenents P Systems
£ >

To access the sublibraries in the twelve top-level Simscape Electrical libraries, further
expand the nodes. Alternately, use the open_system command at the MATLAB command

prompt. For example, to access the sublibraries in the Connectors & References library,
enter the commands:

ee lib;
open_system('ee lib/Connectors & References')

1-5
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Systems, and Electrical Power Systems Using Simscape
Electrical
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In this section...

“Simulink Templates for Modeling with Simscape Electrical” on page 1-7
“Simscape Electrical Blocks and Ports” on page 1-7
“Machine and Transformer Source Code Examples” on page 1-8

“Plotting and Display Options for Asynchronous and Synchronous Machines” on page 1-
8

“Choosing the Right Simscape Electrical Technology” on page 1-8

“Assumptions and Limitations” on page 1-8

When you model and analyze mechatronic systems, analog circuit architectures, or
electrical power systems using Simscape Electrical, your workflow might include the
following tasks:

1 Create a Simulink model that includes components from Simscape Electrical
libraries.

In most applications, it is most natural to model the physical system using Simscape
Electrical blocks and other Simscape blocks, and then develop the controller or signal
processing algorithm in Simulink.

For more information about modeling the physical system, see “Essential Electrical
Modeling Techniques” on page 3-2.

2 Define component data by specifying electrical or mechanical properties as defined
on a datasheet.

For more information about parametrization, see “Parameterizing Blocks from
Datasheets” on page 3-16.

3 Configure the solver options.

For more information about the settings that most affect the solution of a physical
system, see “Setting Up Solvers for Physical Models” (Simscape).

4  Run the simulation.
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For more information on how to perform time-domain simulation of an electrical
system, see “Simulating an Electronic, Mechatronic, or Electrical Power System” on
page 3-9.

Simulink Templates for Modeling with Simscape Electrical

On the Simulink start page, the Simscape section has model templates that provide you
with design patterns for modeling with Simscape Electrical:

* Electrical

* Electrical Three-Phase

* Mechanical Rotational

* Mechanical Translational

Models you create from these templates have the corresponding reference block, the
required Solver Configuration block, and the frequently used Simscape-Simulink
interfacing blocks already in the Simulink canvas. The models also contain links that you
can double-click to access other blocks in the corresponding Simscape libraries.

To create a model using one of these Simscape templates:

1 Open the Simulink Start page. In the MATLAB Home tab, select the Simulink button.
Alternatively, at the command line, enter:

simulink

2 In the Simscape section, locate the templates that are preconfigured for modeling
with Simscape Electrical. Selecting a template opens a model in the Simulink Editor.
To save the model, select File > Save As.

Simscape Electrical Blocks and Ports

Simscape Electrical blocks that are written in the Simscape language are fully compatible
with Simscape technology, including the local solver, code generation, and data logging.

Simscape Electrical blocks have single-phase, composite three-phase, thermal, magnetic,
mechanical translational conserving, and mechanical rotational conserving ports. You can
use composite three-phase ports to build models corresponding to single-line diagrams of
three-phase electrical systems. Composite three-phase ports connect to other composite

three-phase ports. Electrical and mechanical rotational conserving ports connect directly
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to Simscape Foundation library components and Simscape add-on products such as
Simscape Driveline. You can use a Phase Splitter block to split a composite three-phase
port into individual electrical conserving ports.

Machine and Transformer Source Code Examples

Simscape Electrical software provides Simscape language source code examples for
machines and transformers, which you can view and customize. To access the example
blocks, type ThreePhaseExamples lib at the MATLAB command prompt.

Plotting and Display Options for Asynchronous and
Synchronous Machines

For the Machine Inertia block and the asynchronous and synchronous machine blocks in
Simscape Electrical software, you can perform some useful plotting and display actions
using the Electrical menu on the block context menu. For example, to plot torque versus
speed (both in SI units) for the Induction Machine Wound Rotor block, right-click the
block. From the block context menu, select Electrical > Plot Torque Speed (SI). The
software plots the results in a figure window.

Using other options on the Electrical menu, you can plot values in per-unit or display
base parameter values in the MATLAB Command Window. These options enable you to
tune the performance of your three-phase machine quickly.

Choosing the Right Simscape Electrical Technology

Simscape Electrical software includes two different technologies and corresponding
libraries. For a comparison of the two technologies, see “Simscape Electrical Block
Libraries” on page 1-3. Choose the Simscape Electrical technology most appropriate for
your modeling needs and, if possible, build your model using blocks exclusively from that
technology. However, if necessary, you can build a model that uses blocks from both
technologies. To do so, use blocks from the Simscape > Electrical > Specialized Power
Systems > Fundamental Blocks > Interface Elements library to interface between
them.

Assumptions and Limitations

The Simscape Electrical blocks let you perform tradeoff analyses to optimize system
design, for example, by testing various algorithms with different circuit implementations.



See Also

The library contains blocks that use either high level or more detailed models to simulate
components. Simscape Electrical does not have the capability to:

* Perform either layout (physical design) tasks, or the associated implementation tasks
such as layout versus schematic (LVS), design rule checking (DRC), parasitic
extraction, and back annotation.

* Model 3-D parasitic effects that are typically important for high-frequency
applications.

For these types of requirements, you must use an EDA package specifically designed for
the implementation of analog circuits.

See Also

Phase Splitter

More About

. “Simscape Electrical Block Libraries” on page 1-3

. “Essential Electrical Modeling Techniques” on page 3-2
. “Parameterizing Blocks from Datasheets” on page 3-16

. “Setting Up Solvers for Physical Models” (Simscape)
. “Simulating an Electronic, Mechatronic, or Electrical Power System” on page 3-9
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In this section...

“What Is the Per-Unit System?” on page 1-10

“Example 1: Three-Phase Transformer” on page 1-12

“Example 2: Asynchronous Machine” on page 1-13

“Base Values for Instantaneous Voltage and Current Waveforms” on page 1-14

“Why Use the Per-Unit System Instead of the Standard SI Units?” on page 1-14

What Is the Per-Unit System?

The per-unit system is widely used in the power system industry to express values of
voltages, currents, powers, and impedances of various power equipment. It is typically
used for transformers and AC machines.

For a given quantity (voltage, current, power, impedance, torque, etc.) the per-unit value
is the value related to a base quantity.

quantity expressed in SI units
base value

base value in p.u. =

Generally the following two base values are chosen:

* The base power = nominal power of the equipment
* The base voltage = nominal voltage of the equipment

All other base quantities are derived from these two base quantities. Once the base power
and the base voltage are chosen, the base current and the base impedance are
determined by the natural laws of electrical circuits.

base power

base current = Dbase voltage

base voltage _ (base Voltage)2
base current base power

base impedance =

For a transformer with multiple windings, each having a different nominal voltage, the
same base power is used for all windings (nominal power of the transformer). However,



Per-Unit System of Units

according to the definitions, there are as many base values as windings for voltages,
currents, and impedances.

The saturation characteristic of saturable transformer is given in the form of an
instantaneous current versus instantaneous flux-linkage curve: [i1 phil; i2 phi2; ..., in
phin].

When the per-unit system is used to specify the transformer R L parameters, the flux
linkage and current in the saturation characteristic must be also specified in pu. The
corresponding base values are

base instantaneous current = (base rms current) X 2

(base rms voltage) X /2
21 x (base frequency)

base flux linkage =

where current, voltage, and flux linkage are expressed respectively in volts, amperes, and
volt-seconds.

For AC machines, the torque and speed can be also expressed in pu. The following base
quantities are chosen:

* The base speed = synchronous speed

* The base torque = torque corresponding at base power and synchronous speed

base power (3 phases) in VA
base speed in radians/second

base torque =

Instead of specifying the rotor inertia in kg*m?, you would generally give the inertia
constant H defined as

_ kinetic energy stored in the rotor at synchronous speed in joules

H machine nominal power in VA
1 L2
23w
Pnom

The inertia constant is expressed in seconds. For large machines, this constant is around
3-5 seconds. An inertia constant of 3 seconds means that the energy stored in the
rotating part could supply the nominal load during 3 seconds. For small machines, H is
lower. For example, for a 3-HP motor, it can be 0.5-0.7 seconds.

1-11
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Example 1: Three-Phase Transformer

Consider, for example, a three-phase two-winding transformer with these manufacturer-

provided, typical parameters:

Nominal power = 300 kVA total for three phases

Nominal frequency = 60 Hz

Winding 1: connected in wye, nominal voltage = 25-kV RMS line-to-line

resistance 0.01 pu, leakage reactance = 0.02 pu

Winding 2: connected in delta, nominal voltage = 600-V RMS line-to-line

resistance 0.01 pu, leakage reactance = 0.02 pu

Magnetizing losses at nominal voltage in % of nominal current:

Resistive 1%, Inductive 1%

The base values for each single-phase transformer are first calculated:

For winding 1:

Base power

300 kVA/3 = 100e3 VA/phase

Base voltage

25 kV/sqrt(3) = 14434 V RMS

Base current

100e3/14434 = 6.928 A RMS

Base impedance

14434/6.928 = 2083 Q

Base resistance

14434/6.928 = 2083 Q

Base inductance

2083/(2r*60)= 5.525 H

For winding 2:

Base power

300 kVA/3 = 100e3 VA

Base voltage

600 V RMS

Base current

100e3/600 = 166.7 A RMS

Base impedance

600/166.7 = 3.60 Q

Base resistance

600/166.7 = 3.60 Q

Base inductance

3.60/(2m*60) = 0.009549 H
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The values of the winding resistances and leakage inductances expressed in SI units are
therefore

+ For winding 1: R1= 0.01 * 2083 = 20.83 Q; L1= 0.02*¥5.525 = 0.1105 H
+ For winding 2: R2= 0.01 * 3.60 = 0.0360 Q; L2= 0.02*0.009549 = 0.191 mH

For the magnetizing branch, magnetizing losses of 1% resistive and 1% inductive mean a
magnetizing resistance Rm of 100 pu and a magnetizing inductance Lm of 100 pu.
Therefore, the values expressed in SI units referred to winding 1 are

*+ Rm = 100*2083 = 208.3 kQ
« Lm = 100%5.525 = 552.5 H
Example 2: Asynchronous Machine

Now consider a three-phase, four-pole Asynchronous Machine block in SI units. It is rated
3 HP 220 V RMS line-to-line, 60 Hz.

The stator and rotor resistance and inductance referred to stator are

* Rs=0435Q0;Ls=2mH
* Rr=0.816Q; Lr =2 mH

The mutual inductance is Lm = 69.31 mH. The rotor inertia is J = 0.089 kg.m?.

The base quantities for one phase are calculated as follows:

Base power 3 HP*746VA/3 = 746 VA/phase

Base voltage 220 V/sqrt(3) = 127.0 V RMS

Base current 746/127.0 = 5.874 A RMS

Base impedance 127.0/5.874 = 21.62 Q

Base resistance 127.0/5.874 = 21.62 Q

Base inductance 21.62/(2m*60)= 0.05735 H = 57.35 mH

Base speed 1800 rpm = 1800*(2m)/60 = 188.5 radians/second
Base torque (three-phase) 746*3/188.5 = 11.87 newton-meters

Using the base values, you can compute the values in per-units.
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Rs= 0435 / 2162 = 0.0201 pu Ls= 2 / 5735 = 0.0349 pu
Rr= 0816 / 2162 = 0.0377 pu Lr= 2 [/ 05735 = 0.0349 pu
Lm = 69.31/57.35 = 1.208 pu

The inertia is calculated from inertia J, synchronous speed, and nominal power.

Lxj-wr 10089 x(188.5)

H= Pnom 3 X 746

= (0.7065 seconds

If you open the dialog box of the Asynchronous Machine block in pu units provided in the
Machines library of the Simscape Electrical Specialized Power Systems Fundamental
Blocks library, you find that the parameters in pu are the ones calculated.

Base Values for Instantaneous Voltage and Current
Waveforms

When displaying instantaneous voltage and current waveforms on graphs or
oscilloscopes, you normally consider the peak value of the nominal sinusoidal voltage as 1
pu. In other words, the base values used for voltage and currents are the RMS values

given multiplied by /2.

Why Use the Per-Unit System Instead of the Standard SI
Units?

Here are the main reasons for using the per-unit system:

* When values are expressed in pu, the comparison of electrical quantities with their
"normal" values is straightforward.

For example, a transient voltage reaching a maximum of 1.42 pu indicates immediately
that this voltage exceeds the nominal value by 42%.

» The values of impedances expressed in pu stay fairly constant whatever the power and
voltage ratings.

For example, for all transformers in the 3-300 kVA power range, the leakage
reactance varies approximately 0.01-0.03 pu, whereas the winding resistances vary
between 0.01 pu and 0.005 pu, whatever the nominal voltage. For transformers in the
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300 kVA to 300 MVA range, the leakage reactance varies approximately 0.03-0.12 pu,
whereas the winding resistances vary between 0.005-0.002 pu.

Similarly, for salient pole synchronous machines, the synchronous reactance Xy is
generally 0.60-1.50 pu, whereas the subtransient reactance X'y is generally 0.20-0.50

pu.

It means that if you do not know the parameters for a 10-kVA transformer, you are not
making a major error by assuming an average value of 0.02 pu for leakage reactances
and 0.0075 pu for winding resistances.

The calculations using the per-unit system are simplified. When all impedances in a
multivoltage power system are expressed on a common power base and on the nominal
voltages of the different subnetworks, the total impedance in pu seen at one bus is
obtained by simply adding all impedances in pu, without considering the transformer
ratios.
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Build and Simulate Composite and Expanded Three-
Phase Models

2-2

In this section...

“Select System Component Blocks and Build a Resistive Three-Phase Model” on page 2-
2

“Specify Simulation Parameters” on page 2-5

“Load Impedance Parameters” on page 2-6

“Specify Display Parameters” on page 2-6

“Simulate and Analyze the Resistive Three-Phase Model” on page 2-7
“Simulate and Analyze a Reactive Three-Phase Model” on page 2-7
“Create an Expanded Balanced Three-Phase Model” on page 2-8
“Create an Expanded Unbalanced Three-Phase Model” on page 2-10

“Simulate the Expanded Balanced and Unbalanced Models and Analyze the Results” on
page 2-10

In this example, you build and analyze a simple Simscape Electrical model that simulates
the behavior of a three-phase AC voltage source driving a purely resistive three-phase
load. You then modify the load in this model to change it to:

* A reactive three-phase load
* A resistive three-phase load expanded into individual phases
* An expanded three-phase load that does not have equal resistance in each phase

For the completed initial model, see Simple Three-Phase Model.

Select System Component Blocks and Build a Resistive Three-
Phase Model

1 Open the Simulink Start page. In the MATLAB Home tab, select the Simulink button.
Alternatively, at the command line, enter:

simulink

2 Inthe Simscape section, find the templates that are preconfigured for modeling with
Simscape Electrical. Select the Electrical Three-Phase template. A model that
contains these blocks opens in the Simulink canvas.
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Block Purpose Library
Scope Display phase voltages and Simulink > Sinks
currents for the three-phase
system.
Electrical Provide the ground connection Simscape > Foundation
Reference for electrical conserving ports. Library > Electrical >

Electrical Elements

PS-Simulink

Convert the physical signals to

Simscape > Utilities

Converter Simulink signals.

Simulink-PS  |Convert Simulink signals to Simscape > Utilities
Converter physical signals.

Solver Define solver settings that apply |Simscape > Utilities
Configuration |to all physical modeling blocks.

Grounded Provide an electrical ground Simscape > Electrical >
Neutral connection for each phase of the |[Connectors & References
(Three-Phase) |three-phase system.

Line Voltage |Measure the line-line voltages of |Simscape > Electrical >
Sensor a three-phase system and output |[Sensors & Transducers

(Three-Phase)

a three-element physical signal
vector.

The model also contains two links that you can double-click to access blocks from
Simscape and Simscape Electrical libraries. For more information on using templates
for modeling with Simscape Electrical, see “Modeling Analog Circuit Architectures,
Mechatronic Systems, and Electrical Power Systems Using Simscape Electrical” on

page 1-6.

Delete the Simulink-PS Converter and Line Voltage Sensor (Three-Phase) blocks.

Add these blocks to the model.

Block Purpose Library

RLC (Three- [Model the resistive, inductive, Simscape > Electrical >

Phase) and capacitive properties of the |Passive > RLC Assemblies
three-phase load.
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Block Purpose Library
Current Convert the electrical current Simscape > Electrical >
Sensor flowing in each phase of the Sensors & Transducers

(Three-Phase) |three-phase load into a physical
signal proportional to that
current.

Phase Voltage |Convert the voltage across each |Simscape > Electrical >
Sensor phase of the three-phase system |Sensors & Transducers
(Three-Phase) |into a physical signal proportional
to that voltage.

Voltage Provide an ideal three-phase Simscape > Electrical >
Source voltage source that maintains a |Sources

(Three-Phase) |sinusoidal voltage across its
output terminals, regardless of
the current flowing in the source.

5 Copy the PS-Simulink Converter and Grounded-Neutral (Three-Phase) blocks by
right-clicking them and dragging them to new locations on canvas.

6 Add a second input port to the Scope block.

a Right-click the Scope block.
b  From the context menu, select Signals & Ports > Number of Input Ports > 2
7  Connect the blocks as shown.
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T —— |
Valiages
PS-Simulink
Cormvartar

e

P5-Simulink
Converter

Currents

Scope

Solver
Canfiguration
Voltage Source Current Sensor

RLC

i
—— Electrical Reference Grounded Neutrall

Phase Violtage Sensor

Grounded Neutral

8 Remove the on-canvas annotations titled Open Simscape Library and Open Simscape
Electrical Library. Save the model using the name simplethreephasemodel.

The blocks in this model use composite three-phase ports. For more information, see
“Three-Phase Ports” on page 3-6.

Specify Simulation Parameters

As with Simscape models, you must include a Solver Configuration block in each
topologically distinct physical network. This model has a single physical network, so use
one Solver Configuration block.

1 In the Solver Configuration block, select Use local solver and set Sample time to
0.0001.

In Simscape-based models, the local solver is a sample-based solver that represents
physical network states as discrete states. For most Simscape Electrical models, the
local solver is an appropriate first choice. The solver updates block states once per
simulation time step, as determined by Sample time. For simulation of a 60-Hz AC
system, an appropriate sample time is a value in the order of 1e-4. For more
information on solver options, see Solver Configuration.
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If you prefer to use a continuous solver instead of a discrete solver, clear the Use
local solver check box in the Solver Configuration block. The simulation then uses
the Simulink solver specified in the model configuration parameters (Modeling >
Model Settings). For Simscape Electrical models, an appropriate solver choice is the
moderately stiff solver ode23t. For a 60 Hz AC system, specify a value for Max step
size in the order of 1e-4. For more information, see “Variable-Step Continuous
Explicit Solvers” (Simulink).

2 In the Simulink Editor, set the simulation Stop time to 0. 1.

Load Impedance Parameters

The RLC block models resistive, inductive, and capacitive characteristics of the three-
phase load. Using the Component structure parameter, you can specify a series or
parallel combination of resistance, inductance, and capacitance.

In the RLC block, the defaults are:

* Component structure — R.
* Resistance — 1 Q.

Using the default Component structure value, R, models a three-phase load that is
purely resistive in nature. The resistance in each phase is 1 Q.

Specify Display Parameters

Sensor blocks in the model convert the current and voltage in each phase of the three-
phase system to proportional physical signals. PS-Simulink Converter blocks convert the
physical signals into Simulink signals for the Scope block to display.

1 Of these three types of blocks, only the converter blocks have parameters. For this
example:

* Set Output signal unit of the PS-Simulink Converterl block to V. This setting
ensures that the block outputs a signal with the same magnitude as the voltage
signal that enters it.

* Set Output signal unit of the PS-Simulink Converter2 block to A. This setting
ensures that the block outputs a signal with the same magnitude as the current
signal that enters it.

2 Label the input signals to the Scope block. Double-click each line, and type the
appropriate label, Voltages or Currents, as shown in the model graphic.
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You are ready to simulate the model and analyze the results.

Simulate and Analyze the Resistive Three-Phase Model

1  Save the model.

2 Simulate the model.

3 View the phase currents and voltages. Double-click the Scope block.

4 From the scope menu, select View > Configuration Properties. Set Layout to 1-
by-2 display.

5

To scale the scope axes to the data, click the Autoscale button E

In this simulation, the Component structure parameter of the RLC (Three-Phase) block
specifies that the electrical characteristics of the three-phase load are purely resistive.
Therefore, for each phase of the three-phase system, the voltage and current remain in
phase with each other. Because the resistance in each phase is 1 Q, the magnitude of the
phase voltage is equal to the magnitude of the phase current.

Simulate and Analyze a Reactive Three-Phase Model

You can modify the model to create a reactive load. A reactive load has inductive or
capacitive characteristics.
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1  Save this version of the model using the name
simplethreephasemodel reactive.

2 Inthe RLC (Three-Phase) block, set:

* Component structure to Series RL

* Inductance to 0.002

Simulate the model.

View the simulation results. Autoscale the scope axes.

Examine the results in closer detail. For example, click the Zoom button and
drag a box over the first third of one of the plots.

The electrical characteristics of three-phase load are no longer purely resistive.
Because the load has an inductive characteristic, the current flowing in each phase
lags the voltage.

Create an Expanded Balanced Three-Phase Model

1  Open the resistive three-phase model simplethreephasemodel that you initially
created.

2 Delete the RLC (Three-Phase) block.
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Drag two copies of the Phase Splitter block into the model from the Simscape >
Electrical > Connections & References library.

Flip one of the Phase Splitter blocks horizontally. Right-click the block and select
Rotate & Flip > Flip Block > Left-Right.

Drag a Resistor element into the model from the Simscape > Foundation Library >
Electrical > Electrical Elements library.

To create space for more components, hide the Resistor element label. Right-click the
resistor and select Format > Show Block Name to clear this option.

Make two more copies of the Resistor element.
Connect the components as shown.

T
Valiages
PS-Simulink
Converter

=

FS-Simulink
Convartar

Curmrents

Solver
Configuration

N\ /-

Voltage Source Current Sensor

Phase Splitter Phase Splitter1

'
—— Electrical Reference ! Grounded Neutrall

Phasa Violtage Sensor

Grounded Neutral

Save this version of the modified model using the name
simplethreephasemodel expanded balanced.

This model name reflects that the load previously modeled by the RLC block is now
expanded into individual phases. The load is still balanced, that is, there is equal
resistance in each phase.
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Create an Expanded Unbalanced Three-Phase Model

1

Unbalance the load in simplethreephasemodel expanded balanced by
changing the resistance in one phase. Double-click the phase-c resistor element.
Change Resistance to 2.

Save this version of the modified model using the name
simplethreephasemodel expanded unbalanced.

This model name reflects that the three-phase load previously modeled by the RLC
block is expanded into individual phases. The load is unbalanced, that is, the
resistance in one of the phases is higher than in the other two.

Simulate the Expanded Balanced and Unbalanced Models and
Analyze the Results

1

Simulate the simplethreephasemodel expanded balanced model. In the menu
bar of the Simulink Explorer, click the Run button.

View the simulation results. Double-click the Scope block.

To scale the scope axes to the data, click the Autoscale button E

In the simplethreephasemodel, the Component structure parameter of the RLC
(Three-Phase) block specifies that the three-phase load is purely resistive. In this
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version of the model, the load is expanded into an individual resistive element for
each phase, but the resistance in each phase is unchanged. For each phase of the
three-phase system, the voltage and current remain in phase with each other.
Because the resistance in each phase is 1 Q, the magnitude of the phase voltage is
equal to the magnitude of the phase current.

Comparing these results with the results for the three-phase resistive model shows
that a block with composite three-phase ports, the RLC (Three-Phase) block in the
original model, produces results with the same fidelity as that of expanded phases.

Open the simplethreephasemodel expanded unbalanced model.

Simulate the model. Autoscale the scope axes.

In this version of the model, the c-phase of the three-phase load has twice the
resistance of the other two. Therefore, half as much current flows in that phase, as
the second plot shows. However, because the load remains purely resistive, the
voltage and current remain in phase with each other.
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See Also

Related Examples

. “Modeling Analog Circuit Architectures, Mechatronic Systems, and Electrical Power
Systems Using Simscape Electrical” on page 1-6

. “Essential Electrical Modeling Techniques” on page 3-2
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DC Motor Model

In this section...

“Select Blocks to Represent System Components” on page 2-13
“Build the Model” on page 2-14

“Specify Model Parameters” on page 2-15

“Configure the Solver Parameters” on page 2-18

“Run the Simulation and Analyze the Results” on page 2-19

In this example, you model a DC motor driven by a constant input signal that
approximates a pulse-width modulated signal and look at the current and rotational
motion at the motor output.

To see the completed model, open the PWM-Controlled DC Motor example.

Select Blocks to Represent System Components

Select the blocks to represent the input signal, the DC motor, and the motor output

displays.

The following table describes the role of the blocks that represent the system
components.

Block Description

Solver Configuration Defines solver settings that apply to all physical modeling
blocks

PS-Simulink Converter |Converts the input physical signal to a Simulink signal

Controlled PWM Generates the signal that approximates a pulse-width
Voltage modulated motor input signal

H-Bridge Drives the DC motor

DC Motor Converts input electrical energy into mechanical motion
Current Sensor Converts the electrical current that drives the motor into a

measurable physical signal proportional to the current

DC Voltage Source Generates a DC voltage
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Block Description

Electrical Reference Provides the electrical ground

Mechanical Rotational |Provides the mechanical ground

Reference

Ideal Rotational Converts the rotational motion of the motor into a measurable
Motion Sensor physical signal proportional to the motion

Scope Displays motor current and rotational motion

Build the Model

1 Create a new model.

2 Add to the model the blocks listed in the following table. The Library column of the
table specifies the hierarchical path to each block.

Block Library Quantity

Solver Simscape > Utilities 1

Configuration

PS-Simulink Simscape > Utilities 2

Converter

Controlled PWM |Simscape > Electrical > Integrated Circuits |1

Voltage

H-Bridge Simscape > Electrical > Semiconductors & |1
Converters > Converters

DC Motor Simscape > Electrical > Electromechanical |1

> Brushed Motors

Current Sensor |Simscape > Foundation Library > Electrical |1
> Electrical Sensors

DC Voltage Simscape > Foundation Library > Electrical |1
Source > Electrical Sources

Electrical Simscape > Foundation Library > Electrical |1
Reference > Electrical Elements

Mechanical Simscape > Foundation Library > 1
Rotational Mechanical > Rotational Elements

Reference
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Block Library Quantity
Ideal Rotational |Simscape > Foundation Library > 1
Motion Sensor |Mechanical > Mechanical Sensors

Scope Simulink > Commonly Used Blocks 2

Note You can use the Simscape function ssc_new with domain type electrical to
create a Simscape model that contains these blocks:

Simulink-PS Converter

PS-Simulink Conve

Scope

rter

Solver Configuration

Electrical Reference

o]
PS-Simulink1  ~" ooty
« Ideal
- Rotational
i Motion

&} Lﬁ Sensor
P D
PS-Simulink RPM

3 Rename and connect the blocks as shown in the diagram.
Current Sensor
reft  PWM ekl 0
— e e O
ref-  REF REF !
Controlled PWM  &—REV )
PWM Voltage BRK N
reference -
voltage H-Bridge DC Motor @
fix)=0 :
Solver L
Configuration =

Now you are ready to specify block parameters.

Specify Model Parameters

Specify the following parameters to represent the behavior of the system components:
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Model Setup Parameters

The following blocks specify model information that is not specific to a particular block:

* Solver Configuration
* Electrical Reference
¢ Mechanical Rotational Reference

As with Simscape models, you must include a Solver Configuration block in each
topologically distinct physical network. This example has a single physical network, so
use one Solver Configuration block with the default parameter values.

You must include an Electrical Reference block in each Simscape Electrical network. You
must include a Mechanical Rotational Reference block in each network that includes
electromechanical blocks. These blocks do not have any parameters.

For more information about using reference blocks, see “Grounding Rules” (Simscape).
Motor Input Signal Parameters
You generate the motor input signal using these blocks:

» The DC Voltage Source block (PWM reference voltage) generates a constant signal.
* The Controlled PWM Voltage block generates a pulse-width modulated signal.
* The H-Bridge block drives the motor.

In this example, all input ports of the H-Bridge block except the PWM port are connected
to ground. As a result, the H-Bridge block behaves as follows:

*  When the motor is on, the H-Bridge block connects the motor terminals to the power
supply.

*  When the motor is off, the H-Bridge block acts as a freewheeling diode to maintain the
motor current.

In this example, you simulate the motor with a constant current whose value is the
average value of the PWM signal. By using this type of signal, you set up a fast simulation
that estimates the motor behavior.

1  Set the DC Voltage Source block parameters as follows:

* Constant voltage to 2.5



DC Motor Model

2 Set the Controlled PWM Voltage block parameters as follows:

PWM frequency to 4000
Simulation mode to Averaged

This value tells the block to generate an output signal whose value is the average
value of the PWM signal. Simulating the motor with an averaged signal estimates
the motor behavior in the presence of a PWM signal. To validate this
approximation, use value of PWM for this parameter.

3  Set the H-Bridge block parameters as follows:

Simulation mode to Averaged

This value tells the block to generate an output signal whose value is the average
value of the PWM signal. Simulating the motor with an averaged signal estimates
the motor behavior in the presence of a PWM signal. To validate this
approximation, use value of PWM for this parameter.

Note The simulation mode for both the Controlled PWM Voltage and H-Bridge blocks
must be the same.

Motor Parameters

Configure the block that models the motor.

Set the DC Motor block parameters as follows, leaving the unit settings at their default
values where applicable:

* Electrical Torque tab:

Model parameterization to By rated power, rated speed & no-load
speed

Armature inductance to 0.01
No-load speed to 4000

Rated speed (at rated load) to 2500
Rated load (mechanical power) to 10
Rated DC supply voltage to 12
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* Mechanical tab:

* Rotor inertia to 2000
* Rotor damping to 1e-06

Current Display Parameters

Specify the parameters of the blocks that create the motor current display:

* Current Sensor block

* PS-Simulink Converterl block

* Current scope

Of the three blocks, only the PS-Simulink Converterl block has parameters. Set the PS-

Simulink Converterl block Output signal unit parameter to A to indicate that the block
input signal has units of amperes.

Torque Display Parameters

Specify the parameters of the blocks that create the motor torque display:

+ Ideal Rotational Motion Sensor block
e PS-Simulink Converter block
* RPM scope

Of the three blocks, only the PS-Simulink Converter block has parameters you need to
configure for this example. Set the PS-Simulink Converter block Output signal unit
parameter to rpm to indicate that the block input signal has units of revolutions per
minute.

Note You must type this parameter value. It is not available in the drop-down list.

Configure the Solver Parameters

Configure the solver parameters to use a continuous-time solver because Simscape
Electrical models only run with a continuous-time solver. Increase the maximum step size
the solver can take so the simulation runs faster.
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1 In the model window, select Modeling > Model Settings to open the Configuration
Parameters dialog box.

Select odel5s (Stiff/NDF) from the Selver list.
Expand Additional options and enter 1 for the Max step size parameter value.
Click OK.

For more information about configuring solver parameters, see “Simulating an Electronic,
Mechatronic, or Electrical Power System” on page 3-9.

Run the Simulation and Analyze the Results
In this part of the example, you run the simulation and plot the results.
In the model window, select Simulation > Run to run the simulation.

To view the motor current and torque in the Scope windows, double-click the Scope
blocks. You can do this before or after you run the simulation.

Note By default, the scope displays appear stacked on top of each other on the screen, so
you can only see one of them. Click and drag the windows to reposition them.

The following plot shows the motor current.

Motor Current
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The next plot shows the motor rpm.

Motor RPM

As expected, the motor runs at about 2000 rpm when the applied DC voltage is 2.5 V.
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Triangle Wave Generator Model

In this section...

“Select Blocks to Represent System Components” on page 2-21
“Build the Model” on page 2-22

“Specify Model Parameters” on page 2-24

“Configure the Solver Parameters” on page 2-27

“Simulate Model and Analyze Results” on page 2-28

In this example, you model a triangle wave generator using Simscape Electrical blocks
and custom Simscape Electrical blocks, and then look at the voltage at the wave
generator output.

You use a classic circuit configuration consisting of an integrator and a noninverting
amplifier to generate the triangle wave, and use datasheets to specify block parameters.
For more information, see “Parameterizing Blocks from Datasheets” on page 3-16.

To see the completed model, open the Triangle Wave Generator example.

Select Blocks to Represent System Components

First, you select the blocks to represent the input signal, the triangle wave generator, and
the output signal display.

You model the triangle wave generator with a set of physical blocks. The wave generator
consists of:

» Two operational amplifier blocks

* Resistors and a capacitor that work with the operational amplifiers to create the
integrator and noninverting amplifier

* Simulink-PS Converter and PS-Simulink Converter blocks whose function is to bridge
the physical part of the model, which uses physical signals, and the rest of the model,
which uses Simulink signals.

You have a manufacturer datasheet for the two operational amplifiers you want to model.

Later in the example, you use the datasheet to parameterize the Simscape Electrical
Band-Limited Op-Amp block.
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The following table describes the role of the blocks that represent the system

components.

Block Description

Sine Wave Generates a sinusoidal signal that controls the resistance of the
Variable Resistor block

Scope Displays the triangular output wave

Simulink-PS Converts the sinusoidal Simulink signal to a physical signal

Converter

Solver Configuration

Defines solver settings that apply to all physical modeling blocks

PS-Simulink

Converts the output physical signal to a Simulink signal

Converter

Capacitor Works with an operational amplifier and resistor block to create
the integrator

Resistor Works with the operational amplifier and capacitor blocks to

create the integrator and noninverting amplifier

Variable Resistor

Supplies a time-varying resistance that adjusts the gain of the
integrator, which in turn varies the frequency and amplitude of
the generated triangular wave

DC Voltage Source

Generates a DC reference signal for the operational amplifier
block of the noninverting amplifier

Voltage Sensor

Converts the electrical voltage at the output of the integrator
into a physical signal proportional to the current

Electrical Reference

Provides the electrical ground

Band-Limited Op-
Amp

Works with the capacitor and resistor to create an integrator
and a noninverting amplifier

Diode

Limits the output of the Band-Limited Op-Amp block, to make
the output waveform independent of supply voltage

Build the Model

Create a Simulink model, add blocks to the model, and connect the blocks.

1 Create a new model.
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2

specifies the hierarchical path to each block.

Add to the model the blocks listed in this table. The Library Path column of the table

Block Library Path Quantity

Sine Wave Simulink > Sources 1

Scope Simulink > Commonly Used Blocks 1

Simulink-PS Simscape > Utilities 1

Converter

Solver Simscape > Utilities 1

Configuration

PS-Simulink Simscape > Utilities 1

Converter

Capacitor Simscape > Foundation Library > 1
Electrical > Electrical Elements

Resistor Simscape > Foundation Library > 3
Electrical > Electrical Elements

Variable Resistor |Simscape > Foundation Library > 1
Electrical > Electrical Flements

Electrical Simscape > Foundation Library > 2

Reference Electrical > Electrical Elements

DC Voltage Simscape > Foundation Library > 1

Source Electrical > Electrical Sources

Voltage Sensor Simscape > Foundation Library > 1
Electrical > Electrical Sensors

Band-Limited Op- |Simscape > Electrical > Integrated 2

Amp Circuits

Diode Simscape > Electrical > Semiconductor & |2
Converters

Note You can use the Simscape function ssc_new with a domain type of
electrical to create a Simscape model that contains these blocks:

¢  Simulink-PS Converter
¢ PS-Simulink Converter
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* Scope
* Solver Configuration
* Electrical Reference

3 Rename and connect the blocks as shown in the diagram. The blocks in the triangle
wave generator circuit are organized in two stages. The Comparator Stage contains a
comparator constructed from a Band-Limited Op-Amp block and two Resistor blocks.
The Integrator Stage contains an integrator constructed from another Band-Limited
Op-Amp block, a Resistor, a Capacitor, and Electrical Reference.

Variable Resistor Sine Wave

Comparator Stage

Integrator Stage

—J:bgw | -W'"%ﬁ
B o L

R1

Zener2 @ Voltage
Dc
S
) Voltage /| Sensor

Source Zener1 # ‘ LD |§|
4

Solver
== Configuration

T

Scope

Specify Model Parameters

Specify these parameters to represent the behavior of the system components:

* “Model Setup Parameters” on page 2-24

» “Input Signal Parameters” on page 2-25

+ “Triangle Wave Generator Parameters” on page 2-25
» “Signal Display Parameters” on page 2-27

Model Setup Parameters

These blocks specify model information that is not specific to a particular block:



Triangle Wave Generator Model

* Solver Configuration
» Electrical Reference
As with Simscape models, you must include a Solver Configuration block in each

topologically distinct physical network. This example has a single physical network, so
use one Solver Configuration block with the default parameter values.

You must include an Electrical Reference block in each Simscape Electrical network. This
block does not have any parameters.

Input Signal Parameters
Generate the sinusoidal control signal using the Sine Wave block.

Set the Sine Wave block parameters as follows:

* Amplitude — 0.5e4
* Bias — le4
* Frequency — pi/5e-4

Triangle Wave Generator Parameters
Configure the blocks modeling the physical system that generates the triangle wave:

* Integrator stage — Band-Limited Op-Amp, Capacitor, and Resistor block R3

* Comparator stage — Band-Limited Op-Amp1, Resistor blocks R1 and R2

* Variable Resistor

* Diode and Diodel

* Simulink-PS Converter and PS-Simulink Converter blocks that bridge the physical part
of the model and the Simulink part of the model.

1 Accept the default parameters for the Simulink-PS Converter block. These
parameters establish the units of the physical signal at the block output such that
they match the expected default units of the Variable Resistor block input.

2 Set the two Band-Limited Op-Amp block parameters for the LM7301 device with a +-
20V power supply:

* The datasheet gives the gain as 97 dB, which is equivalent to 10 ~ (97 /20) =
7.1e4. Set the Gain, A parameter to 7. 1le4.
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The datasheet gives input resistance as 39 Mohms. Set Input resistance, Rin to
39e6.

Set Output resistance, Rout to 0 ohms. The datasheet does not quote a value
for Rout, but the term is insignificant compared to the output resistor that it
drives.

Set minimum and maximum output voltages to -20 V and +20 V, respectively.

The datasheet gives the maximum slew rate as 1.25 V/ps. Set the Maximum slew
rate, Vdot parameter to 1.25e6 V/s.

Set the bandwidth to 4e6.

Set the two Diode block parameters for a 4.3 V zener diode. To model a BZX384-
B4V3, set block parameters as follows:

On the Main tab, set Diode model to Piecewise Linear. This selects a
simplified Zener diode model that is more than adequate to test the correct
operation of this circuit.

Leave the Forward voltage as 0.6 V — this is a typical value for most diodes.

The datasheet gives the forward current as 250 mA when the forward voltage is
1V. So that the Diode block matches this, set the On resistance to (1 V-0.6V)/
250 mA = 1.6 ohms.

The datasheet gives the reverse leakage current as 3 pA at a reverse voltage of 1
V. Therefore, set the Off conductance to 3pA/1V =3e-6S.

The datasheet gives the reverse voltage as 4.3 V. On the Breakdown tab, set the
Reverse breakdown voltage Vzto 4.3 V.

Set the Zener resistance Rz to a suitably small number. The datasheet quotes
the Zener voltage for a reverse current of 5 mA. For the Diode block to be
representative of the real device, the simulated reverse voltage should be close to
4.3V at bmA. As Rz tends to zero, the reverse breakdown voltage tends to Vz
regardless of current, as the voltage-current gradient becomes infinite. However,
for good numerical properties, Rz must not be made too small. If, say, you allow a
0.01 V error on the Zener voltage at 5 mA, then Rz is 0.01 V/ 5 mA = 2 ohms. Set
the Zener resistance parameter to this value.

The Voltage Sensor block does not have any parameters.

Accept the default parameters for the Variable Resistor block. These parameters
establish the units of the physical signal at the block output such that they match the
expected default units of the Variable Resistor block input.

Set the Capacitor block parameters as follows:
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+ Capacitance — 2.5e-9
* Capacitor voltage — 0.08

This value starts the oscillation in the feedback loop. It is found in the Variables
tab.

* Series resistance — 0
Set the DC Voltage Source block Constant voltageparameter to 0.
Set the Resistor R3 block Resistance parameter to 10000.
Set the Resistor R1 block Resistance parameter to 1000.
10 Set the Resistor R2 block Resistance parameter to 10000.

11 Accept the default parameters for the PS-Simulink Converter block. These
parameters establish the units of the physical signal at the block output such that
they match the expected default units of the Scope block input.

Signal Display Parameters
Specify the parameters of the Scope block to display the triangular output signal.

Double-click the Scope block and then click the View > Configuration Properties to
open the Scope Configuration Properties dialog box. On the Logging tab, clear the Limit
data points to last check box.

Configure the Solver Parameters

Configure the solver parameters to use a continuous-time solver.Simscape Electrical
models only run with a continuous-time solver when the Simscape Solver Configuration
block has its Local Solver parameter cleared. You also change the simulation end time,
tighten the relative tolerance for a more accurate simulation, and remove the limit on the
number of simulation data points Simulink saves.

1 In the model window, select Modeling > Model Settings to open the Configuration
Parameters dialog box.

2 In the Solver category in the tree on the left side of the dialog box:

* Enter 2000e-6 for the Stop time parameter value.
* Select ode23t (Mod. stiff/Trapezoidal) from the Solver list.
* Enter 4e-5 for the Max step size parameter value.
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* Enter le-6 for the Relative tolerance parameter value.

3 Inthe Data Import/Export category in the Select tree, clear the Limit data points
to last check box.

4 Click OK.

For more information about configuring solver parameters, see “Simulating an Electronic,
Mechatronic, or Electrical Power System” on page 3-9.

Simulate Model and Analyze Results
Run the simulation and plot the results.
In the model window, select Simulation > Run to run the simulation.

To view the triangle wave in the Scope window, double-click the Scope block. You can do
this before or after you run the simulation.

The following plot shows the voltage waveform. As the resistance of the Variable Resistor
block increases, the amplitude of the output waveform increases and the frequency
decreases.

Triangle Waveform Voltage
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* “Essential Electrical Modeling Techniques” on page 3-2

* “Three-Phase Ports” on page 3-6

» “Switch Between Physical Signal and Electrical Ports” on page 3-8

* “Simulating an Electronic, Mechatronic, or Electrical Power System” on page 3-9
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* “Parameterize an Exponential Diode from SPICE Netlist” on page 3-26

* “Parameterize an Op-Amp from a Datasheet” on page 3-30
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* “Simulating Thermal Effects in Semiconductors” on page 3-37

* “Plot Basic Characteristics for Battery Blocks” on page 3-53

* “Plot Basic Characteristics for Semiconductor Blocks” on page 3-56

* “MOSFET Characteristics Viewer” on page 3-59

» “Converting a SPICE Netlist to Simscape Blocks” on page 3-68

* “Photovoltaic Thermal (PV/T) Hybrid Solar Panel” on page 3-77
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In this section...

“Overview of Modeling Rules” on page 3-2

“Required Blocks” on page 3-3

“Creating a New Model” on page 3-4

“Modeling Instantaneous Events” on page 3-4

“Using Simulink Blocks to Model Physical Components” on page 3-5

Overview of Modeling Rules

Simscape Electrical models are essentially Simscape block diagrams refined for modeling
single- and multi-phase electronic, mechatronic, and electrical power systems. Simscape
Electrical blocks feature these port types:

* Three-phase ports, which connect the phases of a three-phase electrical system
between Simscape Electrical blocks.

There are two three-phase port types in Simscape Electrical blocks, composite and
expanded. You can connect a composite three-phase port only to another composite
three-phase port. You can connect the individual electrical conserving ports of an
expanded three-phase port only to other electrical conserving ports. For more
information, see “Three-Phase Ports” on page 3-6.

* Electrical and mechanical rotational conserving ports B, which connect directly to
Simscape foundation blocks.

Each port type has specific Across and Through variables associated with it. To learn
about the rules to follow when building an electromechanical model, see “Basic
Principles of Modeling Physical Networks” (Simscape).

» Physical signal ports [, which connect to Simulink blocks through Simulink-PS
Converter and PS-Simulink Converter blocks from the Simscape Utilities library. These
blocks convert physical signals to and from Simulink mathematical signals.

Keep these rules in mind when using each port type in Simscape Electrical blocks.

* You can connect physical conserving ports only to other conserving ports of the same
type. Electrical conserving ports in Simscape Electrical blocks can connect directly to
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Simscape electrical components. Mechanical rotational conserving ports in Simscape
Electrical blocks can connect directly to Simscape mechanical rotational components.

* The physical connection lines that connect conserving ports are nondirectional lines
that carry physical variables (Across and Though variables) rather than signals. You
cannot connect physical conserving ports to Simulink ports or to physical signal ports.

* You can branch physical connection lines. When you do so, directly connected
components have the same Across variables. The value of any Through variable (e.g.,
current or torque) transferred along the physical connection line is divided among the
multiple components connected by the branches.

For each Through variable, the sum of the values flowing into a branch point equals
the sum of the values flowing out.

* You can connect physical signal ports to other physical signal ports using regular
connection lines, similar to Simulink signal connections. These connection lines carry
physical signals between Simscape Electrical blocks.

* You can connect physical signal ports to Simulink ports through converter blocks. Use
the Simulink-PS Converter block to connect Simulink outports to physical signal
inports. Use the PS-Simulink Converter block to connect physical signal outports to
Simulink inports.

* Unlike Simulink signals, physical signals can have units. In Simscape Electrical block
dialog boxes, you can specify the units along with the parameter values, where
appropriate. Use the converter blocks to associate units with an input signal and to
specify the desired output signal units.

For an example of these rules applied to an electromechanical model, see Three-Phase
Asynchronous Machine Starting.

Required Blocks

Each topologically distinct physical network in a diagram requires exactly one Solver
Configuration block from the Simscape Utilities library. The Solver Configuration block
specifies global environment information for simulation and provides parameters for the
solver that your model needs for simulation.

Each electrical network requires an Electrical Reference block. This block establishes the
electrical ground for the circuit. Networks with electromechanical blocks also require a
Mechanical Rotational Reference block. For more information about using reference
blocks, see “Grounding Rules” (Simscape).
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Creating a New Model

An easy way to start a new Simscape Electrical model, prepopulated with the required
blocks, is to use the Simscape function ssc_new. For more information, see “Creating a
New Simscape Model” (Simscape).

Another way to start a new model is to use a Simscape template from the Simulink start
page. The start page includes model templates that provide you with design patterns for
modeling electrical, three-phase electrical, mechanical rotational, and mechanical
translational networks using Simscape Electrical. For more information, see “Modeling
Analog Circuit Architectures, Mechatronic Systems, and Electrical Power Systems Using
Simscape Electrical” on page 1-6.

You can also use the “Creating A New Circuit” (Simscape) example as a template for a
new electronic circuit model. This example opens a simple electrical model, prepopulated
with some useful blocks, and also opens an Electrical Starter Palette, which contains links
to the most often used electrical components. Open the example by typing
ssc_new_elec in the MATLAB Command Window and use File > Save As to save the
example model under the desired name. Then delete the unwanted blocks and add new
ones from the Electrical Starter Palette and from the block libraries.

Modeling Instantaneous Events

When working with Simscape Electrical, your model may include Simulink blocks that are
associated with events or discrete sampling. Such blocks can create instantaneous
changes to the physical system inputs through the Simulink-PS Converter block that
connects them. When you build this type of model, make sure that the corresponding zero
crossings are generated.

Many blocks in the Simulink library generate these zero crossings by default. For
example, the Pulse Generator block produces a discrete-time output by default, and
generates the corresponding zero crossings. To generate zero crossings for all Simulink
blocks that model instantaneous events, in the Solver Configuration Parameters for the
model, expand Solver details and in the Zero crossing options, for the Zero crossing
control option, select Use local settings or Enable all. For more information
about zero crossing control, see “Zero-crossing control” (Simulink).


matlab:ssc_new_elec
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Using Simulink Blocks to Model Physical Components

To run a fast simulation that approximates the behavior of the physical components in a
system, you may want to use Simulink blocks to model one or more physical components.

The Modeling an Integrated Circuit example uses Simulink to model a physical
component. The 2-Input NOR (Behavioral Model) masked subsystem is a behavioral
model, built using Simscape Foundation Library blocks.

Im1
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Custom integrated Push-Pull Output
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This behavioral model contains a subsystem comprised of Simulink blocks, which
implements the custom integrated-circuit behavior.
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The Simulink Logical Operator block implements the behavioral model of the two-input
NOR gate. Using Simulink in this manner introduces algebraic loops, unless you place a
lag somewhere between the physical signal inputs and outputs. In this case, a first-order
lag is included in the Propagation Delay subsystem to represent the delay due to gate
capacitances. For applications where no lag is required, use blocks from the Physical
Signals sublibrary in the Simscape Foundation Library to implement the desired
functionality.
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In this section...

“About Three-Phase Ports” on page 3-6

“Expand and Collapse Three-Phase Ports on a Block” on page 3-7

About Three-Phase Ports

In Simscape Electrical software, you can connect the phases of a three-phase system
between blocks using two types of ports.

* Composite three-phase port
* Expanded three-phase port

Composite three-phase ports represent three individual electrical conserving ports with a
single block port. You can use composite three-phase ports to build models that
correspond to single-line diagrams of three-phase electrical systems. Instead of explicitly
connecting each phase of the three-phase system between blocks, you connect all three
phases using a single port. You can connect composite three-phase ports only to other
composite three-phase ports.

Expanded three-phase ports represent the individual phases of a three-phase system
using three separate electrical conserving ports. You individually connect each phase of
the three-phase system between blocks. Electrical conserving ports can connect directly
to electrical components from the Simscape and Simscape Electrical libraries.

Composite three-phase ports produce results with the same fidelity as expanded three-
phase ports. Both connection methods consider instantaneous phase voltages and
currents and are suitable for modeling balanced and unbalanced three-phase electrical
power systems. Each electrical conserving port in an expanded three-phase port has a
Through variable of scalar current and an Across variable of scalar voltage. For a
composite three-phase port, the Through variable is a three-element current, and the
Across variable is a three-element voltage.

You can use the Phase Splitter block to expand a composite three-phase port into separate
electrical conserving ports. The separate electrical ports can then connect to Simscape
Electrical electrical components.

The figure shows two simple circuits that contrast the composite and expanded
connection methods. The two circuits produce the same results.
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The top circuit uses a Voltage Source block with a composite three-phase port ~. The
bottom circuit uses a Voltage Source block with expanded electrical conserving ports a, b,
and c. In each circuit, the instantaneous phase voltages and currents are the same.

Expand and Collapse Three-Phase Ports on a Block

Simscape Electrical blocks that have composite three-phase ports have an option to
switch between composite and expanded ports.

* Right-click the block. On the Simscape block choices context menu, select

Expanded three-phase ports or Composite three-phase ports.

For blocks with a single composite port ~, the expanded electrical ports are labeled a,
b, and c. For blocks with more than one composite port ~1 and ~2, the expanded
electrical ports are labeled al, b1, c1 and a2, b2, c2.
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Switch Between Physical Signal and Electrical Ports
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Some Simscape Electrical blocks have an option to switch certain ports between physical
signal and electrical conserving ports. An electrical conserving port is a Simscape
physical conserving port that has a Through variable of current and an Across variable of
voltage. For a comparison of Simscape physical signal and physical conserving ports, see
“Connector Ports and Connection Lines” (Simscape).

To switch a block connection port between an electrical conserving port B and a physical
signal port b:

Right-click the block.

2 On the Simscape > Block choices context menu, select a variant that includes that
includes the term Electrical, for an electrical conserving port, or PS for a physical
signal port.
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Simulating an Electronic, Mechatronic, or Electrical
Power System

In this section...

“Selecting a Solver” on page 3-9

“Specifying Simulation Accuracy/Speed Tradeoff” on page 3-9
“Avoiding Simulation Issues” on page 3-10

“Running a Time-Domain Simulation” on page 3-10

“Running a Small-Signal Frequency-Domain Analysis” on page 3-11

Selecting a Solver

Simscape Electrical software supports all of the continuous-time solvers that Simscape
supports. For more information, see “Setting Up Solvers for Physical Models” (Simscape).

You can select any of the supported solvers for running a simulation of an electronic
model. The variable-step solvers, ode23t and odel5s, are recommended for most
applications because they run faster and work better for systems with a range of both fast
and slow dynamics. The ode23t solver is closest to the solver that SPICE traditionally
uses.

To use Simulink Coder software to generate standalone C or C++ code from your model,
you must use the odel4x solver. For more information about code generation, see “Code
Generation” (Simscape).

Specifying Simulation Accuracy/Speed Tradeoff

To trade off accuracy and simulation time, adjust one or more of the following
parameters:

* Relative tolerance in the Simulink Configuration Parameters dialog box
* Absolute tolerance in the Simulink Configuration Parameters dialog box
* Max step size in the Simulink Configuration Parameters dialog box

* Consistency Tolerance in the Solver Configuration block dialog box

In most cases, the default tolerance values produce accurate results without sacrificing
unnecessary simulation time. The parameter value that is most likely to be inappropriate
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for your simulation is Max step size, because the default value, auto, depends on the
simulation start and stop times rather than on the amount by which the signals are
changing during the simulation. If you are concerned about the solver missing significant
behavior, change the parameter to prevent the solver from taking too large a step.

The Simulink documentation describes the following parameters in more detail and
provides tips on how to adjust them:

* “Relative tolerance” (Simulink)

* “Absolute tolerance” (Simulink)

* “Max step size” (Simulink)

The Solver Configuration block reference page in the Simscape documentation explains
when to adjust the Consistency Tolerance parameter value.

Avoiding Simulation Issues

If you experience a simulation issue, first read “Troubleshooting Simulation Errors”
(Simscape) to learn about general troubleshooting techniques.

There are a few techniques you can apply to any Simscape Electrical model to overcome
simulation issues:

* Add parasitic capacitors and/or resistors (specifically, junction capacitance and ohmic
resistance) to the circuit to avoid numerical issues. The Astable Oscillator example
uses these devices.

* Adjust the current and voltage sources so they start at zero and ramp up to their final
values rather than starting at nonzero values.

To learn about avoiding simulation errors in the presence of specific Simscape Electrical
model configurations, see “Modeling Instantaneous Events” on page 3-4 and “Using
Simulink Blocks to Model Physical Components” on page 3-5.

Running a Time-Domain Simulation

When you run a time-domain simulation, Simscape Electrical software uses the Simscape
solver to analyze the physical system in the Simulink environment. For more information,
see “How Simscape Simulation Works” (Simscape).



See Also

Running a Small-Signal Frequency-Domain Analysis

You can perform small-signal analysis for Simscape and Simscape Electrical models using
linearization capabilities of Simulink software. For more information, see “Linearize an
Electronic Circuit” (Simscape).

See Also

Solver Configuration

More About

. “How Simscape Simulation Works” (Simscape)
. “Trimming and Linearization” (Simscape)
. “Troubleshooting” (Simscape)
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In this section...

“Available Output Models” on page 3-12
“Quadratic Model Output and Parameters” on page 3-13

Available Output Models

The blocks in the Logic sublibrary of the Integrated Circuits library provide a choice of
two output models:

* Linear — Models the gate output as a voltage source driving a series resistor and
capacitor connected to ground. This is suitable for logic circuit operation under
normal conditions and when the logic gate drives other high-impedance CMOS gates.
The block sets the value of the gate output capacitor such that the resistor-capacitor
time constant equals the Propagation delay parameter value. The linear output
model is shown in the following illustration.
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* Quadratic — Models the gate output in terms of a complementary N-channel and P-
channel MOSFET pair. This adds more fidelity, which becomes relevant if drawing
higher currents from the gate output, or if exercising the gate under fault conditions.
In addition, the gate input demand is lagged to approximate the Propagation delay
parameter value. Default parameters are representative of the 74HC logic gate family.
The quadratic output model is shown in the next illustration.
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Use the Output current-voltage relationship parameter on the Qutputs tab of the
block dialog box to specify the output model.

For most system models, MathWorks recommends selecting the linear option because it
supports faster simulation. If necessary, you can use the more detailed output model to
validate simulation results obtained from the simpler model.

Quadratic Model Output and Parameters

If you select the quadratic model, use the following parameters to control the block
output:

* Supply voltage — Supply voltage value (Vcc) applied to the gate in your circuit. The
default value is 5 V.

* Measurement voltage — The gate supply voltage for which mask data output
resistances and currents are defined. The default value is 5 V.

* Logic HIGH output resistance at zero current and at I_OH — A row vector
[ R OH1 R OH2 ] of two resistance values. The first value R_ OH1 is the gradient of the
output voltage-current relationship when the gate is logic HIGH and there is no output
current. The second value R_ OH?2 is the gradient of the output voltage-current
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relationship when the gate is logic HIGH and the output current is I OH. The default
valueis [ 25 250 ] Q.

* Logic HIGH output current I_OH when shorted to ground — The resulting
current when the gate is in the logic HIGH state, but the load forces the output
voltage to zero. The default value is 63 mA.

* Logic LOW output resistance at zero current and at I_OL — A row vector
[ R OLI R OLZ2 ] of two resistance values. The first value R_OL1 is the gradient of the
output voltage-current relationship when the gate is logic LOW and there is no output
current. The second value R_OLZ is the gradient of the output voltage-current
relationship when the gate is logic LOW and the output current is I OL. The default
valueis [ 30 800 ] Q.

* Logic LOW output current I_OL when shorted to Vcc — The resulting current
when the gate is in the logic LOW state, but the load forces the output voltage to the
supply voltage Vcc. The default value is -45 mA.

* Propagation delay — Time it takes for the output to swing from LOW to HIGH or HIGH
to LOW after the input logic levels change. For quadratic output, it is implemented by
the lagged gate input demand. The default value is 25 ns.

* Protection diode on resistance — The gradient of the voltage-current relationship
for the protection diodes when forward biased. The default value is 5 Q.

* Protection diode forward voltage — The voltage above which the protection diode
is turned on. The default value is 0.6 V.

The following graphic illustrates the quadratic output model parameterization, using the
default parameter output characteristics for a +5V supply.
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Simscape Electrical is a system-level simulation tool that provides blocks with a
commensurate level of fidelity. Block parameters are designed, where possible, to match
the data found on manufacturer datasheets. For example, the bipolar transistor blocks
support parameterization in terms of the small-signal quantities quoted on a datasheet,
and the underlying model is simpler than models typically used by specialist EDA
simulation tools. The smaller number of parameters and simpler underlying models can
support MATLAB system performance analysis better, and thus support design choices.
Following system design, you can perform validation in hardware or more detailed
modeling and validation using an EDA simulation tool.

The following parameterization examples illustrate various block parameterization
techniques:

» Example 1: “Parameterize a Piecewise Linear Diode Model from a Datasheet” on page
3-18

* Example 2: “Parameterize an Exponential Diode from a Datasheet” on page 3-22
+ Example 3: “Parameterize an Exponential Diode from SPICE Netlist” on page 3-26
* Example 4: “Parameterize an Op-Amp from a Datasheet” on page 3-30

Most of the time, datasheets should be a sufficient source of parameters for Simscape
Electrical blocks (see Examples 1 on page 3-18, 2 on page 3-22, and 4 on page 3-30).
Sometimes, there is need for more information than is available on the datasheet, and
data can be augmented from a manufacturer SPICE netlist. For example, circuit
performance may depend on one or two critical components, and increased accuracy is
needed either for parameter values or the underlying model. Simscape Electrical libraries
contain a SPICE-compatible sublibrary to support this case, as is illustrated by Example 3
on page 3-26. If you have many components that need to be modeled to a high level of
accuracy, then Simulink cosimulation with a specialist circuit simulator may be a better
option.

You can also use the SPICE conversion assistant to convert SPICE components into
Simscape equivalents. For more information, see “Converting a SPICE Netlist to
Simscape Blocks” on page 3-68

In mechatronic applications in particular, you may need to model input-output behavior of
integrated circuits, such as PWM waveform generators and H-bridges. For these two
examples, Simscape Electrical libraries contain abstracted-behavior equivalent blocks
that you can use. Where you need to model other devices, possible options include
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creating your own abstracted model using the Simscape language, or using Simulink
blocks. For an example of using Simulink blocks, see the Modeling an Integrated Circuit
example.

When looking for a datasheet, make sure that you have the originating manufacturer
datasheet because some resellers abbreviate them.

For additional ways to parameterize and validate your model, see “Additional
Parameterization Workflows” on page 3-32.
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The Triangle Wave Generator example model, also described in “Triangle Wave Generator
Model” on page 2-21, contains two zener diodes that regulate the maximum output
voltage from an op-amp amplifier circuit. Each of these diodes is implemented with the
Simscape Electrical Diode block, parameterized using the Piecewise Linear option.
This simple model is sufficient to check correct operation of the circuit, and requires
fewer parameters than the Exponential option of the Diode block. However, when
specifying the parameters, you need to take into account the bias condition that will be
used in the circuit. This example explains how to do this.

The Phillips Semiconductors datasheet for a BZX384-B4V3 gives the following data:

Working voltage, Vz(V) at Iz.; = 5 mA 4.3
Diode capacitance, C4(pF) 450
Reverse current, [z(pA) at Vg =1V 3

Forward voltage, Vi(V) at Iz = 5 mA 0.7

In the datasheet, the tabulated values for Vi are for higher forward currents. This value of
0.7V at 5mA is extracted from the datasheet current-voltage curve, and is chosen as it
matches the zener current used when quoting the working voltage of 4.3V.

To match the datasheet values, the example sets the piecewise linear diode block
parameters as follows:

* Forward voltage. Leave as default value of 0.6V. This is a typical value for most
diodes, and the exact value is not critical. However, it is important that the value set is
taken into account when calculating the On resistance parameter.

* On resistance. This is set using the datasheet information that the forward voltage is
0.7V when the current is 5mA. The voltage to be dropped by the On resistance
parameter is 0.7V minus the Forward voltage parameter, that is 0.1V. Hence the On
resistance is 0.1V /5mA = 20 Q.

* Off conductance. This is set using the datasheet information on reverse current. The
reverse current is 3pA for a reverse voltage of 1V. Hence the Off conductance should
be set to 3pA/ 1V = 3e-6 S.

* Reverse breakdown voltage. This parameter should be set to the datasheet working
voltage parameter, 4.3V.
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» Zener resistance. This needs to be set to a suitable small number. Too small, and the

voltage-current relationship becomes very steep, and simulation convergence may not
be as efficient. Too large, and the zener voltage will be incorrect. For the Diode block
to be representative of the real device, the simulated reverse voltage should be close
to 4.3V at 5mA (the reverse bias current provided by the circuit). Allowing a 0.01 V
error on the zener voltage at 5mA, the zener resistance R; will be 0.01V/5mA =2 Q.

Junction capacitance. This parameter is set to the datasheet diode capacitance
value, 450 pF.

Block Parameters: Diode *
Diode

This block represents a diode. Use the Diode model parameter to select one of the following model types:

[1] Piecewise Linear Diode. This option invokes the diede model from the Simscape Foundation Library.

[2] Exponential Diode. Uses the standard exponential diode equation I = Is*(exp(V/(N*Vt))-1) where Is is the
Saturation current, Vt is the thermal voltage, and N is the emission coefficient (>=1). Vt is given by Vt = k*T/e
where k is Boltzmann's constant, T is the absolute Temperature of the p-n junction, and e is the magnitude of
charge on an electron.

For finite Reverse breakdown voltage, the diode will exhibit reverse breakdown characteristics.

Right-click on the block and select Simscape > Block choices to access variant implementations of the block.
Source code

Settings

Main  Breakdown  Capacitance  Variables

Diode model: Piecewise linear -

Forward voltage: [0.6 | [v |
On resistance: [20 | [ohm |
Off conductance: [3e6 | [s |
Number of series diodes: [1 |
Number of parallel diodes: [1 |

Cancel Help Apply
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Block Parameters: Diode

Diode

This block represents a diode. Use the Diode model parameter to select one of the following model types:

[1] Piecewise Linear Diode. This option invokes the diede model from the Simscape Foundation Library.

[2] Exponential Diode. Uses the standard exponential diode equation I = Is*(exp(V/(N*Vt))-1) where Is is the
Saturation current, Vt is the thermal voltage, and N is the emission coefficient (>=1). Vt is given by Vt = k*T/e
where k is Boltzmann's constant, T is the absolute Temperature of the p-n junction, and e is the magnitude of
charge on an electron.

For finite Reverse breakdown voltage, the diode will exhibit reverse breakdown characteristics.

Right-click on the block and select Simscape > Block choices to access variant implementations of the block.
Source code

Settings

Main  Breakdown  Capacitance  Variables

Zener resistance: |2 | | Ohm v|

Reverse breakdown voltage: |4.3 | | v v|

Cancel Help Apply
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Block Parameters: Diode *
Diode

This block represents a diode. Use the Diode model parameter to select one of the following model types:

[1] Piecewise Linear Diode. This option invokes the diede model from the Simscape Foundation Library.

[2] Exponential Diode. Uses the standard exponential diode equation I = Is*(exp(V/(N*Vt))-1) where Is is the
Saturation current, Vt is the thermal voltage, and N is the emission coefficient (>=1). Vt is given by Vt = k*T/e
where k is Boltzmann's constant, T is the absolute Temperature of the p-n junction, and e is the magnitude of
charge on an electron.

For finite Reverse breakdown voltage, the diode will exhibit reverse breakdown characteristics.

Right-click on the block and select Simscape > Block choices to access variant implementations of the block.
Source code

Settings

Main Breakdown Capacitance  Variables

Capacitance: Fixed or zero junction capacitance =
Junction capacitance: 450 | | pF ~
Charge dynamics: Do not model charge dynamics -

Cancel Help Apply
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Example 1 on page 3-18 uses a piecewise linear approximation to the diode’s exponential
current-voltage relationship. This results in more efficient simulation, but requires some
thought to go into the setting of block parameter values. An alternative is to use a more
complex model that is valid for a wider range of voltage and current values. This example
uses the Exponential parameterization option of the Diode block.

This model either requires two data points from the diode current-voltage relationship, or
values for the underlying equation coefficients, namely the saturation current IS and the
emission coefficient N. The BZX384-B4V3 datasheet only provides values for the former
case. Some datasheets do not give the necessary data for either case, and you must follow
the processes in Example 1 on page 3-18 or Example 3 on page 3-26 instead.

The two data points in the table below are from the BZX384-B4V3 datasheet current-
voltage curve:

Diode forward voltage, Vg |0.7V 1v

Diode forward current, Ip 5mA 250mA

Set the exponential diode block parameters as follows:

* Currents [I1 I2]. Set to [5 250] mA.
* Voltages [V1 V2]. Set to [0.7 1.0] V.
* Reverse breakdown voltage. Set to the datasheet working voltage value, 4.3V.

* Ohmic resistance, RS. Set to 0.01 Q. This is an example of a parameter that cannot
be determined from the datasheet. However, setting its value to zero is not necessarily
a good idea, because a small value can help simulation convergence for some circuit
topologies. Physically, this term will not be zero because of the connection resistances.

* Junction capacitance. Set to the datasheet diode capacitance value, 450 pF.

A more complex capacitance model is also available for the Diode component with the
exponential equation option. However, the datasheet does not provide the necessary
data. Moreover, the operation of this circuit is not sufficiently sensitive to voltage-
dependent capacitance effects to warrant the extra detail.
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Block Parameters: Diode *
Diode

This block represents a diode. Use the Diode model parameter to select one of the following model types:

[1] Piecewise Linear Diode. This option invokes the diede model from the Simscape Foundation Library.

[2] Exponential Diode. Uses the standard exponential diode equation I = Is*(exp(V/(N*Vt))-1) where Is is the
Saturation current, Vt is the thermal voltage, and N is the emission coefficient (>=1). Vt is given by Vt = k*T/e
where k is Boltzmann's constant, T is the absolute Temperature of the p-n junction, and e is the magnitude of
charge on an electron.

For finite Reverse breakdown voltage, the diode will exhibit reverse breakdown characteristics.

Right-click on the block and select Simscape > Block choices to access variant implementations of the block.
Source code

Settings

Main  Breakdown  Capacitance  Temperature Dependence  Variables

Diode model: Exponential -

Parameterization: Use two I-V curve data points -

Currents [11 12]: [[5250] | [ma |
Voltages [V1 V2]: [[0.71.0] | [v |
Ohmic resistance, RS: [0.01 | [ohm |
Measurement temperature: [25 | [degc |
Number of series diodes: [1 |
Number of parallel diodes: [1 |

Cancel Help Apply
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Block Parameters: Diode

Diode

This block represents a diode. Use the Diode model parameter to select one of the following model types:

[1] Piecewise Linear Diode. This option invokes the diede model from the Simscape Foundation Library.

[2] Exponential Diode. Uses the standard exponential diode equation I = Is*(exp(V/(N*Vt))-1) where Is is the
Saturation current, Vt is the thermal voltage, and N is the emission coefficient (>=1). Vt is given by Vt = k*T/e
where k is Boltzmann's constant, T is the absolute Temperature of the p-n junction, and e is the magnitude of
charge on an electron.

For finite Reverse breakdown voltage, the diode will exhibit reverse breakdown characteristics.

Right-click on the block and select Simscape > Block choices to access variant implementations of the block.
Source code

Settings

Main  Breakdown  Capacitance  Temperature Dependence  Variables

Reverse breakdown voltage: 4.3 | | v ~

Cancel Help Apply
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Block Parameters: Diode *
Diode

This block represents a diode. Use the Diode model parameter to select one of the following model types:

[1] Piecewise Linear Diode. This option invokes the diede model from the Simscape Foundation Library.

[2] Exponential Diode. Uses the standard exponential diode equation I = Is*(exp(V/(N*Vt))-1) where Is is the
Saturation current, Vt is the thermal voltage, and N is the emission coefficient (>=1). Vt is given by Vt = k*T/e
where k is Boltzmann's constant, T is the absolute Temperature of the p-n junction, and e is the magnitude of
charge on an electron.

For finite Reverse breakdown voltage, the diode will exhibit reverse breakdown characteristics.

Right-click on the block and select Simscape > Block choices to access variant implementations of the block.
Source code

Settings

Main  Breakdown  Capacitance  Temperature Dependence  Variables

Capacitance: Fixed or zero junction capacitance =
Junction capacitance: 450 | | pF ~
Charge dynamics: Do not model charge dynamics -

Cancel Help Apply

3-25



3 Modeling and Simulation Basics

Parameterize an Exponential Diode from SPICE Netlist

3-26

If a datasheet does not provide all of the data required by the component model, another
source is a SPICE netlist for the component. Components are defined by a particular type
of SPICE netlist called a subcircuit. The subcircuit defines the coefficients for the defining
equations. Most component manufacturers make subcircuits available on their websites.
The format is ASCII, and you can directly read off the parameters. The BZX384-B4V3
subcircuit can be obtained from Philips Semiconductors.

The subcircuit data can be used to parameterize the Simscape Electrical Diode block
either in conjunction with the datasheet, or on its own. For example, the Ohmic resistance
is defined in the subcircuit as RS = 0.387, thus providing the missing piece of information
in Example 2 on page 3-22.

An alternative workflow is to use the Simscape Electrical Additional Components/SPICE
Semiconductors sublibrary. The SPICE Diode block in this sublibrary can be directly
parameterized from the subcircuit by setting:

* Saturation current, ISto 1.033e-15

¢  Ohmic resistance, RS to 0.387

 Emission coefficient, N to 1.001

* Zero-bias junction capacitance, CJO to 2.715e-10

* Junction potential, V] to 0.7721

* Grading coefficient, M to 0.3557

* Capacitance coefficient, FC to 0.5

* Reverse breakdown current, IBV to 0.005

* Reverse breakdown voltage, BV to 4.3

Note that where there is a one-to-one correspondence between subcircuit parameters and
datasheet values, the numbers often differ. One reason for this is that datasheet values
are sometimes given for maximum values, whereas subcircuit values are normally for
nominal values. In this example, the C]JO value of 271.5 pF differs from the datasheet
capacitance of 450 pF at zero bias for this reason.
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Block Parameters: SPICE Diode =
SPICE Diode

This model approximates a SPICE diede. You specify both model card and instance parameters as instance
parameters on this mask. The instance parameter OFF and the noise model parameters KF and AF are not
supported. Additional instance parameters are SCALE and TOFFSET.

SCALE is the number of parallel diode instances for this device. SCALE multiplies the output current and device
charge directly. This differs from the AREA parameter, which multiples the device parameters IS, CJO and IBV,
and divides RS.

You can set the diode temperature to a fixed temperature or to the circuit temperature (from the SPICE
Environment Parameters block) plus TOFFSET.

The block lets you include or exclude capacitance modeling, initial conditions and reverse breakdown modeling.
The capacitance modeling uses the published equations, which may yield a slightly different value than SPICE for
capacitance. The initial condition VO is the voltage across the internal diode junction, so it is only effective when
junction capacitance is present. The breakdown voltage BV is not adjusted as a function of the breakdown current
IBV.

Source code
Settings

Main  Junction Capacitance Reverse Breakdown  Temperature

Device area, AREA: |1 | | m~2 v|
xﬂl_t;r of parallel devices, | 1 |
Saturation current, 1S: [1.033e-15 | [am~2 v]
Ohmic resistance, RS: [0.387 | [m~270hm |
Emission coefficient, N: [1.001 |

OK Cancel Help Apply
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Block Parameters: SPICE Diode =
SPICE Diode

This model approximates a SPICE diede. You specify both model card and instance parameters as instance
parameters on this mask. The instance parameter OFF and the noise model parameters KF and AF are not
supported. Additional instance parameters are SCALE and TOFFSET.

SCALE is the number of parallel diode instances for this device. SCALE multiplies the output current and device
charge directly. This differs from the AREA parameter, which multiples the device parameters IS, CJO and IBV,
and divides RS.

You can set the diode temperature to a fixed temperature or to the circuit temperature (from the SPICE
Environment Parameters block) plus TOFFSET.

The block lets you include or exclude capacitance modeling, initial conditions and reverse breakdown modeling.
The capacitance modeling uses the published equations, which may yield a slightly different value than SPICE for
capacitance. The initial condition VO is the voltage across the internal diode junction, so it is only effective when
junction capacitance is present. The breakdown voltage BV is not adjusted as a function of the breakdown current
IBV.

Source code
Settings

Main Junction Capacitance Reverse Breakdown Temperature

Model junction capacitance?: Yes -

é&]acr)c:—bias junction capacitance, |2.?15e-10 | | Fim~2 v|
Junction potential, VJ: [0.7721 | [v |
Grading coefficient, M: |0.355? |
Capacitance coefficient, FC: |0.5 |
Transit time, TT: | 1] | | s ~ |
Specify initial condition?: No -

Cancel Help Apply
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Block Parameters: SPICE Diode =
SPICE Diode

This model approximates a SPICE diede. You specify both model card and instance parameters as instance
parameters on this mask. The instance parameter OFF and the noise model parameters KF and AF are not
supported. Additional instance parameters are SCALE and TOFFSET.

SCALE is the number of parallel diode instances for this device. SCALE multiplies the output current and device
charge directly. This differs from the AREA parameter, which multiples the device parameters IS, CJO and IBV,
and divides RS.

You can set the diode temperature to a fixed temperature or to the circuit temperature (from the SPICE
Environment Parameters block) plus TOFFSET.

The block lets you include or exclude capacitance modeling, initial conditions and reverse breakdown modeling.
The capacitance modeling uses the published equations, which may yield a slightly different value than SPICE for
capacitance. The initial condition VO is the voltage across the internal diode junction, so it is only effective when
junction capacitance is present. The breakdown voltage BV is not adjusted as a function of the breakdown current
IBV.

Source code
Settings

Main  Junction Capacitance  Reverse Breakdown  Temperature

Model reverse breakdown?: Yes A
Reverse breakdown voltage, BV: |4.3 | | v v|
Reverse breakdown current, IBV: |0.005 | | A/m~2 v|

Cancel Help Apply
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The Triangle Wave Generator example model, also described in “Triangle Wave Generator
Model” on page 2-21, contains two op-amps, parameterized based on a datasheet for an
LM7301. The National Semiconductor datasheet gives the following data for this device:

Gain 97dB = 7.1e4
Input resistance 39MQ

Slew rate 1.25V/ps
Bandwidth 4MHz

The Band-Limited Op-Amp and Finite-Gain Op-Amp blocks have been designed to work
from manufacturer datasheets. Implementing detailed op-amp device models, derived
from manufacturer SPICE netlist models, is not recommended, because it provides more
accuracy than is typically warranted and slows down simulations. The simple
parameterization of the Simscape Electrical op-amp blocks allows you to determine the
sensitivity of your circuit to abstracted performance values, such as maximum slew rate
and bandwidth. Because of this behavior-based parameterization, you can determine
which specification of op-amp is required for a given application. A circuit designer can
later match these behavioral parameters, determined from the model, against specific op-
amp devices.

Based on the datasheet values above, set the Band-Limited Op-Amp block parameters as
follows:

* Gainsetto7.led

* Input resistance, Rin set to 39e6Q)

* Output resistance, Rout set to zero. The value is not defined, but will be small
compared to the 1000Q load seen by the op-amp.

* Minimum output, Vmin set to the negative supply voltage, -20V in this model
* Maximum output, Vmax set to the positive supply voltage, 20V in this model

* Maximum slew rate, Vdot setto 1.25/1e-6 V/s

 Bandwidth, f set to 4e6 Hz

Note that these parameters correspond to the values for +-5 volt operation. The
datasheet also gives values for +-2.2V and +-30V operation. It is usually better to pick
values for a supply voltage below what your circuit uses, because performance is worse at
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lower voltages; for example, the gain is less, and the input impedance is less. You can use
the variation in op-amp parameters with supply voltage to suggest a typical range of
parameter values for which you should check the operation of your circuit.

"k Block Parameters: Band-Limited Op-Amp @
Band-Limited Op-Amp
This block models a band-limited op-amp. If the voltages at the positive and negative pins are denoted Vp and Vm,
then the output voltage is given by
Vout = A®(Vp-Vm)*1/(s/(2*pi*f}+1)-Tout*Rout

where A is the gain, Rout is the output resistance, Iout is the output current, s is the Laplace operator, and f is the
3dB bandwidth. The input current is given by (Vp-Vm)/Rin where Rin is the input resistance. The no-load output
voltage is limited the range Vmin to Vmax, and the slew rate is limited to +Vdot.

The Initial output voltage, V0, sets the initial op-amp output voltage. Note that this does not take account of any
voltage drop across Rout. The initial condition is not used if you select the Start simulation from steady state option
in the Solver Configuration block.

Settings

FParameters

Gain, A: 7.1e4

Input resistance, Rin: 30e6 Ohm -
Output resistance, Rout: 1] Ohm -
Minimum output, Vmin: -20 v -
Maximum output, Vmax: 20 v -
Maximum slew rate, Vdot: 1.25/1e-6 Vs -
Bandwidth, f: 4e6 Hz -
Initial output voltage, VO: 0 v -

0K ][ Cancel H Help Apply
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Additional Parameterization Workflows

In this section...

“Validation Using Data from SPICE Tool” on page 3-32
“Parameter Tuning Against External Data” on page 3-32
“Building an Equivalent Model of a SPICE Netlist” on page 3-32

Validation Using Data from SPICE Tool

You can validate a parameterized Simscape Electrical component by comparing its
behavior to the data from a specialist circuit simulation tool that uses a manufacturer
SPICE netlist. Make sure to create a test harness for the component that validates the
data across relevant operating points and frequencies.

Parameter Tuning Against External Data

If you have lab measurements of the device, or data from another simulation
environment, you can use this to tune the parameters of the equivalent Simscape
Electrical component. For an example of parameter tuning, see “Solar Cell Parameter
Extraction From Data”.

Building an Equivalent Model of a SPICE Netlist

In “Parameterize an Exponential Diode from SPICE Netlist” on page 3-26,
parameterization from a SPICE netlist is relatively straightforward because the netlist
defines a single device (the diode) plus the corresponding model card (the parameters).
Conversely, a netlist for an op-amp may have more than ten devices, plus supporting
model cards. In principle, it is possible to build your own equivalent model of a more
complex device by using the SPICE-compatible blocks in the Simscape > Electrical >
Additional Componentslibrary. Connect the components together using the information
in the netlist. Before embarking on this, make sure that the Additional Components
sublibraries contain all the SPICE-compatible component models you need.

If the device models you wish to model are complex (hundreds of components), then
cosimulation with an external circuit simulator may be a better approach.
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See Also
SPICE Diode
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Simulating Thermal Effects in Rotational and
Translational Actuators

In this section...
“Using the Thermal Ports” on page 3-34
“Thermal Model for Actuator Blocks” on page 3-36

Using the Thermal Ports

All blocks that represent rotational and translational actuators with electrical windings
can optionally show a thermal port for each electrical winding. So, for example:

* A DC Motor block can optionally show a single thermal port corresponding to the
armature

* A Shunt Motor block can optionally show two thermal ports, one for the stator winding
and one for the field winding

The thermal port represents copper resistance losses which convert electrical power to
heat. These losses are sometimes referred to as i%R losses. The thermal ports do not
represent iron losses due to, for example, Eddy currents and hysteresis.

The thermal ports are hidden by default. To expose the thermal port on a particular block
instance in your block diagram:

1  Right-clicking the block where you want to show the thermal port.

2 Selecting Simscape > Block choices > Show thermal port.

|'€@— Simscape 4 Log simulation data

43
Block choices L4 Mo thermal port

Explore
al; Cut Ctrl+ X View simulation data v | Show thermal port
Copy Ctrl+C

Paste Ctrl+V

When the thermal port is exposed, the block dialog box contains two additional tabs,
Temperature Dependence and Thermal Port. For actuator blocks with single winding,
these tabs always contain the same set of parameters.
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Settings

Electrical Torque Mechanical Temperature Dependence Thermal Port |

Resistance temperature

coefficient: 0.00393 K .

Measurement temperature: 25 degC -

* Resistance temperature coefficient — Parameter « in the equation defining
resistance as a function of temperature, as described in “Thermal Model for Actuator
Blocks” on page 3-36. The default value is for copper, and is 0.00393 1/K.

* Measurement temperature — The temperature for which motor parameters are
defined. The default value is 25 °C.

Settings

| Electrical Torque | Mechanical | Temperature Dependence | Thermal Port

Thermal mass: 100 /K -

Initial temperature: 25 degC -

* Thermal mass — Thermal mass of the electrical winding, defined as the energy
required to raise the temperature by one degree. The default value is 100 J/K.

* Initial temperature — The temperature of the thermal port at the start of simulation.
The default value is 25 °C.

For more information on selecting the parameter values, see “Thermal Model for Actuator
Blocks” on page 3-36.

Parameters for actuator blocks with two windings differ, and are described on the
respective block reference pages.
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Thermal Model for Actuator Blocks

The following illustration shows the thermal port model used by the actuator blocks. The
heat generated by the copper windings is provided as an input to the S physical signal
input port of the Ideal Heat Flow Source. The thermal mass represents the lumped
thermal mass of the copper winding where thermal mass is defined as the energy
required to raise its temperature by one degree. If the mass is denoted M and the specific
heat capacity is c,, then thermal mass is M-c,,.

{1 %

H

A
— .\ ldealHeat Flow
Thermal Mass r 1 I."$\", S:;:EEE v

x 7T
4
i Thermal R eference

Winding resistance is assumed linearly dependent on temperature, and is given by:
R - R, (1 + o (T - Ty )
where:

* Ris the resistance at temperature T.
* R, is the resistance at the measurement (or reference) temperature T,
* « is the resistance temperature coefficient. A typical value for copper is 0.00393/K.
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Simulating Thermal Effects in Semiconductors

In this section...

“Using the Thermal Ports” on page 3-37

“Cauer Thermal Model” on page 3-38

“Foster Thermal Model” on page 3-40

“External Thermal Model” on page 3-41

“Thermal Mass Parameterization” on page 3-42

“Electrical Behavior Depending on Temperature” on page 3-43
“Improving Numerical Performance” on page 3-43

“Model Thermal Losses for a Rectifier” on page 3-44

Thermal modeling provides data that helps you to estimate cooling requirements for your
system by using the thermal ports. Some of the blocks in the Simscape Electrical
Semiconductors & Converters library have thermal variants that allow you to determine
device temperatures by simulating heat generation. For example, the IGBT (Ideal,
Switching) block, which models a three-terminal semiconductor device, has thermal
variants that can simulate the heat generated by switching events and conduction losses.

For more information on selecting the parameter values, see “Improving Numerical
Performance” on page 3-43. For explanation of the relationship between the Thermal
Port and Temperature Dependence tabs in a block dialog box, see “Electrical Behavior
Depending on Temperature” on page 3-43.

Using the Thermal Ports

Certain Simscape Electrical blocks, such as the blocks in the Semiconductors &
Converters library, contain an optional thermal port that is hidden by default. If you want
to simulate the generated heat and device temperature, expose the thermal port by:

1 Right-clicking the block where you want to show the thermal port.
2 Selecting Simscape > Block choices > Show thermal port.
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power_dissipated /4|

3-38

i

Simscape 4 Log simulation data |

Explore Block choices L Mo thermal port
Views i ; v Show thermal port
a% Cut Chrl+X View simulation data .
Copy Ctrl+C
Paste Ctrl+V

When the thermal port is exposed, the Block Parameters window for that block contains
an additional tab, Thermal Port. Which parameters are visible depend on the value you
set for the Thermal network parameter:

* “Cauer Thermal Model” on page 3-38

* “Foster Thermal Model” on page 3-40

» “External Thermal Model” on page 3-41

All blocks with optional thermal ports include an optional internal thermal model to keep
your diagram uncluttered.

Cauer Thermal Model

This figure shows an equivalent model of the internal Cauer thermal model for
semiconductor devices.

A B A B
. 7] ’ = &)
1/R_JC 1/R_CA H
Conductive Heat Conductive Heat
Transfer Transfer
4] 1 |
[‘ ’1 Junction Thermal Mass [‘ ’1 Case Thermal Mass
| \ — M_J — M_C
<( + +

Port H corresponds to thermal port H of the block. The two Thermal Mass blocks
represent the thermal mass of the device case and the thermal mass of the semiconductor
junction, respectively. The Heat Flow Rate Source block (called power dissipated in the
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diagram) inputs heat to the model with a value equal to the electrically generated heat
from the device.

The two Conductive Heat Transfer blocks model the thermal resistances. Resistance R_JC
(conductance 1/R _JC) represents the thermal resistance between junction and case.
Because of this resistance, the junction will be hotter than the case under normal
conditions. Resistance R CA represents the thermal resistance between port H and the
device case. If the device has no heat sink, then you should connect port H to a
Temperature Source block with its temperature set to ambient conditions. If your device
does have an external heat sink, then you must model the heat sink externally to the
device and connect the heat sink thermal mass directly to port H.

If you choose to simulate the internal thermal network of the block through Cauer model,
the following parameters will be visible:

* Junction case and case-ambient (or case-heatsink) thermal resistances, [R_JC
R_CA] — Arow vector [ R_JC R CA ] of two thermal resistance values, represented by
the two Conductive Heat Transfer blocks. The first value, R JC, is the thermal
resistance between the junction and the case. The second value, R CA, is the thermal
resistance between port H and the device case. The default valueis [ 0 10 ] K/W.

* Thermal mass parameterization — Select whether you want to parameterize the
thermal masses in terms of thermal time constants (By thermal time constants),
or specify the thermal mass values directly (By thermal mass). For more
information, see “Thermal Mass Parameterization” on page 3-42. The default is By
thermal time constants.

* Junction and case thermal time constants, [t_] t_C] — Arow vector [t Jt C]of
two thermal time constant values. The first value, t ], is the junction time constant.
The second value, t C, is the case time constant. To enable this parameter, set the
Thermal mass parameterization to By thermal time constants. The default
valueis [ 0 10 ]s.

* Junction and case thermal masses, [M_] M_C] — A row vector [ M J M C ] of two
thermal mass values. The first value, M ], is the junction thermal mass. The second
value, M C, is the case thermal mass. To enable this parameter, set the Thermal
mass parameterization to By thermal mass. The default valueis [ 0 1 ] J/K.

* Junction and case initial temperatures, [T JT C] —Arowvector[T JT C ] of
two temperature values. The first value, T J, is the junction initial temperature. The
second value, T C, is the case initial temperature. The default valueis [ 25 25 ] °C.

The following rules apply:
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* Case thermal mass must be greater than zero.

* Junction thermal mass can only be set to zero if the junction-case resistance is also set
to zero.

» If both the case and junction thermal masses are defined, but the junction-case
resistance is zero, then the initial temperatures assigned to the junction and case must
be identical.

Foster Thermal Model

This figure shows an equivalent model of the internal Foster thermal model for
semiconductor devices.

R1 R2 R3
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Port H corresponds to thermal port H of the block. The Heat Flow Rate Source block
(called power dissipated in the diagram) inputs heat to the model with a value equal to
the electrically generated heat from the device. Because this option uses Foster Thermal
Model blocks to model the thermal network, you need to connect a thermal source to the
H port either directly or through some additional thermal components so that the power
flow has a well-defined path. This is not needed in the Cauer thermal model because the
thermal masses already provide a path to a thermal reference.

If you choose to simulate the internal thermal network of the block through Foster model,
the following parameters will be visible:

 Thermal resistances, [R1 R2 ... Rn] — A row of n thermal resistance values,
represented by the Foster elements used in the thermal network. These values must
all be greater than zero. The default valueis [ 4 6 ] K/W.

* Thermal mass parameterization — Select whether you want to parameterize the
thermal masses in terms of thermal time constants (By thermal time constants),
or specify the thermal mass values directly (By thermal mass). For more
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information, see “Thermal Mass Parameterization” on page 3-42. The default is By
thermal time constants.

* Thermal time constants, [tl t2 ... tn] — A row vector of n thermal time constant
values, where n is the number of Foster elements used in the thermal network. The
length of this vector must match the length of Thermal resistances, [R1 R2 ... Rn].
These values must all be greater than zero. With this parameterization, the thermal
masses are computed as M; = t;/R;, where M;, t; and R; are the thermal mass,
thermal time, and thermal resistance for the it Foster element. To enable this
parameter, set Thermal mass parameterization to By thermal time constants.
The default valueis [ 6 18 ] s.

* Thermal masses, [M1 M2 ... Mn] — A row vector of n thermal mass values, where n
is the number of Foster elements used in the thermal network. These values must all
be greater than zero. To enable this parameter, set Thermal mass parameterization
to By thermal mass. The default valueis [ 1.5 3 ] ]J/K.

For the internal Foster thermal model, the thermal resistances, thermal time constants,
and thermal masses must all be greater than zero.

External Thermal Model

If you want to model the thermal network of a semiconductor block externally to the block
itself, set the Thermal network parameter to External. This figure shows the
equivalent model of the internal thermal model for semiconductor devices.

&
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Port H corresponds to thermal port H of the block. The Heat Flow Rate Source block
(called power dissipated in the diagram) represents the total dissipated power in the
block. The dissipated power is output as heat flow to the H node. Similar to the Foster
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thermal model, you need to connect a thermal source or additional thermal components
to the H node so that the heat has somewhere to flow.

If you choose to simulate the internal thermal network of the block externally, there are
no additional parameters.

Thermal Mass Parameterization

If you need to estimate thermal masses, there are two parameterization options:

* By thermal time constants — Parameterize the thermal masses in terms of
thermal time constants. This is the default.

* By thermal mass — Specify the thermal mass values directly.

For the Cauer model (junction and case), the thermal time constantst Jandt C
are defined as follows:

tJ = MJ . RJC
t C = MC - R CA

where M J and M C are the junction and case thermal masses, respectively, R_JC is the
thermal resistance between junction and case, and R_CA is the thermal resistance
between port H and the device case.

For the Foster model, the thermal time constant, t;, is defined as follows for the ith
Foster element:

ti= My R,

where M; and R; are the thermal mass and the thermal resistance of the 1t" Foster
element, respectively.

You can determine the case-time constant by experimental measurement. If data is not
available for the junction-time constant, you can either omit the constant and set the
junction-case resistance to zero, or you can set the junction-time constant to a typical
value of one-tenth of the case-time constant. Alternatively, you can estimate thermal
masses based on the device dimensions and averaged material-specific heats.
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Electrical Behavior Depending on Temperature

For blocks with optional thermal ports, there are two simulation options:

» Simulate the generated heat, device temperature, and the effect of temperature on the
electrical equations.

» Simulate the generated heat and device temperature, but do not include effect of
temperature on the electrical equations. Use this option when the impact of
temperature on the electrical equations is small for the temperature range that you
are simulating, or where the primary task of the simulation is to capture the heat
generated to support system-level design.

The thermal port and the Thermal Port tab of the Block Parameters window let you
simulate the generated heat and device temperature. For blocks with a Temperature
Dependence tab, it is possible to simulate the impact of the junction temperature on the
electrical characteristics. The Thermal Dependence tab lets you model the effect that
the temperature of the semiconductor junction has on the electrical equations. Therefore:

* To simulate all of the temperature effects, show the block’s thermal port and, if the
block has a Temperature Dependence tab, set the Parameterization parameter to
one of the provided options, for example, Use an I-V data point at second
measurement temperature.

» To simulate only the generated heat and device temperature, show the block’s thermal
port and, on the Temperature Dependence tab, set Parameterization to None —
Simulate at parameter measurement temperature.

Improving Numerical Performance

Set realistic values for thermal masses and resistances. Otherwise, junction temperatures
can become extreme, and out of range for valid results, which can manifest as numerical
difficulties during simulation. You can test if numerical difficulties are a result of
unrealistic thermal values by turning off the temperature dependence for the electrical
equations, by opening the Block Parameters window, clicking the Thermal Dependence
tab, and setting Parameterization to None — Simulate at parameter
measurement temperature.

The thermal time constants are generally much slower than electrical time constants, so
the thermal aspects of your model are unlikely to dictate the maximum fixed time step
you can simulate at (for example, for hardware-in-the-loop simulations). However, if you
need to remove detail (for example, to speed up simulation), the junction-thermal mass
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time constant is typically an order of magnitude faster than the case-thermal mass time
constant. Yo can remove the effect of the junction-thermal mass by setting the junction-
thermal mass and junction-case thermal resistance to zero.

Model Thermal Losses for a Rectifier
Model Heat Transfer for a Single Rectifier Diode

To model and measure heat transfer as a function of the thermal characteristics of a
semiconductor, connect a Foster model-based thermal network and a temperature sensor
to a block with a thermal port.

1 Open the model. At the MATLAB command prompt, enter:

ee_rectifier diodes

The model contains a three-phase rectifier that includes six Diode blocks.

2 Select a thermal variant for the Diodel block by right-clicking the block and, from the
context menu, selecting Simscape > Block choices. Select Show thermal port.

3  Open the Diodel block. In the Thermal Port settings, set Thermal network to
External.

4 Add a Simscape Electrical block that represents the heat flow between the diode and
the environment. Open the Simulink Library browser, click Simscape > Electrical >
Passive > Thermal, and add a Foster Thermal Model block to the model.

5 Open the Foster Thermal Model block and modify these parameters:
a Thermal resistance data — Specify [ 0.00311 0.008493 0.00252
0.00288 1 K/W.

b Thermal time constant data — Specify [ 0.0068 0.0642 0.3209
2.0212 ]s.

6 Add these blocks to represent the ambient temperature as a constant by using an
ideal temperature source.

a  From the Simulink Library browser, open the Simscape > Foundation Library
> Thermal > Thermal Sources library and add a Controlled Temperature
Source block.

b From the Simscape > Foundation Library > Thermal > Thermal Flements
library, add a Thermal Reference block.
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¢ From the Simscape > Foundation Library > Physical Signals > Sources

library, add a PS Constant block. For the Constant parameter, specify a value of
300.

Add these blocks to measure and display the temperature of Diodel:
a  From the Simulink Library browser, open the Simscape > Foundation Library
> Thermal > Thermal Sensors library and add a Temperature Sensor block.

b From the Simscape > Utilities library, add a PS-Simulink Converter block. For
the Output signal unit parameter, select K.

¢ From the Simulink > Sinks library, and add a Scope block.
Arrange and connect the blocks as shown in the figure.

Diode2 ZL Dioded /' Diode6
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DC Voltage

al P Currents
and
\ Controlled Voltages

[T Temperature Source
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Foster Thermal Model ‘“

Label the signal from the PS-Simulink Converter block to the Scope block by double-
clicking the line between the blocks and entering Temp (K).
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10 Simulate the model.
11 To see the temperature data, open the Scope block.

Temp (K)

L L T L L L L L

The temperature of Diodel fluctuates over a temperature range of 0.3 K as it
increases from the initial value of 300 K to a settling point of 300.6-300.9 K toward

the end of the simulation.
Model Heat Transfer for All Rectifier Diodes

To see the total heat generated by all of the semiconductors in the rectifier, use data
logging and the Simscape Results Explorer.

1 To enable the thermal ports on all the rectifier diodes, select thermal variants for the
Diode2, Diode3, Diode4, Diodeb, and Diode6 blocks by right-clicking the blocks and
selecting Simscape > Block choices > Show thermal port.

3-46



Simulating Thermal Effects in Semiconductors

Open the Diode2, Diode3, Diode4, Diode5, and Diode6 blocks and, in the Thermal
port settings, set Thermal network to External.

Add blocks to measure the heat transfer for each diode by creating a Foster thermal
model subsystem.

a Make a copy of this group of blocks:

* Foster Thermal Model
* Controlled Temperature Source
* PS Constant
* Thermal Reference
b  Arrange and connect the copied blocks as shown in the figure.
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¢ Create a subsystem from the copied blocks and rename the subsystem as
Foster D2. For more information, see “Create a Subsystem” (Simulink).

d  Open the Foster D2 subsystem. Open the Connl block, and for the Port location
on the parent subsystem parameter, select Right.

Z% Diode2
Conn1 J

Foster_D2

e Make four copies of the Foster D2 subsystem. Attach one subsystem to each of
the remaining Diode blocks and rename the subsystems as Foster D3 through
Foster D6 to match the Diode3 through Diode6 block names.

4 Simulate the model.
5 View the results using the Simscape Results Explorer.
a In the model window, in the text under Three-Phase Rectifier, click Explore
simulation results.

b  To display the temperature data for Diodel, in the Simscape Results Explorer
window, expand the Diodel > H node and click T.

¢ To display the DC voltage in a separate plot, expand the Sensing Vdc > Voltage
Sensor node, press CTRL, and click V.

d To display the temperature data for all the diodes, expand the Diode2 > H node,
press CTRL, and click T. Repeat the process for Diode3 through Diode6.
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e To overlay the temperature data in single plot, in the Simscape Results Explorer

window, above the tree-node window, click the options button. In the Options
dialog box, for Plot signals, select Overlay. To accept the change, click OK.
Click and drag the legend down to see the temperature data clearly.
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The temperature profile for each diode lags, in succession, behind the temperature
profile of Diodel. For each diode, the temperature also rises and settles along the
same values as the temperature profile for Diodel. The data indicate that, because of
the lagging behavior of the individual diode temperatures, the temperature of the
rectifier rises and settles along the same temperature profile as the diodes, but with
less fluctuation.



Plot Basic Characteristics for Battery Blocks

Plot Basic Characteristics for Battery Blocks

A quick plot feature lets you visualize the voltage-charge characteristic for battery blocks,
based on the current block parameter values.

This feature is implemented for Battery and Battery (Table-Based) blocks.
To plot the battery voltage-charge characteristics:

1 Right-click a battery block in your model and, from the context menu, select
Electrical > Basic characteristics. The software automatically computes a set of
bias conditions, based on the block parameter values, and opens a figure window
containing a plot of no-load voltage versus the state-of-charge (SOC) for the block.

For example, the following plot corresponds to the default parameter values of a
Battery block with infinite charge.
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2 Ifyou change the block parameter values and plot the characteristics again, the plot

opens in a new window. This way, you can compare the plots side-by-side and see how
the parameter values affect the resulting voltage-charge characteristics for the block.

For example, if you change the Battery charge capacity parameter value to Finite
and Self-discharge to Enabled, the new plot looks like this.
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Plot Basic Characteristics for Semiconductor Blocks

3-56

A quick plot feature lets you visualize the basic I-V characteristics for semiconductor
switching devices, based on the current block parameter values.

This feature is implemented for nonthermal variants of the following blocks in the
Semiconductors library:

* N-Channel IGBT

* N-Channel MOSFET (both threshold-based and surface-potential-based variants)
* P-Channel MOSFET (both threshold-based and surface-potential-based variants)
* N-Channel LDMOS FET

¢ P-Channel LDMOS FET

* N-Channel JFET

* P-Channel JFET

* NPN Bipolar Transistor

* PNP Bipolar Transistor

To plot the characteristics, right-click an appropriate semiconductor block in your model
and, from the context menu, select Electrical > Basic characteristics.

Note For surface-potential-based N-Channel MOSFET and P-Channel MOSFET blocks,
the Electrical > Explore characteristics option is also available. This option opens the
Characteristics Viewer tool, which lets you perform an in-depth study of block
characteristics and match the block behavior to a set of target characteristics. For more
information, see “MOSFET Characteristics Viewer” on page 3-59.

To plot the basic characteristics:

1 Right-click a semiconductor block in your model and, from the context menu, select
Electrical > Basic characteristics. The software automatically computes a set of
bias conditions, based on the block parameter values, and opens a figure window
containing a plot of the DC I-V characteristics for the block.

For example, the following plot corresponds to the default parameter values of a
threshold-based N-Channel MOSFET block.
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2 Ifyou change the block parameter values and plot the characteristics again, the plot
opens in a new window. This way, you can compare the plots side-by-side and see how
the parameter values affect the resulting DC I-V characteristics for the block.

For example, if you change the Gate-source voltage, Vgs, for R_DS(on) parameter
value to 20 V, the new plot looks like this.
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. “MOSFET Characteristics Viewer” on page 3-59
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MOSFET Characteristics Viewer

In this section...

“Suggested Workflow” on page 3-59
“Add and Manage Characteristics” on page 3-61
“Choose Parameters and Generate Plots” on page 3-64

“Save the Results” on page 3-66

The Characteristics Viewer tool lets you study characteristics of a particular
parameterization of a surface-potential-based MOSFET block and match the block
behavior to a set of target characteristics. The tool allows you to:

* Plot simulated data, using the current block parameters.
* Overlay simulated data plots over tabulated target data.

* Modify block parameters.

*  When satisfied with the results of the parameters tuning in the Characteristics Viewer,
update the block parameters in the model.

* Save generated parameter sets for future reuse in a different model.

Suggested Workflow

The Characteristics Viewer tool is available for surface-potential-based N-Channel
MOSFET or P-Channel MOSFET blocks only. To switch to a surface-potential-based
variant when you add an N-Channel MOSFET or P-Channel MOSFET block from the
library, right-click the block in your model and, from the context menu, select Simscape
> Block choices > Surface-potential-based. Then, when you right-click the block
again, the context menu will contain the Electrical option, necessary to start the
parameterization tool.

To use the MOSFET parameterization tool:
1 Right-click a surface-potential-based MOSFET block in your model and, from the

context menu, select Electrical > Explore characteristics. A charactericViewer
window opens.
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MOSFET Characteristics Viewer

Double-click Add characteristics. Specify the characteristics type (target,
simulated, or both), and the desired values. Click Add to plot.

Continue adding more characteristics, as needed. The Replace plot button lets you
replace previously added plots. You can also use the List/Delete characteristics
block, iteratively with Add characteristics, to configure your characteristics set.

Double-click Choose parameters and select the parameters of interest.
Double-click Generate plots.

Iterate between the previous two steps to tune the parameters by matching the
simulation results to the target curves.

When satisfied with the results of the parameters tuning, double-click Update
starting block parameters to update the block parameters in your model. Until you
perform this step, the block in the original model is not affected.

You can double-click Save data to save the generated characteristics as a MAT-file,
for future reuse in a different model.

Add and Manage Characteristics

You start the MOSFET parameters tuning process by specifying the desired set of target
characteristics:

In the charactericViewer window, double-click Add characteristics.

The Characteristics window opens.
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Block Parameters: Characteristics et

Parameters

Plot number |

Characteristic type Target and simulated -

Sweep type |V_D5 7
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Add to plot Replace plot

Cancel Help Apply

Enter Plot number. This number defines the number of the figure that the
characteristic will be plotted on. It allows you to add multiple characteristics to the
same figure, for overlaying characteristics on top of each other. However, the figure
will comprise one xy-axis only.

Specify the Characteristic type:

* Target only — The plot will contain data that you specified, in terms of both
input and output values. No simulation will be performed in this case. The data
will simply be added to the appropriate plot.

* Simulated only — The plot will contain data that is a result of a simulation over
the input bias conditions that you specify.

* Target and simulated — The plot will contain both types of data. This option
is useful if you are trying to adjust parameters for the model to fit data that you
have extracted from a datasheet.
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10

11

12

Select Sweep type, which defines the x-axis variable for the resultant plot:

* V_GS — Sweep over the gate-source voltage.
* V_ DS — Sweep over the drain-source voltage.

* I D — Sweep over the drain current. Normally, the drain current is not a typical
input for a characteristic sweep.

If the Characteristic type is Simulated only, specify Sweep range. This is a
vector of values indicating the range for the swept variable. Only the minimum and
maximum values of this vector are utilized by the tool, since the exact sample points
for the output data are determined by the variable-step simulation.

If the Characteristic type is Target only or Target and simulated, specify
Sweep values. This is a vector of values for the swept variable at which the output is
sampled for the target data. As an example, for an I D-V DS characteristic extracted
from a datasheet, the vector would contain the V_DS values corresponding to the
sampled I D values in the target curve.

Select Step type to define the second independent input bias condition. The choices
are the same as for Sweep type. For example, if an I D-V DS curve is defined as
being at a constant V_GS, choose V_GS for Step type.

Use Step values to specify the values for the stepped variable. For example, if an
I DV DS curve is desired for V_GS values of 0 and 10V, set Step type to V_GS and
Step values to [0 10].

Select Output type, which defines the output measurement for the characteristic.
This is the y-axis variable for the resultant plot. The available values are: V_GS, V_DS,
I D,C GG, C GD, C DG, and C_DD. The capacitances C GG, C GD, C DG, and C DD
are defined according to their terminals. To relate these quantities to the datasheet
parameters of Ciss, Crss and Coss, note that C GG = Ciss, C DD = Coss, and C GD =
CrssatV _GS = 0.

V_GS is not a good choice as an output for the surface-potential-based MOSFET
model. This value is provided in anticipation of using this tool for other device types.

If the Characteristic type is Target only or Target and simulated, specify
Output values. This is the target data that you want to plot in the figures. Provide
this data as an m-by-n matrix, where m is the size of Step values and n is the size of
Sweep values.

Click Add to plot to add the characteristic specification to the appropriate Plot
number.

Continue adding more characteristics, as needed.
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The Replace plot button lets you replace previously added plots. You can also use
the List/Delete characteristics block, iteratively with Add characteristics, to
configure your characteristics set.

Choose Parameters and Generate Plots

After you have specified the desired set of target characteristics, the next step is to define
the parameters for the MOSFET block:

1 Inthe charactericViewer window, double-click Choose parameters.
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Block Parameters: Tuner
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The Tuner window opens. It contains a series of sliders on different tabs, according to
which feature of the MOSFET characteristics is most impacted by the specific
parameter:

* The VT tab displays parameters that primarily impact the threshold voltage
(gamma and phib2ref).

* The parameters on the DC tab primarily affect the DC characteristics.
* The parameters on the AC tab primarily affect the MOSFET dynamics.
* The parameters on the T tab affect temperature scaling.

* The parameters on the FIXED tab are generally fixed at some particular value
that is not easy to derive from the displayed characteristics, such as the
simulation temperature and the gate resistance (which is often indicated directly
on datasheets).

* The EXTRAS tab contains other parameters, which impact the characteristics in
ways similar to parameters that already appear on other tabs. For example, Rsref
(the series resistance associated with the source) operates similarly to betaref
from the DC tab. As a result, it is not always possible to disentangle these two
effects.

2 Use the sliders on the appropriate tabs of the Tuner dialog.

You can modify the min and max values, as needed, because they simply define the
range over which the various sliders work. These values have no meaning for the
underlying model parameters. Changing a min or max value automatically updates
the slider range, without needing to click OK or Apply.

3 After adjusting the sliders, generate the plots to see how close the simulation data is
to the target data. In the charactericViewer window, double-click Generate
plots.

4 Iterate between tuning the parameters and generating plots until the simulation
results match the target curves.

Save the Results

Once you are satisfied with the results of the parameters tuning:

* Double-click Update starting block parameters to update the block parameters in
your model. Until you perform this step, the block in the original model is not affected.
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Note For this step to work, the original model must stay open while you are tuning
the parameters.

* You can also double-click Save data to save the generated characteristics as a MAT
file, for future reuse in a different model. Specify the file name for saving the data.
Inside the file, all the data is saved in an object named parameterHelper.

To apply the parameters stored in this object to another MOSFET block, select the
MOSFET block in a model and, in the MATLAB Command Window, type:

parameterHelper.parameters.updateBlockParameters(gcbh)

This command applies the parameter values to the block defined by the handle gcbh.
You can also use a string instead of the block handle, for example:
parameterHelper.parameters.updateBlockParameters(gcb)

To inspect the parameters directly, type parameterHelper.parameters.values for
the values (stored as character vectors) or parameterHelper.parameters.names
for the names.

See Also

More About

. Interactive Generation of MOSFET Characteristics
. “Plot Basic Characteristics for Semiconductor Blocks” on page 3-56
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Converting a SPICE Netlist to Simscape Blocks
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In this section...

“Commands” on page 3-68

“Numeric Suffixes” on page 3-69
“Mathematical Functions” on page 3-70
“Symbols” on page 3-72

“Components” on page 3-72

“Performing Manual Conversions” on page 3-75

“Limitations” on page 3-76

You can convert SPICE components into Simscape equivalents using the SPICE
conversion assistant. Often this conversion is automatic. However, because SPICE is a
rich language, it is not always possible to perform a full conversion without some manual
intervention.

To convert SPICE subcircuits into equivalent Simscape components, follow these steps.

1  Use the subcircuit2ssc function to generate Simscape language component files
from a SPICE netlist file. You can use the optional subcircuitl,..,subcircuitN
input arguments to specify which subcircuits to convert.

2 Make any necessary manual conversions to the generated Simscape component files.
To identify the required manual conversions, check the comments at the beginning of
the generated Simscape component files. You can use the optional
unsupportedCommands output argument to generate a struct array that lists
unsupported SPICE commands for each subcircuit.

3 Build the library using ssc_build or add individual components to your model using
Simscape Component blocks.

There are many different SPICE simulators with variations in syntax and syntax

interpretation. The conversion assistant uses the same syntax as Cadence® PSpice and,
where such differences exist, complies with PSpice.

Commands

The SPICE conversion assistant supports these commands:



Converting a SPICE Netlist to Simscape Blocks

* .FUNC — Reusable function

* .PARAM — Definable parameter

* .MODEL — Set of reusable component parameters

* .SUBCKT — Subcircuit

* .LIB — Directive to include models from an external netlist
* .INC — Directive to include contents of external netlist

The conversion assistant implements . FUNC SPICE commands using Simscape functions.
These functions are placed inside a package sublibrary named

+subcircuit name simscape functions, where subcircuit name is the name of
the subcircuit being converted.

Specify the .MODEL syntax for resistors, capacitors, and inductors, as

.MODEL <model name> res(r=<value>)

.MODEL <model name> cap(c=<value>)

.MODEL <model name> ind(l=<value>)

where the r, ¢, and 1 values are scaling factors for the value specified on the component
declaration. This behavior complies with PSpice, but is not consistent across all
simulators.

The conversion assistant does not automatically convert initial conditions specified using
the . IC statement. However, you can specify initial conditions for capacitors and
inductors using the syntax IC=<value>. Also, you can manually convert any . IC
statements from the generated Simscape component files.

Because the purpose of the conversion assistant is to help convert SPICE subcircuits into
Simscape blocks, simulation commands, such as . TRAN, are ignored.

Numeric Suffixes

The conversion assistant supports these numeric SPICE suffixes:

Suffix Name Scale
T Tera lel?2
G Giga 1le9
MEG Mega leb6

K Kilo le3
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Suffix Name Scale

M Milli le-3
MIL -- 25.4e-6
U Micro le-6

N Nano le-9

P Pico le-12

F Femto le-15

Mathematical Functions

The conversion assistant supports these basic mathematical functions used in SPICE and

MATLAB.

Elementary Math

Name SPICE Function MATLAB Function
Absolute value abs abs

Smallest element min min

Largest element max max

Sign function sgn sign

Trigonometry

Name SPICE Function MATLAB Function
Sine sin sin

Inverse sine asin asin

Hyperbolic sine sinh sinh

Cosine cos cos

Inverse cosine acos acos

Hyperbolic cosine cosh cosh




Exponents and Logarithms

Name SPICE Function MATLAB Function
Tangent tan tan

Inverse tangent atan atan
Four-quadrant inverse atan2 atan2

tangent

Hyperbolic tangent tanh tanh

Exponents and Logarithms

Name SPICE Function MATLAB Function
Power ** or pwr ~ or power
Exponential exp exp

Natural logarithm 1n or log log

Base-10 logarithm logl0 loglo

Square root sqrt sqrt

The conversion assistant interprets Log() as the natural logarithm rather than the
base-10 logarithm. Not all SPICE simulators are consistent in this regard, so ensure that

this interpretation is congruent with your SPICE model.

Other

In addition, the conversion assistant supports these SPICE functions:

Name SPICE Function
If condition if

Saturation limit

Current through device i

Voltage across device v

Step function stp
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Symbols

The conversion assistant recognizes these SPICE symbols:

* + at the start of a line indicates line continuation from the previous line
* * at the start of a line indicates that the entire line is a comment
* ; within a line indicates the beginning of an inline comment

Components

The notation for SPICE commands in this section follows these rules:

* <argument> refers to a required item in a command line

* <argument>* refers to a required item in a command line that occur one or more
times

* [argument] refers to an optional item in a command line

* [argument]* refers to an optional item in a command line that occur zero or more
times

This list shows the full set of supported SPICE components, and their supported SPICE
netlist notations. You can specify only the .MODEL parameters that differ from SPICE
default values.

Sources

* Independent voltage source

V<name> <+ node> <- node> [DC] <value>

V<name> <+ node> <- node> exp(<vl> <v2> <tdl> <tcl> <td2> <tc2>)
V<name> <+ node> <- node> pulse(<vl> <v2> <td> <tr> <tf> <pw> <per>)
V<name> <+ node> <- node> pwl(<<tj> <vj>>*)

V<name> <+ node> <- node> sffm(<voff> <vampl> <fc> <mod> <fm>)
V<name> <+ node> <- node> sin(<voff> <vampl> <freg> <td> <df>)

* Independent current source

I<name> <+ node> <- node> [DC] <value>

I<name> <+ node> <- node> exp(<il> <i2> <tdl> <tcl> <td2> <tc2>)
I<name> <+ node> <- node> pulse(<il> <i2> <td> <tr> <tf> <pw> <per>)
I<name> <+ node> <- node> pwl(<<tj> <ij>>*)

I<name> <+ node> <- node> sffm(<ioff> <iampl> <fc> <mod> <fm>)
I<name> <+ node> <- node> sin(<ioff> <iampl> <freq> <td> <df>)

* Current-controlled voltage source



Passive Devices

H<name>
H<name>
H<name>
H<name>
H<name>

<+
<+
<+
<+
<+

node>
node>
node>
node>
node>

<-
<-
<-
<-
<-

node> <voltage source name> <gain>

node> VALUE={<expression>}

node> POLY(<value>) <voltage source name>* <coefficient>*

node> TABLE {<expression>}=< <input value>, <output value> >*

node> <voltage source name> TABLE=< <input value>, <output value> >*

* Voltage-controlled voltage source

E<name>
E<name>
E<name>
E<name>
E<name>

node>
node>
node>
node>
node>

<-
<-
<-
<-
<-

node> <+ control node> <- control node> <gain>

node> VALUE={<expression>}

node> POLY(<value>) <<+ control node> <- control node>>* <coefficient>*
node> TABLE {<expression>}=< <input value>, <output value> >*

node> <+ control node> <- control node> TABLE=< <input value>, <output value> >*

e Current-controlled current source

F<name>
F<name>
F<name>
F<name>
F<name>

<+
<+
<+
<+
<+

node>
node>
node>
node>
node>

<-
<-
<-
<-
<-

node> <voltage source name> <gain>

node> VALUE={<expression>}

node> POLY(<value>) <voltage source name>* <coefficient>*

node> TABLE {<expression>}=< <input value>, <output value> >*

node> <voltage source name> TABLE=< <input value>, <output value> >*

* Voltage-controlled current source

G<name>
G<name>
G<name>
G<name>
G<name>

node>
node>
node>
node>
node>

<-
<-
<-
<-
<-

node> <+ control node> <- control node> <gain>

node> VALUE={<expression>}

node> POLY(<value>) <<+ control node> <- control node>>* <coefficient>*
node> TABLE {<expression>}=< <input value>, <output value> >*

node> <+ control node> <- control node> TABLE=< <input value>, <output value> >*

* Behavioral source (The <expression> does not need to appear in braces {})

B<name> <+ node> <- node> V=<expression>
B<name> <+ node> <- node> I=<expression>

Passive Devices

e Resistor

R<name> <+ node> <-

.MODEL <model name>

* Capacitor

C<name> <+ node> <-

.MODEL <model name>

e Inductor

L<name> <+ node> <-
.MODEL <model name> ind(l=<value>)

node> [model name] <value>
res(r=<value>)

node> [model name] <value> [IC=<value>]
cap(c=<value>)

node> [model name] <value> [IC=<value>]

* Inductor coupling

K<name> <inductor name> <inductor name>* <value>
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Switches

Voltage-controlled switch

S<name> <+ node> <- node> <+ control node> <- control node> <model name>
.MODEL <model name> sw(ron=<value>, roff=<value>, vt=<value>, vh=<value>)

Current-controlled switch

W<name> <+ node> <- node> <voltage source name> <model name>
.MODEL <model name> csw(ron=<value>, roff=<value>, it=<value>, ih=<value>)

Semiconductor Devices

Diode

D<name> <+ node> <- node> <model name> [area]

.MODEL <model name> d(is=<value>, rs=<value>, n=<value>, cjo=<value>, vj=<value>,
+m=<value>, fc=<value>, tt=<value>, revbrk=<value>, bv=<value>, ibv=<value>,
+xti=<value>, eg=<value>)

Bipolar junction transistor (B]JT)

NPN

Q<name> <collector node> <base node> <emitter node> [substrate node] <model name> <area>

.MODEL <model name> npn(bf=<value>, br=<value>, cjc=<value>, cje=<value>, cjs=<value>,
+eg=<value>, fc=<value>, ikf=<value>, ikr=<value>, irb=<value>, is=<value>, isc=<value>,
+ise=<value>, itf=<value>, mjc=<value>, mje=<value>, mjs=<value>, nc=<value>, ne=<value>,
+nf=<value>, nr=<value>, rb=<value>, rbm=<value>, rc=<value>, re=<value>, tf=<value>,
+tr=<value>, vaf=<value>, var=<value>, vjc=<value>, vje=<value>, vjs=<value>, vtf=<value>,
+xcjc=<value>, xtb=<value>, xtf=<value>, xti=<value>)

PNP

Q<name> <collector node> <base node> <emitter node> [substrate node] <model name> <area>

.MODEL <model name> pnp(bf=<value>, br=<value>, cjc=<value>, cje=<value>, cjs=<value>,
+eg=<value>, fc=<value>, ikf=<value>, ikr=<value>, irb=<value>, is=<value>, isc=<value>,
+ise=<value>, itf=<value>, mjc=<value>, mje=<value>, mjs=<value>, nc=<value>, ne=<value>,
+nf=<value>, nr=<value>, rb=<value>, rbm=<value>, rc=<value>, re=<value>, tf=<value>,
+tr=<value>, vaf=<value>, var=<value>, vjc=<value>, vje=<value>, vjs=<value>, vtf=<value>,
+xcjc=<value>, xtb=<value>, xtf=<value>, xti=<value>)

Junction field-effect transistor (JFET)

N-Channel

J<name> <drain node> <gate node> <source node> <model name> [area]
.MODEL <model name> njf(beta=<value>, cgd=<value>, cgs=<value>, fc=<value>, is=<value>,
+lambda=<value>, m=<value>, n=<value>, rd=<value>, rs=<value>, vto=<value>, xti=<value>)

P-Channel



Subsystems

J<name> <drain node> <gate node> <source node> <model name> [area]
.MODEL <model name> pjf(beta=<value>, cgd=<value>, cgs=<value>, fc=<value>, is=<value>,
+lambda=<value>, m=<value>, n=<value>, rd=<value>, rs=<value>, vto=<value>, xti=<value>)

* Metal-oxide-semiconductor field-effect transistor (MOSFET)

N-Channel (only level-1 and level-3 are supported)

M<name> <drain node> <gate node> <source node> <bulk node> <model name>
+[L=<value>] [W=<value>] [AD=<value>] [AS=<value>] [PD=<value>] [PS=<value>] [NRD=<value>]
+[NRS=<value>] [M=<value>]

.MODEL <model name> nmos (cbd=<value>, cbs=<value>, cgbo=<value>, cgdo=<value>,
+cgso=<value>, cj=<value>, cjsw=<value>, delta=<value>, eta=<value>, fc=<value>,
+gamma=<value>, is=<value>, js=<value>, kappa=<value>, kp=<value>, lambda=<value>,
+ld=<value>, level=<value>, mj=<value>, mjsw=<value>, n=<value>, neff=<value>, nfs=<value>,
+nss=<value>, nsub=<value>, nrd=<value>, nrs=<value>, pb=<value>, phi=<value>, rd=<value>,
+rs=<value>, rsh=<value>, theta=<value>, tox=<value>, tpg=<value>, ucrit=<value>,
+uexp=<value>, uo=<value>, vmax=<value>, vto=<value>, xj=<value>)

P-Channel (only level-1 and level-3 are supported)

M<name> <drain node> <gate node> <source node> <bulk node> <model name>
+[L=<value>] [W=<value>] [AD=<value>] [AS=<value>] [PD=<value>] [PS=<value>] [NRD=<value>]
+[NRS=<value>] [M=<value>]

.MODEL <model name> pmos (cbd=<value>, cbs=<value>, cgbo=<value>, cgdo=<value>,
+cgso=<value>, cj=<value>, cjsw=<value>, delta=<value>, eta=<value>, fc=<value>,
+gamma=<value>, is=<value>, js=<value>, kappa=<value>, kp=<value>, lambda=<value>,
+ld=<value>, level=<value>, mj=<value>, mjsw=<value>, n=<value>, neff=<value>, nfs=<value>,
+nss=<value>, nsub=<value>, nrd=<value>, nrs=<value>, pb=<value>, phi=<value>, rd=<value>,
+rs=<value>, rsh=<value>, theta=<value>, tox=<value>, tpg=<value>, ucrit=<value>,
+uexp=<value>, uo=<value>, vmax=<value>, vto=<value>, xj=<value>)

Subsystems

» Subcircuit

X<name> [node]* <subcircuit name> [PARAMS: < <name>=<value> >*]

Performing Manual Conversions

After you generate the Simscape component files, inspect each file header for messages
regarding unsupported SPICE commands. For example, the conversion assistant does not
support the implementation of temperature coefficients for resistors:

Rl p n 1k TC=0.01,-0.002

The generated Simscape component file contains all the supported conversions, and this
header, which identifies the temperature coefficients of the resistor for manual
conversion:

component test
% test
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Component automatically generated from a SPICE netlist (11-Dec-2018 09:34:57).
Users should manually implement the following SPICE commands in order to
achieve a complete implementation:

R1: tc 0.01 -0.002

o° o° o o°

To complete the conversion, modify the Simscape component file to implement the
missing components. For more information about performing manual conversions and this
particular scenario, see subcircuit2ssc.

Limitations

* The netlist must be written in PSpice format and be syntactically correct. The
conversion assistant does not check for proper PSpice syntax.

* Only a subset of the PSpice netlist language is supported. However, unsupported
PSpice commands are identified at the top of the corresponding Simscape component
file to facilitate manual conversion.

* To build generated Simscape components into Simscape blocks, parameter values
must conform to Simscape constraints. For example, capacitance of a fundamental
capacitor and inductance of a fundamental inductor must be nonzero.

See Also

ssc_build | subcircuit2ssc

More About

. “Building Custom Block Libraries” (Simscape)
. “Composite Components” (Simscape)



Photovoltaic Thermal (PV/T) Hybrid Solar Panel

Photovoltaic Thermal (PV/T) Hybrid Solar Panel

This example shows how to model the cogeneration of electrical power and heat using a
hybrid PV/T solar panel. The generated heat is transferred to water for household
consumption.

It uses blocks from the Simscape™ Foundation™, Simscape Electrical™, and Simscape
Fluids™ libraries. The electrical portion of the network contains a Solar Cell block, which
models a set of photovoltaic (PV) cells, and a Load subsystem, which models a resistive
load. The thermal network models the heat exchange that occurs between the physical
components of the PV panel (glass cover, heat exchanger, back cover) and the
environment. Heat is exchanged through conduction, convection, and radiation. The
thermal-liquid network contains a pipe, a tank, and pumps. The pumps control the flows
of the liquids through the system.

To model the reflection, absorption and transmission of light in the glass cover, an optical
model is embedded in a MATLAB® Function block.

Model overview

Open the model to view its structure:

open_system('sscv _hybrid solar panel');
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. Plot outputs: temperatures, power, volume of tank. (see code)
. Calculate efficiencies: electrical and thermal (see code)
. Explore simulation resulis using sscexplore

The thermal network is in red, the electrical network in blue and the thermal liquid
network in yellow. There are subsystems for the solar and pump inputs. There is also a
subsystem that contains scopes for visualizing the simulation results. Another subsystem
contains the function for the optical model.

Parameters

You can use the hybrid solar panel data.m script to change the parameter values that
this example uses for components such as the load, solar cell, pipe, and tank.

edit sscv_hybrid solar_panel data;

Inputs

The inputs of the model are the pump flows and the solar variables for irradiance and
incidence angle. A repeating sequence block is used to define the inputs because they
follow a 24-hour periodic cycle.

open_system('sscv _hybrid solar panel/Solar inputs');



Photovoltaic Thermal (PV/T) Hybrid Solar Panel

1] e &

solar_irradiance

WV V—<2]

solar_inclination

open_system('sscv_hybrid solar panel/Pump flow inputs');

(7]

intermal_flow

—_—

demand

—_—

supply

The sun rises at 6:00 and sets at 19:00. The irradiance follows a bell curve that peaks at
12:30. The incidence angle changes from pi/3 to 0

There are three pumps. One pump models user demand, another models source supply,
and a third models internal flow that forces convection in the pipe. The demand is
constant and only non-zero from 10:00 to 22:00. The supply is constant and only non-zero
from 18:00 to 6:00. The internal flow is also constant and only non-zero from 6:00 to
22:00. This model is used for the internal flow because it is not efficient to force heat
exchange during the night when the ambient temperature is low.

You can use the hybrid solar panel plot inputs.m script to plot the inputs:

sscv_hybrid solar _panel plot inputs;
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Optical model for the glass cover
The optical model is inside a subsystem:

open_system('sscv_hybrid solar panel/Optical model');
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It consists of a MATLAB® Function block, with the 2 solar inputs, and 3 outputs: the
transmitted irradiance on the PV cells, the heat absorbed by the glass, and the radiative
power absorbed by the PV cells. Part of it will be transformed into electrical power (V*I)
and the rest will be heat absorbed by the PV cells.

From an optical point of view, the glass consists of 2 parallel boundaries (air-glass, glass-
air), each one of those reflects and transmits light. The reflection coefficient in a
boundary is obtained from the Fresnel equations. " is for P-polarizarion and " for S-
polarization. The total reflection is the average of both, and the transmittance is 1 — r as
there is no absorption so far:

3
B (,r,-:fll.rlxﬁ[{l,-j 1,",.-""1:.:IJ :sinli_l")',:,'li)

JI--l a P L - a3
: n: ,cos(f;) 4 ‘w‘”*f..l sin(#; )=

. N T 2
cos(t;) — /n;,; — sin(#;)-
ry = E 5
cos( ;) 4 ‘.,-"F“.-E-. ; — sin(@;)-
1 .
=3 (rp + 1s)
ti=1-r

This is an example of the optical coefficients rp, rs, r and t in function of incidence angle:

nrel = 1.52; %0ptical index from air to glass

theta = linspace(0, pi/2, 100);

rp = ( nrel”2*cos(theta) - sqrt(nrel”2 - sin(theta).”2) )."2./...
( nrel”2*cos(theta) + sqrt( nrel”2 - sin(theta).”2 ) ).”2 ;
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rs = ( cos(theta) - sqrt(nrel”2 - sin(theta).”2) ).”2./...
( cos(theta) + sqrt( nrel”2 - sin(theta).”2 ) ).”2 ;

r=0.5%(rp + rs);

t=1-r;

figure();

plot(theta*180/pi, rp, 'Color', [0 1 1], 'LineWidth', 1.5);

hold on

plot(theta*180/pi, rs, 'Color', [0 0.5 1], 'LineWidth', 1.5);

plot(theta*180/pi, r, 'Color', [0 O 1], 'LineWidth', 1.5);

plot(theta*180/pi, t, 'Color', 'm', 'LineWidth', 1.5);

legend('rp','rs','r','t");

xlabel('Incidence angle (deg)');
grid on
box on
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This is what happens in one boundary, but the glass has 2 parallel boundaries separated

by dy. The angle after the 1st boundary is the incidence angle on the 2nd boundary and is
calculated from Snell's Law:

ny sin{fh ) = ng sin(fy)

When the light enters the glass, it absorbs part of it with a constant probability per unit
length (alpha @), resulting in an exponential decay from distance travelled for the
transmittance coefficient in the glass:

- exn il
Ty = X cos(th)



Photovoltaic Thermal (PV/T) Hybrid Solar Panel

Then, when it arrives to the 2nd boundary, it reflects and transmits again with Fresnel
equations. The reflected light is trapped inside the glass, reflecting infinite times between
the 2 boundaries until completely absorbed. The total reflection and transmission

coefficients of the system are then the sum of an infinite geometrical series, for which the
result is:

- r[T-'_.'r'}
T, = — 1=
. 1 rireTy
2 I )
f;rr;rg
R_;- =r +

]
1 — riraT;

Ag=1-T, - Ry

Finally, the total optical coefficients for the glass are:

sscv_hybrid solar panel plot optics;
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1 Reflection coefficient
05 .
D 1 i 1 1 1 1 i 1
0 10 20 30 40 50 a0 7o 80 a0
3?2 1072 Absorption coefficient
2 4
1 = -
D 1 i 1 1 1 1 i 1
0 10 20 30 40 50 a0 7o 80 a0
1 Transmission coefficient
s T
D 1 i 1 1 1 1 i 1
0 10 20 30 40 50 a0 7o 80 a0

Incidence angle (deg)
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Outputs

The outputs of the model are the temperatures of all components of the panel, the
electrical and thermal power, and the volume in the tank.

You can use the script hybrid solar panel plot outputs to plot the solution:

sscv_hybrid solar panel plot outputs;

Temperatures
T T T LI T T — T
320 /""’- \ -t % /z-"‘ -
o \ ,_/ \ -~ = = =(Glass
\ / . S e Salar calls
ES'H} ;f - 11 !‘ 2 /! —_ ===~ Exchangar | ]
= | == A i, == ‘\i [y Back
300 f.l' "\‘\ i !‘.\ !t’ Tankwalar | |
‘ 1 \I pa i 1 _— I b I W
0 10 20 30 40 50 60 70 BO
Useful Power
T T I'/ \ T T T ]
400 == Elkatrical powar 1o load
'-. ————— Tharmal pawar ta damandad watar
- 1 ‘
= 200 k! ; .
\ \
kY N,
L]
0 i I I |
0 20 50 60 70 80
Water volume in the tank
0z T T T T T J
o015 b
E
0.1 b
1 I I 1 I I /
0 10 20 30 40 50 60 70 80

Time [h]

Efficiency calculation

From the outputs it is possible to calculate the electrical, thermal, and total efficiency of

the panel:

sscv_hybrid solar panel efficiency;

rpfkkx Efficiency Calculation xxokokkxx
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Total input energy from the sun in the period: 43.7919 kWh
Average input energy from the sun per day: 14.5973 kWh/day

Total electrical energy supplied to the load: 7.5163 kWh
Average electrical energy supplied per day: 2.5054 kWh/day

Total absolute thermal energy in the water supplied to the user: 26.1097 kWh
Total absolute thermal energy in the water extracted from the source: 16.5053 kWh

Total used thermal energy (sink - source): 9.6044 kWh
Average used thermal energy per day (sink - source): 3.2015 kWh/day

Electrical efficiency: 0.17164
Thermal efficiency: 0.21932
Total efficiency: 0.39095

>k 3k 3k 3k 3ko3ko3k koK Sk Sk Sk Sk Sk 5k 5k 5k 5K 5K 5K 5K 5K 5K 3K K K K K K >k >k >k >k >k >k kokok sk

The electrical efficiency is on the order of standard PV cells, but adding the thermal
efficiency the production of energy is significantly better, with a system efficiency on the
order of a cogeneration plant.

A further analysis could use Simulink® Design Optimization™ or other optimization tools
to find optimal values for certain parameters eligible for control, maximizing total
efficiency.

Another improvement would be the addition of controllers to the pumps and the electrical
load, in order to drive the system to different operating points and optimize the
performance.

clear variables

close all
bdclose all

See Also
Solar Cell
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Modeling Machines

* “Machine Parameterization” on page 4-2

* “Per-Unit Conversion for Machine Parameters” on page 4-4

* “Machine Plotting and Display Options” on page 4-6

» “Initialize Synchronous Machines and Controllers” on page 4-8
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Machine Parameterization

4-2

In Simscape Electrical software, induction machines are parameterized using
fundamental parameters. Each synchronous machine is parameterized using standard or
fundamental parameters.

Machine fundamental parameters include the values of inductances and resistances of the
stator and rotor d- and g-axis equivalent circuits. These parameters fully specify the
electrical characteristics of the machine, but you cannot determine them directly from
machine test responses. Hence, it is more common to parameterize a synchronous
machine using a standard parameter set. You can obtain the standard parameters by
observing responses at the machine terminals with suitable tests scenarios.

You can tell the parameter set a block uses because the block name includes the
parameter set name, e.g. Induction Machine Squirrel Cage. The parameters you can set
in the block dialog box correspond to the parameterization type.

If a machine block has standard and fundamental variants, base your block choice on the
parameters you are most familiar with or you have available. Standard block variants use
classical equations to convert standard parameter values that you enter to fundamental
parameter values for use at run time.

If a machine block has an SI and a per-unit variant, base your block choice on the
parameters you have available. For machine blocks that are SI variants, you enter the
number of pole pairs and the SI values for the nominal voltage, power, and frequency on
the main tab of the dialog box. You also enter SI values for the resistance and reactance
parameters on the impedance tab, and for the magnetic flux linkage parameters on the
initial condition tab. The block uses classical equations to calculate per-unit base values
from the parameters on the main tab. It expresses the resistance, inductance, and
magnetic flux linkage parameters as per-unit ratios of the SI values (resistance,
reactance, and magnetic flux linkage) and the base values for use at run time.

The field circuit and rotational ports of machine blocks use SI units. However, the pu
measurement port of machine blocks outputs a vector of physical signals in per-unit.



See Also

See Also

More About

. “Per-Unit System of Units” on page 1-10
. “Per-Unit Conversion for Machine Parameters” on page 4-4
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Per-Unit Conversion for Machine Parameters

4-4

In this section...

“Impedance Conversion Equations” on page 4-4
“Magnetic Flux Linkage Conversion Equations” on page 4-4

Impedance Conversion Equations

For machine impedance parameters (resistance, inductance, and reactance), the
relationships between SI and per-unit values are defined by these equations:

_ Ren
Rpase

X(sn

L=X=
Xbase

where:

* Ry is the resistance, expressed in Q.

* Ry is the per-unit base resistance, expressed in Q.
* R is the per-unit resistance.

* Xy is the reactance, expressed in Q.

*  Xpse 1S the per-unit base reactance, expressed in Q.
* X is the per-unit reactance.

» L is the per-unit inductance.

Magnetic Flux Linkage Conversion Equations

For machine magnetic flux linkage parameters, the relationship between SI and per-unit
values is defined by

C)))
v Ybase

where:




See Also

* Y is the magnetic flux linkage, expressed in Wh.
*  Wpese 1S the per-unit base magnetic flux linkage, expressed in Wb.
* y is the per-unit magnetic flux linkage.

See Also

More About
. “Per-Unit System of Units” on page 1-10
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Machine Plotting and Display Options

4-6

Use the Electrical menu on the block context menu to perform plotting and display
actions for certain blocks in the Simscape ElectricalElectromechanical sublibrary. For
example, you can plot torque versus speed for the Induction Machine Wound Rotor block,
either in SI or per-unit units.

Using other options on the Electrical menu, you can display values in per-unit or display
base parameter values in the MATLAB Command Window. These options enable you to
initialize and tune your three-phase machine quickly.

Asynchronous Machine Options

The context menus of certain asynchronous machine blocks contain some or all of these
options:

Display Base Values — Displays the machine per-unit base values in the MATLAB
Command Window.

Plot Torque Speed (SI) — Plots torque versus speed, both measured in SI units, in a
MATLAB figure window using the present machine parameters.

Plot Torque Speed (pu) — Plots torque versus speed, both measured in per-unit, in a
MATLAB figure window using the present machine parameters.

Plot Open-Circuit Saturation — Plots terminal voltage versus no-load stator
current, both in per-unit, or, for SI blocks, in V and A, respectively, in a MATLAB figure
window. The plot contains three traces:

¢ Unsaturated
¢ Saturated

¢ Derived

Plot Saturation Factor — Plots saturation factor applied to magnetic inductance
versus magnetic flux linkage in per-unit, or for SI blocks, in Wb, in a MATLAB figure
window.

Plot Saturated Inductance — Plots magnetizing inductance versus per-unit
magnetic flux linkage, both in per-unit, or, for SI blocks, in H and Wb, respectively, in a
MATLAB figure window.



Machine Plotting and Display Options

Induction Machine Options

The context menus of certain induction machine blocks contain some or all of these
options for displaying the associated values in the MATLAB Command Window:

* Display Base Values — Displays the machine per-unit base values in the MATLAB
Command Window

* Display Associated Base Values — Displays the associated per-unit base values in
the MATLAB Command Window.

* Display Associated Initial Conditions — Displays the associated intitial condition
values in the MATLAB Command Window.

¢ Plot Open-Circuit Saturation (pu) — Plots air-gap voltage, V,,, versus field current,

Iz, both measured in per-unit, in a MATLAB figure window. The plot contains three
traces:

* Unsaturated — Stator d-axis mutual inductance (unsaturated), Ladu you
specify
* Saturated — Per-unit open-circuit lookup table (Vag versus ifd) you specify

* Derived — Open-circuit lookup table (per-unit) derived from the Per-unit open-
circuit lookup table (Vag versus ifd) you specify. This data is used to calculate
the saturation factor, K, versus magnetic flux linkage, v, characteristic.

* Plot Saturation Factor (pu) — Plots saturation factor, K, versus magnetic flux
linkage, y,;, both measured in per-unit, in a MATLAB figure window using the present
machine parameters. This value is derived from parameters you specify:

* Stator d-axis mutual inductance (unsaturated), Ladu
*  Per-unit field current saturation data, ifd
* Per-unit air-gap voltage saturation data, Vag

Machine Inertia Block Options

For the Machine Inertia block, you can display the inertia parameters and base values
using the Electrical menu on the block context menu. The block displays parameter
values in the MATLAB Command Window.
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Initialize Synchronous Machines and Controllers

4-8

In Simscape Electrical software, you can specify steady-state power and voltage values
for a synchronous machine. Based on the values you specify, the machine block calculates
the initial field circuit and rotational input values required to achieve this steady state.
Starting a machine at steady state prevents undesired transient effects in your simulation.

Calculate the required power and voltage characteristics of your load circuit.

2 In the Initial Conditions tab of the dialog box, set Specify initialization by to
Electrical power and voltage output.

3  Enter the required power and voltage values and click OK.

Right-click the machine block and select Electrical > Display Associated Initial
Conditions.

Simscape Electrical Power Systems calculates the field circuit and rotational port
values required to start the machine in steady state and displays them in the
MATLAB Command Window.

5 Use these values to input parameters to the blocks connected to the field circuit and
rotational ports of the synchronous machine.

Note If you set Specify initialization by to Mechanical and magnetic states,
Simulink does not calculate the associated initial conditions fro the machine.




Customization

* “Build Custom Blocks Using the Three-Phase Electrical Domain” on page 5-2
* “Custom Synchronous Machine” on page 5-4
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Build Custom Blocks Using the Three-Phase Electrical
Domain

5-2

Simscape Foundation domains include a three-phase electrical domain. You can use this
domain to develop your own custom three-phase blocks using Simscape language. To
refer to this domain in your custom component declarations, use the following syntax:

foundation.electrical.three phase

Additionally, the ThreePhaseExamples library, included in the Simscape Electrical product
examples, contains a Fundamental library, a Transforms library, and the following custom
three-phase components:

* Permanent Magnet Synchronous Motor
* Synchronous Machine

* Synchronous Machine (simplified)

* Zigzag Transformer

You can use these simplified example models to write your own custom component files.

To open the custom library, at the MATLAB command prompt, type
ThreePhaseExamples 1lib. Double-click any block in the library to open its dialog box,
and then click the Source code link in the block dialog box to open the Simscape source
file for this block in the MATLAB Editor.

To customize the block for your application, edit the source file and save it under another
name.

For example, you can create a folder called +MyMachines and save the source files for
your customized machines in this folder. Create this folder in your working directory, or in
another directory that is on the MATLAB path. Running the ssc_build command on this
package generates the MyMachines 1lib library model. This library contains all your
custom machine blocks and is located in the same directory where you have created the
+MyMachines folder. Open the MyMachines 1ib library by double-clicking it or by
typing its name at the MATLAB command prompt.

For more information on packaging and deploying Simscape component files, see
“Building Custom Block Libraries” (Simscape).

Things to keep in mind when writing component files:



See Also

If you create a custom component by modifying an existing one, do not forget to
change the name of the component and the name of the resulting block.

The component name must be the same as the name of the Simscape file. For example,
if you plan to save your component in a file called MyComponent. ssc, change the
declaration line in the file:

component MyComponent

The comment line immediately following the component declaration (that is, the first
line beginning with the % character) defines the name of the block, as it appears in the
custom library next to the block icon and at the top of the block dialog box. If you do
not specify this comment, then the component name serves as the block name. The
block name must be unique within the subpackage (sublibrary) where it resides.

Additional comments, below the line specifying the block name, are interpreted as the
block description. You do not have to modify them when copying an existing file, but if
you change the way the component works, it makes sense to reflect the change in the
block description. The block description is for informational purposes only.

When modifying component equations, if you introduce additional terms, make sure to
add the appropriate variables or parameters to the component declaration section. For
example, if you add zero-sequence dynamics to the component equations, declare an
additional parameter for stator zero-sequence inductance, L0, and an additional
variable for the initial stator zero-sequence magnetic flux linkage.

The “Custom Synchronous Machine” on page 5-4 tutorial shows how you can modify

the Synchronous Machine component file and customize it for use in your applications.
For more information on writing customized component files, see “Custom Components”
(Simscape).

See Also

More About

“Custom Synchronous Machine” on page 5-4
“Custom Components” (Simscape)
“Foundation Domains” (Simscape)
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Custom Synchronous Machine

The ThreePhaseExamples library, included in the product examples, contains simplified
example models that you can use to write your own machine and transformer component
files. The Synchronous Machine component in the ThreePhaseExamples library is similar
to the Synchronous Machine Round Rotor block, but its equations have been simplified to
omit zero-sequence dynamics. The Synchronous Machine block is therefore suitable for
balanced operation only.

This example shows how you can further simplify the component file and make a custom
machine block that does not account for the stator rate of change of flux.

1 In your working directory, create a folder called +MyMachines. This folder will
contain the source files for your customized machines.

2 To open the library of simplified component examples, at the MATLAB command
prompt, type:

ThreePhaseExamples lib



Custom Synchronous Machine
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100%

3 Double-click the Synchronous Machine block.

In the block dialog box, click the Source code link.

The Simscape source file for this block opens in the MATLAB Editor.

5 Change the name of the component, the name of the block, and the block description

by replacing these lines of the file:

component sm

Synchronous Machine :1.5

Synchronous machine (SM) with a round rotor parameterized

using fundamental per-unit parameters. The defining equations are
simplified by omitting the zero-sequence dynamics: the model is suitable
for balanced operation.

The model contains effect of rate of change of magnetic flux linkages

on stator voltages, effect of speed variation on stator voltages, one
damper winding on the d-axis and two damper windings on the g-axis.

0® o° o d° o° o o° o°
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% Copyright 2012-2018 The MathWorks, Inc.
with:

component sml
% Simplified Synchronous Machine
% This synchronous machine does not include the stator d.psi/dt terms.

To remove the stator rate of change of flux terms, scroll down to the equations
section and modify the stator voltage equations from:

% Per unit stator voltage equations

pu_ed == oneOverOmega*pu psid.der - pu_psig*pu_velocity - Ra*pu_id;
pu_eq == oneOverOmega*pu psiq.der + pu_psid*pu_velocity - Ra*pu iq;
to:

% Per unit stator voltage equations
pu ed == -pu_psig*pu_velocity - Ra*pu id;
pu_eq == pu_psid*pu_velocity - Ra*pu iq;

Save the file in the +MyMachines folder as sml.ssc. The name of the Simscape file
must match the component name.

To generate the custom library containing the new block, at the MATLAB command
prompt, type:

ssc_build(MyMachines)

This command generates the MyMachines 1ib library model in your working
directory.

To open the custom library, at the MATLAB command prompt, type:
MyMachines lib

The library contains the Simplified Synchronous Machine block, which you can now
use in your models.



See Also
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See Also
ssc_build
More About
. “Build Custom Blocks Using the Three-Phase Electrical Domain” on page 5-2
. “Custom Components” (Simscape)
. “Customizing the Block Name and Appearance” (Simscape)
. “Component Equations” (Simscape)
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Tune an Electric Drive

In this section...

“Cascade Control Structure” on page 6-2

“Equations for PI Tuning Using the Pole Placement Method” on page 6-2
“Equations for DC Motor Controller Tuning” on page 6-5

“Tune the Electric Drive in the Example Model” on page 6-7

This example shows how to tune an electric drive using a cascade control structure.

Cascade Control Structure

The figure shows a feedback control loop that uses a cascade control structure. The outer
speed-control loop is slower acting than the inner current-control loop.

Mg lgre P n
f Speed f Current U, DC Motor i
Control Control

r 3 z

Ia

Equations for Pl Tuning Using the Pole Placement Method

To satisfy the required control performance for a simple discrete plant model, G¢(z1), use
a closed loop PI control system Gpi(z!). The transient performance can be expressed in
terms of the overshoot. The overshoot decreases relative to the damping factor:

_HE

o =e1-¢g?

where,
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o is overshoot.
€ is the damping factor.

The response time, t,, depends on the damping and the natural frequency, w,, such that:

If€<0.7,

4
wné
If€=0.7,

tr =

6
tr;w_i'

The general workflow for designing a PI controller for a first-order system is:

1

Discretize the plant model using the zero-order hold (ZOH) discretization method.
That is, given that the first-order equation representing the plant is

K
CO) =T s+T
where,

* K, is the first-order gain.
* T, is time constant of the first-order system.

Setting
1-271

S=——
Zz 'Tg

yields the discrete plant model,

Kl )21 1

G(z-1) = m\ T ) it
&)= Ts—Tm) -1 1+az ¥

1+(T)z 1

whereT; is sample time for the discrete-time controller.

Write a discrete-time representation for the PI controller using the same transform.
For
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Gpi(s) = Kp + KI( L )

s
setting
1-271
S=—7—"
T

yields the discrete controller model,

Kp+ (KTs—Kp)z™! _ qo+ @1z}
1-2z71 1-271 7

Gpi(z™1) =

Combining the discrete equations for the plant and the controller yields the closed
loop transfer function for the system,

qob1z™ + q1b1z72
1+ (a1 =1+ qob))z~ 1+ (=a; + q1b1)z™ %

Goz™!) =

The denominator of the transfer function is the characteristic polynomial. That is,

Poo(z 1) =1+ (a1 — 1+ qob1)z~ ! + (—ay + qib1)z2.

The characteristic polynomial for achieving the required performance is defined as

Pz H)=1+az7 1+ apz7?,

where,

= - Ze_gw”TScos(wnTS 1- 52).
ap = e 2bwnTs

To determine the controller parameters, set the characteristic polynomial for the
system equal to the characteristic polynomial for the required performance. If

PCO(Z_l) = Pcd(z_l),
then

a1=al—1+q0b1



Tune an Electric Drive

and
a= —a + qb;.

Solving for q, and q; yields

ap—a;+1
i T
and

a +aq
q = by

Therefore, the general equations for the proportional and integral control parameters
for the first-order system are

Kp = q
and
q +Kp
Kj=———F.
I Ts

Equations for DC Motor Controller Tuning

Assuming that, for the system in the example model, K;, = K}, the simplified mathematical
equations for voltage and torque of the DC motor are

di
Vg = Lad—g + Ryig + Kpw
and

dw .
Te = ]mw + Bmw + Tipad = Kplg,

where:

* v, is the armature voltage.

* i, is the armature current.
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* L, is the armature inductance.

* R, is the armature resistance.

* w is the rotor angular velocity

* T, is the motor torque.

* Ty is the load torque.

* Jnis the rotor moment of inertia.

* B,is the viscous friction coefficient.
* K, is a constant of proportionality.

To tune the current controller, assume that the model is linear, that is, that the back
electromotive force, as represented by K,w, is negligible. This assumption allows for an
approximation of the plant model using this first-order Laplace equation:

1
Rq

Lq :
(R_G)S +1

Gi(s) =

Given the system requirements, you can now solve for Kp and K;. The requirements for the
current controller in the example model are:

* Sample time, T;= 1 ms.
* Overshoot, 0 = 5%.
* Response time, t, = 0.11 s.

Therefore, the proportional and integral parameters for the current controller are:

« Kp=7.7099.
. K;=455.1491.

To tune the speed controller, approximate the plant model with a simple model. First
assume that the inner loop is much faster than the outer loop. Also assume that there is
no steady-state error. These assumptions allow for the use a first-order system by
considering a transfer function of 1 for the inner current loop.

To output rotational velocity in revolutions per minute, the transfer function is multiplied
by a factor of 30/n. To take as control input the armature current instead of the motor
torque, the transfer function is multiplied by the proportionality constant, K. The
resulting approximation for the outer-loop plant model is
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30Kp
By
Jm )
(ﬂ)s +1

Gn(s) =

The speed controller has the same sample time and overshoot requirements as the
current controller, but the response time is slower, such that:

* Sample time T;= 1 ms.
¢ QOvershoot 0 = 5%.

* Response time t. = 0.50 s.

Therefore, the proportional and integral parameters for the speed controller are:

Kp = 0.0045
K; = 0.0405

Tune the Electric Drive in the Example Model
1 Explore the components of the DC motor and the cascaded controller.
a Open the model. At the MATLAB command prompt, enter

model = 'ee dc motor control'
open_system(model)

wReq

I
wReq P w
G—»S G G S
>ia s o o ) R “
»

Gate driver ?
Vde

chopper + o
Torque -0.015 at 1.5 sec
Vdc
Control " S D = Source
° Motor Friction
' [&]
O y ) ~
. ! il
{fg=0 Tral—>]

Four-Quadrant Scope
1. Modify model parameters Chopper
2. Explore simulation results using sscexplore
3. Learn more about this example

DC Motor Control —

TLoad
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2

3
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b  The Control subsystem contains the model of the cascaded control system built
using blocks from the Simulink library.

wReq Slew rate E’_, ! et

Reset
2000 rpm/s

Pl rpm

oc G 1)

PWM Generation

vRef
= O wMax

W Reset

[=])
DC Current Controller

¢ The Four Quadrant Chopper block represents a four-quadrant DC-DC chopper
that contains two bridge arms, each of which has two IGBT (Ideal, Switching)
blocks. When the input voltage exceeds the threshold of 0.5 V, the IGBT (Ideal,
Switching) blocks behave like linear diodes with a forward-voltage of 0.8 V and
a resistance of 1e-4 ohm. When the threshold voltage is not exceeded, the IGBT
(Ideal, Switching) blocks act like linear resistors with an off-state conductance of
le-5 1/ohm.

Simulate the model.

sim(model)
View the results. Open the Scope block.
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Armature current [A]

Motor torque [M*m]

At 1.5 seconds, there is a load torque that results in a steady-state error.

4 Tune the DC motor controller. The ee_getDCMotorFirstOrderPIParams function

calculates the proportional gain, Kp, and the integral gain, K}, for the first-order
system in this example.

The function syntax is [Kp, Ki] = getParamPI(Km,Tm,Ts,sigma,tr).

The input arguments for the function are the system parameters and the
requirements for the controller:

* Km is the first-order gain.
* Tmis the time constant of the first-order system.

* T, is the sample time for the discrete-time controller.

6-9
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sigma is the desired maximum overshoot, g.
t, is the desired response time.

To examine the equations in the function, enter

edit ee getDCMotorFirstOrderPIParams

To calculate the controller parameters using the function, save these system
parameters to the workspace:

Ra=4.67; % [0hm]
La=170e-3; % [H]
Bm=47.3e-6; % [N*m/(rad/s)]
Im=42.6e-6; % [Kg*m~2]
Kb=14.7e-3; % [V/(rad/s)]
Tsc=le-3; % [s]

Calculate the parameters for tuning the current controller as a function of the
parameters and requirements for the inner controller:

* Km=1/Ra.

* Tm= La/Ra.

e Ts=Tsc.

* sigma=0.05.
e Tr=0.11.

[Kp_i, Ki_i] = ee_getDCMotorFirstOrderPIParams(1/Ra,La/Ra,Tsc,0.05,0.11)
Kp i =

7.7099

Ki i =
455.1491

The gain parameters for the current controller are saved to the workspace.

Calculate the parameters for tuning the speed controller based on the
parameters and requirements for the outer controller:

« Km=Kb*(30/pi).
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* Tm = Jm/Ra.

* Ts=Tsc.

* sigma=0.05.
* Tr=0.5.

[Kp_n, Ki n] = ee getDCMotorFirstOrderPIParams((Kb*(30/pi))/Bm,Jm/Bm,Tsc,0.05,0.5)

Kp n =

0.0045

Kin =
0.0405

The gain parameters for the speed controller are saved to the workspace.
Simulate the model using the saved gain parameters for the speed and controllers.

sim(model)
View the results. Open the Scope block.

6-11
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Armature current [A]

Motor torque [M*m]

There is slightly more overshoot, however, the controller responds much faster to the load
torque change.

See Also

Inertia | Rotational Electromechanical Converter | Rotational Friction

Related Examples
. “DC Motor Control”
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7 simulation and Analysis of Power Engineering Systems

Optimize Block Settings for Simulating with the
Partitioning Solver

7-2

In this section...

“Update Solver and Zero-Sequence Settings Using the ee solverUpdate Function” on
page 7-3

“Limitations of the ee updateSolver Function” on page 7-12

The Partitioning solver is a Simscape fixed-step local solver that improves performance
for certain models. However, not all networks can simulate with the Partitioning solver.
Some models that use the Partitioning solver can produce errors and fail to initialize due
to numerical difficulties. To resolve numerical difficulties preventing initialization with
asynchronous, synchronous, and permanent magnet rotor machine blocks, you can
exclude zero-sequence terms. Excluding parasitic conductance resolves numerical
difficulties with the Floating Neutral (Three-Phase) and Neutral Connection block, which
include such conductance by default.

To determine the best solver choice for your model, use the ee_updateSolver helper
function, which is useful for iterating with various solvers. The function updates certain
parameter values for every instance of these blocks in your model:

* Solver Configuration blocks

* Machine blocks that have a Zero sequence parameter

* Connection blocks that have a Parasitic conductance to ground parameter

The function syntax is ee_updateSolver(solver,system). Specify both input

arguments using character vectors. The table shows how the function updates the values,
depending on the solver that you specify.
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Input Solver Solver Asynchronous, Floating
Argument Configuration |Configuration |Synchronous, |Neutral (Three-
Block (Solver |Block (Use and Permanent|Phase) Block
type) local solver Magnet Rotor |and Neutral
and Use fixed- |Machine Blocks|Connection
cost runtime |(Zero Block
consistency sequence) (Parasitic
iterations) conductance to
ground)
'Partitioning’ Partitioning Selected Exclude 0
'Backward Backward Euler |Selected Include le-12
Euler' or
'‘BackwardEuler'
‘Trapezoidal' Trapezoidal Selected Include le-12
'Global' or No change Cleared Include le-12
'Nonlocal'

Update Solver and Zero-Sequence Settings Using the
ee_solverUpdate Function

This example shows how to use the ee_solverUpdate function to configure the Solver
Configuration and PMSM blocks in a model for simulation with the Partitioning solver and
the Backward Euler solver. It also shows how to compare the simulation duration times

and the results.

1 Open the model. At the MATLAB command prompt, enter this code.

See Code

model = 'ee pmsm drive';
open_system(model)
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1. Explore simulation resulis using sscexplore
2. Learn more about this example

Two blocks that the ee solverUpdate function can update are the Solver
Configuration block and PMSM block.

2  Save the parameter settings for the two blocks.

See Code

% Define the Solver Configuration block and the path
% to it as variables

solvConfig = 'Solver Configuration';

solvConfigPath = [model,'/"',solvConfig];

% Define the machine block and the path

% to it as variables

machine = 'Permanent Magnet Synchronous Motor';
machinePath = [model, '/',machine];

% Create a cell array that contains configuration data
configBaseline = {'Block', 'Parameter', 'Value';
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'Solver Configuration', 'Use local solver',...

get param(solvConfigPath, 'UselLocalSolver');
'Solver Configuration', 'Solver type',...

get param(solvConfigPath, 'LocalSolverChoice");
'Solver Configuration', 'Sample time',...

get param(solvConfigPath, 'LocalSolverSampleTime");

'Solver Configuration',...

'Use fixed-cost runtime consistency iterations',...
get param(solvConfigPath, 'DoFixedCost');

'Machine', 'Zero sequence',...

get param(machinePath, 'zero sequence')};

The settings are saved to configBaseline array in the MATLAB workspace.

| configBaseline

63 cell

1 2 3
1 Block Parameter ‘alue
2 Solver Configuration Use local solver off

3 Solver Configuration
4 Solver Configuration
5 Solver Configuration
6 Machine

Solver type

Sample time

Use fixed-cost runtime consistency iterations
Fero sequence

ME_BACKWARD_EULER_ADVANCER
Ts

off
pe.enum.park.zeraseguence.include

The settings of interest for the Solver Configuration block are:

* Use local solver — The option to use a local Simscape solver is cleared.

* Solver type — Backward Euler, a Simscape local fixed- cost solver, is specified.
However, if you open the block dialog box, you can see that it is not enabled

because the option to use a local solver is cleared.

* Use fixed-cost runtime consistency iterations — The option to use fixed-cost is
cleared. This option is also disabled when the option to use a local solver is
cleared.

For the machine, the Zero sequence parameter is set to Include. Zero-sequence
equations can cause numerical difficulty when you simulate with the Partitioning

solver.
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To return all simulation outputs within a single Simulink.SimulationQutput
object so that you can later compare simulation times, enable the single-output
format of the sim command.

% Enable single-output format
set param(model, 'ReturnWorkspaceQutputs', 'on')

Mark the rotor torque signal, which connects the trqMotor From block to a Mux
block, for Simulink data logging and viewing with the Simulink Data Inspector.

See Code

% Define the trgMotor From block and the path

% to it as variables

torqueSensor = 'From6';

signalSubsytem = 'Signals’;

torqueSensorPath = [model,'/',signalSubsytem,'/',torqueSensor];

% Mark the output signal from the trgMotor From block

%  for Simulink(R) data logging

phTorqueSensor = get param(torqueSensorPath, 'PortHandles');
set param(phTorqueSensor.Outport(1l), 'DatalLogging','on")

The logging badge marks the signal in the model.
Determine the results and how long it takes to simulate with the baseline settings.

See Code

% Run a timed simulation using the Baseline solver configuration

out = sim(model);

tBaseline = out.SimulationMetadata.TimingInfo.ExecutionElapsedWallTime;

Use ee_updateSolver function to change to the Backward Euler solver
configuration. Save the configuration settings, and compare the settings to the
baseline settings.

See Code

% Configure for Backward Euler solver simulation
ee_updateSolver('Backward Euler',6model)

% Save the new parameter settings and compare them to the baseline
% configuration.

% Create a cell array that contains configuration data
configBackEuler = {'Block', 'Parameter', 'Value';
'Solver Configuration', 'Use local solver',...
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get _param(solvConfigPath, 'UseLocalSolver');
'Solver Configuration','Solver type',...

get _param(solvConfigPath, 'LocalSolverChoice');
'Solver Configuration','Sample time',...

get param(solvConfigPath, 'LocalSolverSampleTime');

'Solver Configuration',...

'Use fixed-cost runtime consistency iterations',...

get _param(solvConfigPath, 'DoFixedCost');
'Machine', 'Zero sequence',...
get _param(machinePath, 'zero sequence')};

o

configDiff = setdiff(configBackEuler,configBaseline)

configDiff =

1x1 cell array

% Compare the Partitioning solver block settings to the Baseline settings

{'on'}
| configBackEuler |
63 cel N
1 2 =
1 Elnck Parameter Walue
2 Salver Configuration Use local solver an

3 Solver Configuration
4 Solver Configuration
5 Solver Configuration
6 Machine

Solver type

Sample time

Use fixed-cost runtime consistency iterations
Zero sequence

NE_BACKWARD_EULER_ADVANCER
Ts

on
pe.enum.park.zerosequence.include

The option to use the local solver, which is set to Backward Euler by default, and the
option to use fixed-cost runtime consistency iterations are now both selected.

7 Run a timed simulation using the Backward Euler solver.

See Code

out = sim(model);
= out.SimulationMetadata.TimingInfo.ExecutionElapsedWallTime;

tBackEuler

8 Ifyou change the local solver to the Partitioning solver and simulate the model now,
an error occurs because of the zero-sequence terms. Use the ee_updateSolver
function to configure the model for simulating with the Partitioning solver without
generating an error. Save the configuration settings, compare the settings to baseline
settings, and run a timed simulation.

7-7
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See Code

% Configure for Partioning solver simulation
ee updateSolver('Partitioning', model)

% Create a cell array that contains configuration data
configPartitioning = {'Block', 'Parameter"', 'Value';
'Solver Configuration','Use local solver',...
get param(solvConfigPath, 'UseLocalSolver');
'Solver Configuration','Solver type',...
get param(solvConfigPath, 'LocalSolverChoice');
'Solver Configuration','Sample time',...
get param(solvConfigPath, 'LocalSolverSampleTime');
'Solver Configuration',...
'Use fixed-cost runtime consistency iterations',...
get param(solvConfigPath, 'DoFixedCost');
'Machine', 'Zero sequence',...
get param(machinePath, 'zero sequence')};

% Compare the Partitioning solver block settings to the Baseline settings
configDiff = setdiff(configPartitioning, configBaseline)

% Run a timed simulation using the Partitioning solver
out = sim(model);
tPartitioning = out.SimulationMetadata.TimingInfo.ExecutionElapsedWallTime;

configDiff =
3x1 cell array

{'NE_PARTITIONING ADVANCER'
{'ee.enum.park.zerosequence.exclude'}
{'on’ }

Warning: Initial conditions for nondifferential variables

not supported. The following states may deviate from

requested initial conditions:
['<a
href="matlab:open_and hilite system('ee pmsm drive/Battery')"...

>ee pmsm drive/Battery</a>']
Battery.num cycles
o In ee.sources.battery base

['<a
href="matlab:open_and hilite system('ee_pmsm drive/Permanent
Magnet Synchronous Motor')">ee pmsm drive/Permanent
Magnet Synchronous Motor</a>']
Permanent_Magnet Synchronous Motor.angular position
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| configPartitioning [

63 cell
1 2 3
1 Block Parameter Yalue
2 |Solver Configuration Use local solver on
3 Solver Configuration Solver type NE_PARTITIOMING_ADVANCER
4 Solver Configuration Sample time Ts
5 Solver Configuration Use fixed-cost runtime consistency iterations  on
G Machine Fero sequence pe.enum.parkzerosequence. exclude

The solver type is now set to the Partitioning solver and the machine is configured to

exclude zero-sequence terms.

The simulation runs without generating an error. It does generate a warning because
initial conditions for nondifferential variables are not supported for the Partitioning

solver.
9 Print tables that show:

* Simulation time for each solver

* Percent differences in speed for the local solvers versus the baseline global solver.

See Code

% Display the simulation times
compTimeDiffTable = table({'Baseline’;...
'Backward Euler';...
'Partitioning'}, ...
{tBaseline;tBackEuler;tPartitioning}, ...
'VariableNames', {'Solver','Sim Duration'});

display(compTimeDiffTable);

% Compute and display the percent difference for the simulation times

spdBackEulerVsBaseline
spdPartitionVsBaseline

100*(tBaseline - tBackEuler)/tBaseline;
100*(tBaseline - tPartitioning)/tBaseline;

compPctDiffTable = table({'Backward Euler versus Baseline';...

'Partitioning versus Baseline'}, ...
{spdBackEulerVsBaseline;. ..
spdPartitionVsBaseline}, ...
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'VariableNames', {'Comparison', 'Percent Difference'});

display(compPctDiffTable);

3x2 table
Solver Sim Duration
'Baseline’ [38.0255]
'Backward Euler' [23.4011]
"Partitioning’ [ 9.2042]
compPctDiffTable =
2x2 table
Comparison Percent Difference

'Backward Euler versus Baseline' [38.4594]
'"Partitioning versus Baseline' [75.7946]

Simulation time on your machine may differ because simulation speed depends on
machine processing power and the computational cost of concurrent processes. The
local fixed-step Partitioning and Backward Euler solvers are faster than the baseline
solver, which is a global, variable-step solver. The Partitioning solver is faster than
the Backward Euler solver.

To compare the results, open the Simulink Data Inspector.

See Code

Get Simulink Data Inspector run IDs for
the last three runs

runIDs = Simulink.sdi.getAllRunIDs;

runBackEuler runIDs(end - 1);

runPartition runIDs(end);

o° o°

% Open the Simulink Data Inspector
Simulink.sdi.view

compBaselinePartition = Simulink.sdi.compareRuns(runBackEuler,...
runPartition);

To see the comparison, click Compare and then click From6.
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Baseline:

Compare to:

0.15

0.05

-0.05

Run 14: pe_pmsm_drive ¥ | Global Abs Tolerance: 0| Global Time Tolerance: 0
= Compare
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The first plot shows the overlay of the Backward Euler and Partitioning solver
simulation results. The second plot shows how they differ. The default tolerance for
differences is 0. To determine if the accuracy of the results meets your requirements,
you can adjust the relative, absolute, and time tolerances. For more information, see
“Compare Simulation Data” (Simulink).
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You can also use the ee_updateSolver function to reset the model for simulation with a
global solver.

See Code

% Configure for Global/Nonlocal solver simulation
ee _updateSolver('Global',model)

Limitations of the ee_updateSolver Function

Using the ee_updateSolver function does not guarantee that a simulation does not
generate an error or that a simulation produces accurate results. To ensure that
simulation accuracy meets your requirements, it is a recommended practice to compare
simulation results to baseline results whenever you change model or block settings.

See Also
PMSM | Solver Configuration

Related Examples

. “Increase Simulation Speed Using the Partitioning Solver” (Simscape)
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Phasor-Mode Simulation Using Simscape Components

You can run your model in phasor mode to speed up simulation. In Simscape, phasor
mode is known as frequency-time equation formulation. In general, this formulation leads
to accurate simulation of AC models using larger time steps than the traditional time
formulation.

Use frequency-time equation forumulation to speed up your simulation when:

* Your simulation contains periodic AC signals with a common fundamental frequency
* You are interested in the slow-moving AC-related quantities, such as amplitude or
phase, and the DC output signals

Set up the model

To measure the time required to run a simulation, open the model ee sm_control and
create a model callback.

mdl = load system('ee sm control');
open_system(mdl) ;

set param(mdl, 'StartFcn', 'tic;");

set param(mdl, 'StopFcn', 'tsim=toc;"');

7-13
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1. Plot terminal voltage and rotor speed (see code) . Load Load

2. Modify model parameters Initial Load Step off Step on

3. Explore simulation results using sscexplore
4. Learn more about this example

I

Run a time-based simulation
Double-click the Solver Configuration block and apply the following configuration:

* Enable the local solver by checking the Use local solver check box
* Set the Sample time parameter to le-3
* Setthe Equation formulation parameter to Time

You can also run this code to configure the block.

blk = find system(mdl, 'MaskType', 'Solver Configuration');
set param(blk, 'UseLocalSolver','on');

set param(blk, 'LocalSolverSampleTime', 'le-3"');

set param(blk, 'EquationFormulation', '"NE TIME EF');

Simulate the model and save the run time and logging variable.
sim(get param(mdl, 'Name'));

tsim time = round(tsim,2);
simlog ee sm control time = simlog ee sm control;

7-14
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Run a phasor-mode simulation
Double-click the Solver Configuration block and apply the following configuration:

» Enable the local solver by checking the Use local solver check box
* Set the Sample time parameterto le-2
* Setthe Equation formulation parameter to Frequency and time

You can also run this code to configure the block.
blk = find system(mdl, 'name', 'Solver Configuration');
set param(blk, 'UseLocalSolver','on');

set param(blk, 'LocalSolverSampleTime', 'le-2"');
set param(blk, 'EquationFormulation', 'NE_FREQUENCY TIME EF');

Simulate the model and save the run time and logging variable.
sim(get param(mdl, 'Name'));

tsim phasor = round(tsim,2);

simlog ee sm control phasor = simlog ee sm control;
Compare DC results

Plot the field voltage and rotor speed for both the time and frequency-time simulations.
For each simulation mode, display markers at every 50 data points.

[hTime,hPhasor]=setup figure(simlog ee sm control time,simlog ee sm control phasor, 'dc
legend([hTime, hPhasor],{['Time (t=',num2str(tsim time),'s)'],['Phasor (t=',num2str(tsir

7-15
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Terminal voltage (per-unit)

Rotor velocity (per-unit)

fe]
%)
1

O Time (t=5.68s)
#  Phasor(t=1.64s)

Time (s)

The phasor simulation reproduces near-identical results as the time-based simulation,
despite using a time step that is 10 times larger. The measured simulation time is also
shown for each of the simulation modes in the plot legend. This performance indicator is
different on different machines, but the frequency-time simulation should be about two
times faster than the time simulation. Note that the actual time required per step is
higher in the frequency-time case, but the overal time is reduced.

Compare AC results

Plot the a-phase voltage of the synchronous machine over the time period 1s to 1. 1s.
Because of the larger time steps in the frequency-time formulation, the resolution of the
AC quantity is too small to make out the sine wave. The points that are available are
undersampled, but still accurate.
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a-phase voltage (V)

[hTime, hPhasor]=setup figure(simlog ee sm control time,simlog ee sm control phasor, 'ac
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In general, use frequency-time formulation to speed up simulations where the outputs of
interest are DC or slow-moving AC quantities. You can use periodic sensors to measure
slow-moving properties of AC signals such as amplitude and phase in both time and
frequency time formulations. For more information, see the PS Harmonic Estimator
(Amplitude, Phase) block.
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Sometimes there are small phase offsets between time- and frequency-time-generated AC
signals. This difference is caused by the accumulated integration error of a slightly
different signal frequency over time.

See Also

Solver Configuration

More About

. “Frequency and Time Simulation Mode” (Simscape)

7-18



Examine the Simulation Data Logging Configuration of a Model

Examine the Simulation Data Logging Configuration of a

Model

Many analyses that you can perform using Simscape Electrical require a simulation log
variable in your MATLAB workspace. The model in this example is configured to log
Simscape data for the whole model for the entire simulation time. To examine the data
logging configuration of a model:

1

Open the model. At the MATLAB command prompt, enter

model = 'ee rectifier power dissipated';
open(model)

Open the model configuration parameters and then, in the left pane, select
Simscape. Relevant parameters are:

* Log simulation data — Data logging is enabled for the whole model because this
parameter is set to A1l so you can calculate the power dissipated by any of the
semiconductors in the model.

* Workspace variable name — This parameter, which is also referred to as the
name of the simulation log variable, is specified as
simlog ee rectifier power dissipated.

* Limit data points — You can calculate the power dissipated for the entire
simulation time because the option is not selected.

Alternatively, you can determine the Simscape data logging configuration without opening
the model configuration parameters, by using the get param function. For example, for
the ee rectifier power dissipated model, to determine:

If all, some, or no data is logged, at the MATLAB command prompt, enter
get param(model, 'SimscapelLogType')
ans =

‘all'
The name of the Simscape logging variable

get param(model, 'SimscapeLogName"')
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ans =

'simlog ee rectifier power dissipated’
» If the option to limit data-points is on or off

get param(model, 'SimscapelLogLimitData')

ans =

"off!

See Also

Functions
get param

Related Examples
. “Data Logging” (Simscape)
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Perform a Power-Loss Analysis

In this section...

“Prerequisite” on page 7-21
“Calculate Average Power Losses for the Simulation” on page 7-21

“Analyze Power Dissipation Differences Using Instantaneous Power Dissipation” on page
7-23

“Mitigate Transient Effects in Simulation Data” on page 7-27

This example shows how to analyze power loss and how to mitigate transient power
dissipation behavior. Analyzing power loss, with and without transients, is useful for
determining if components are operating within safety and efficiency guidelines.

Prerequisite

This example requires a simulation log variable in your MATLAB workspace. The model in
this example is configured to log Simscape data for the whole model for the entire
simulation time.

To learn how to determine if a model is configured to log simulation data, see “Examine
the Simulation Data Logging Configuration of a Model” on page 7-19.

Calculate Average Power Losses for the Simulation

1 Open the model. At the MATLAB command prompt, enter

model = 'ee rectifier power dissipated';
open(model)
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. Calculate power dissipated by all of the diodes in the model for the entire simulation time (see command window for output).

Voltages, and
Power Dissipation

. Explore

. Calculate power dissipated by diode D6 for the entire simulation time (see command window for output).

simulation results using sscexplore.

. Calculate the maximum power dissipated by diode D6. (see command window for output).
. Calculate power dissipated by diode D6 between simulation time, = 1e-3 to 0.5 s (see command window for output).

. Plot power dissipated by the diodes (see code).
. Calculate power dissipated by all of the diodes between simulation time, { = 0.4 to 0.5 s (see command window for output).

O~ Wwh =

2

. Learn more about the ee_getPowerLossSummary function.

Simulate the model.
sim(model)
The simulation log variable, which is named

simlog ee rectifier power dissipated, appears in the workspace.

Calculate the average losses for the entire simulation for each of the diodes in the
model.

rectifierLosses = ee getPowerLossSummary(simlog ee rectifier power dissipated.Rectifier)

rectifierLosses =
6x2 table

LoggingNode Power
'ee rectifier power dissipated.Rectifier.D6' 52.222
'ee rectifier power dissipated.Rectifier.D3' 52.222
'ee rectifier power dissipated.Rectifier.D4' 52.194
'ee rectifier power dissipated.Rectifier.D5' 52.194
'ee rectifier power dissipated.Rectifier.D1l' 52.194
'ee rectifier power dissipated.Rectifier.D2' 52.194
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On average, diodes D3 and D6 dissipate more power than the other diodes in the
rectifier.

Analyze Power Dissipation Differences Using Instantaneous
Power Dissipation

The Diode blocks each have a power dissipated variable, which measures instantaneous
power dissipation. To investigate the differences in the average power dissipated by the
diodes, view the simulation data using the Simscape Results Explorer.

1 Open the simulation data using the Results Explorer.

sscexplore(simlog ee rectifier power dissipated)
2 View the instantaneous power dissipated by the diodes.

a Expand the Rectifier node
Expand the D1 through D6 nodes

Click the power dissipated nodes for diode D1, and then Ctrl+click the
power dissipated nodes for the other five diodes.

In the Results Explorer window, click the plot options button and set Plot
signals to Separate.
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At the beginning of the simulation, there is a difference in the power dissipation for

each diode.

3 Take a closer look at the differences. Overlay the plots and zoom to the beginning of

the simulation.

b

In the Results Explorer window, click the plot options button.
Enable the Limit time axis option.




Perform a Power-Loss Analysis

¢ For Stop time, specify 0.02.
d Set Plot signals to Overlay.
e C(lick OK.
|4\ Simscape Results Explorer: pe_rectifier_power_dissipated - O
File Edit View Insert Toocls Desktop Window Help
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EB ; 20| |
G- n
[]...L" p
EB power_dissipated
R v
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i
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E]"'L." p | II._._, .\\ I.,_.___ " ||~U.— .
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| | |
Statistics for root node: Il | ||| | | | ‘ ‘ |
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Number of logged variables: 93 0 0002 0004 0006 0008 001 0012 0014 0016 0018 0.02
Numnber of logged zero crossing signals: 0 Time (s)

The variation in power dissipation is due to transient behavior at the beginning of the
simulation. The model reaches steady state at simulation time, t = 0.001 seconds.

contains transient behavior.

Determine the average power dissipation for only the diodes during the interval that
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rectifierLosses = ee getPowerLossSummary(simlog ee rectifier power dissipated.Rectifier,0,1le-3)

rectifierLosses =
6x2 table
LoggingNode Power
'Rectifier.D3' 174.88
'Rectifier.D6' 174.88
'Rectifier.D4' 0.27539
'Rectifier.D5' 0.27539
'Rectifier.D1' 0.12482
'Rectifier.D2' 0.032017

The average power dissipated by diodes D3 and D6 exceeds the average for the other

diodes.

Output a table of the maximum power dissipation for each diode, for the entire
simulation time.

pd D1 max
pd_D2_max
pd_D3_max
pd_D4 max
pd_D5_max
pd_D6_max

diodes = {'D
PowerMax = [

max(simlog ee rectifier power dissipated.
max(simlog ee rectifier power dissipated.
max(simlog ee rectifier power dissipated.
max(simlog ee rectifier power dissipated.
max(simlog ee rectifier power dissipated.
max(simlog ee rectifier power dissipated.

1';'D2';'D3"';'D4";'D5";'D6"'};

Rectifier.
Rectifier.
Rectifier.
Rectifier.
Rectifier.
Rectifier.

.power_dissipated.
.power_dissipated.
.power_dissipated.
.power_dissipated.
.power_dissipated.
.power_dissipated.

pd D1 max;pd D2 max;pd D3 max;pd D4 max;pd D5 max;pd D6 max];

T = table(PowerMax, 'RowNames', diodes)

T =
6x1 table
PowerMax
D1 166.45
D2 166.45
D3 339.54
D4 166.45
D5 166.45
D6 339.54

series.
series.
series.
series.
series.
series.

values);
values);
values);
values);
values);
values);



Perform a Power-Loss Analysis

The maximum instantaneous power dissipation for diodes D3 and D6 is almost double
the maximum instantaneous power dissipation for the other diodes.

Mitigate Transient Effects in Simulation Data

To mitigate the transient power dissipation at the beginning of the simulation, use the
final simulation state to initialize a new simulation at steady-state conditions.

1 Configure the model to save the final state.

Open the model configuration parameters.
In the Solver pane, change the Stop time from 0.5 to le-3.
¢ Inthe Data Import/Export pane, select these options:

* Final States
* Save final operating point
d Click Apply.
2 Run the simulation.

The final state is saved as the variable xFinal in the MATLAB workspace.

3 Configure the model to initialize using xFinal, in the model configuration parameters.

a In the Data Import/Export pane:

* Select the Initial state option.
* Change the Initial state parameter value from xInitial to xFinal.
e C(Clear the Final states option.
b In the Solver pane, change the Stop time to 0.5.
¢ Click OK.
4  Run the simulation.
View the data from the new simulation.

Click the Reload logged data S button in the Simscape Results Explorer.

b  Click OK to confirm that simlog ee rectifier power dissipated isthe
variable name that contains the logged data.
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¢ To see the data more clearly, click and drag the legend away from the peak
amplitudes.
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The plot shows that the simulation no longer contains the transient.
6 Output a table of the maximum power dissipation for each diode, for the modified

simulation.

pd_D1 _max = max(simlog_ee rectifier power_dissipated.Rectifier.Dl.power dissipated.series.values);
pd_D2_max = max(simlog_ee rectifier power_dissipated.Rectifier.D2.power dissipated.series.values);
pd_D3_max = max(simlog_ee rectifier power_dissipated.Rectifier.D3.power dissipated.series.values);




See Also

pd D4 max = max(simlog ee rectifier power dissipated.Rectifier.D4.power dissipated.series.values);
pd D5 max = max(simlog ee rectifier power dissipated.Rectifier.D5.power dissipated.series.values);
pd D6 max = max(simlog ee rectifier power dissipated.Rectifier.D6.power dissipated.series.values);
diodes = {'D1';'D2';'D3"';'D4"';'D5"';'D6'};

PowerMax = [pd D1 max;pd D2 max;pd D3 max;pd D4 max;pd D5 max;pd D6 max];

T = table(PowerMax, 'RowNames', diodes)

T:
6x1 table
PowerMax
D1 166.45
D2 166.45
D3 166.45
D4 166.45
D5 166.45
D6 166.45

The maximum instantaneous power dissipation for diodes D3 and D6 is the same as
the maximum instantaneous power dissipation for the other diodes.

See Also

Functions
ee getEfficiency | ee getPowerLossSummary | ee _getPowerLossTimeSeries

Related Examples

“Power-Loss Analysis of a Three-Phase Rectifier”

“Examine the Simulation Data Logging Configuration of a Model” on page 7-19
“Data Logging” (Simscape)

“About the Simscape Results Explorer” (Simscape)
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Choose a Simscape Electrical Function for an Offline
Harmonic Analysis

7-30

In this section...

“Harmonic Distortion” on page 7-30

“Harmonic Analysis Functions” on page 7-30

“Evaluate Relative Overall Harmonic Distortion” on page 7-31
“Compare Harmonic Distortion to Standard Limits” on page 7-32
“Minimize Harmonic Distortion with Passive Filters” on page 7-32
“Verify the Results of an Online Harmonic Analysis” on page 7-33

Harmonic Distortion

Nonlinear loads create power distortion in the form of harmonics, that is, voltages and
currents that are multiples of the fundamental frequency. Harmonic waveforms can result
in energy losses though heat dissipation and in reduced power quality. They can also
cause equipment to malfunction or to become damaged. Standards development
organizations such as the Institute of Electrical and Electronics Engineers (IEEE) and the
International Electrotechnical Commission (IEC) define the recommended limits for
harmonic content in electric power systems.

Harmonic Analysis Functions

You can use the simulation and analysis functions in Simscape Electrical to perform an
offline, that is post-simulation, analysis to examine harmonic distortion in your model. The
ee plotHarmonics function generates a bar chart. The ee_getHarmonics and

ee calculateThdPercent functions provide harmonic data in numerical form.

To decide which functions and workflows to use for your harmonic analysis, consider your
goals. The table cross-references the harmonic functions with common harmonic analysis
according to the data the function outputs and the task requires.



Choose a Simscape Electrical Function for an Offline Harmonic Analysis

Goal

ee_plotHarmonics

ee_getHarmonics

ee_calculateThdPercen
t

Evaluate the
relative overall
harmonic
distortion

Bar chart of the
percentage of
fundamental
magnitude

¢ Fundamental
peak value

¢ Total harmonic
distortion (THD)
percentage

Compare the
harmonic
distortion to
standard limits

¢ Fundamental
frequency

* Harmonic orders

* Harmonic
magnitudes

Total harmonic distortion
(THD) percentage

Determine the
parameters for
filtering
harmonic
distortion

* Fundamental
frequency

e Harmonic orders

e Harmonic
magnitudes

Evaluate Relative Overall Harmonic Distortion

Use this workflow for a high-level understanding of the waveform distortion in your power

system.

Enable Simscape data logging.
Save the logged voltage or current data to a variable.

Use the ee plotHarmonics function to generate a bar chart of harmonic
percentages with the peak fundamental magnitude and the total harmonic distortion
(THD) percentage displayed in the plot title.
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Compare Harmonic Distortion to Standard Limits

Use this workflow to obtain values for evaluating the IEEE or IEC suitability of your
power system.

1
2

N o »u b

Enable Simscape data logging.
Save the logged voltage or current data to a variable.

Use the ee_getHarmonics function to obtain the harmonic orders, the magnitude
for each order, and the fundamental frequency.

Save the fundamental peak to a new variable.
Calculate the RMS voltage or current for each order.
Calculate the harmonic distortion percentage for individual harmonics.

Use the ee calculateThdPercent function to obtain the total harmonic distortion
(THD).

Compare the percentage data for each order and the THD percentage to the standard
limits.

Minimize Harmonic Distortion with Passive Filters

Use this workflow to determine the parameters for filtering the distorted waveforms with
passive filters. Use individual, series-tuned filters for specific harmonic orders. Use a
single high-pass filter to filter higher orders.

Enable Simscape data logging.
Save the logged voltage or current data in a variable.

Use the ee_getHarmonics function to obtain the harmonic orders, the magnitude
for each order, and the fundamental frequency.

Identify the harmonic orders that you want to filter.

For each filter:

a  Specify the filter size, in terms of reactive power compensation, and specify the
filter quality.

b Calculate the capacitor reactance at the tuned harmonic order.
Calculate the filter capacitance.

d Calculate the inductor reactance at the tuned harmonic order.



See Also

e Calculate the filter inductance.
f  Calculate the filter resistance.

Verify the Results of an Online Harmonic Analysis

You can examine harmonic distortion in your model online, that is during simulation,
using the Simscape Spectrum Analyzer block. To verify the results from the Spectrum
Analyzer block:

1

To determine the THD in your model, perform an online analysis. For information, see
“Perform an Online Harmonic Analysis Using the Simscape Spectrum Analyzer Block”
on page 7-34.

2 Usethe ee getHarmonics and ee calculateThdPercent functions to determine
the THD in your model.

3 Compare the THD values for the online and offline analyses. If the results differ,
reconfigure the Spectrum Analyzer block.

See Also

Blocks

Spectrum Analyzer

Functions
ee calculateThdPercent | ee getHarmonics | ee plotHarmonics

Related Examples

“Harmonic Analysis of a Three-Phase Rectifier”

“Perform an Online Harmonic Analysis Using the Simscape Spectrum Analyzer
Block” on page 7-34

“Data Logging” (Simscape)
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Perform an Online Harmonic Analysis Using the
Simscape Spectrum Analyzer Block

7-34

In this section...

“Harmonic Distortion” on page 7-34

“Prerequisite” on page 7-34

“Perform an Offline Harmonic Analysis” on page 7-35
“Perform an Online Harmonic Analysis” on page 7-38

Harmonic Distortion

Nonlinear loads create power distortion in the form of harmonics, that is, voltages and
currents that are multiples of the fundamental frequency. Harmonic waveforms can result
in energy losses through heat dissipation and in reduced power quality. They can also
cause equipment to malfunction or to become damaged. Standards development
organizations such as the Institute of Electrical and Electronics Engineers (IEEE) and the
International Electrotechnical Commission (IEC) define the recommended limits for
harmonic content in electric power systems.

This example shows how to examine harmonic distortion in your model using offline, that
is after simulation, and online, that is during simulation, analyses. The offline analysis
uses the Simscape Electrical harmonic analysis functions and helps you to determine
configuration settings for, and verify the results of, the online analysis. The online analysis
uses the Simscape Spectrum Analyzer block.

Prerequisite

This example requires a simulation log variable in your MATLAB workspace. The model in
this example is configured to log Simscape data for the whole model for the entire
simulation time.

To learn how to determine if a model is configured to log simulation data, see “Examine
the Simulation Data Logging Configuration of a Model” on page 7-19.



Perform an Online Harmonic Analysis Using the Simscape Spectrum Analyzer Block

Perform an Offline Harmonic Analysis

1 Open the model. At the MATLAB command prompt, enter:

model = 'ee composite rectifier';
open_system(model)

> ]
n H ! *
fix)=0 T— ~ i - DC
o ] 5 MW
I
Voltage Source Rectifier
AC
5 MW
Composite Three-Phase Rectifier i

1. Explore simulation results using sscexplore
2. Learn more about this example

The example model contains a three-phase rectifier. The model also contains a
Selector block that outputs only the a-phase from three-phase current signal that it
receives from the PS-Simulink Converter block.

2 Simulate the model.

sim(model)

3 View the time-domain results. Open the Scope block.
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The time domain analysis shows that the rectifier is converting the voltage, but it
does not include any information about the frequencies in the signal.

4 Determine configuration settings and calculate the expected results for an online
harmonic analysis. Perform an offline harmonic analysis.

a The Simscape Electrical harmonic analysis functions require that you use a fixed-
step solver. Determine the solver type and sample time for the model. To turn on
sample-time highlighting, in the Simulink editor menu bar, select Debug >
Information Overlays > Sample Time > Colors.

Timing Legend 9 >
Highlight | Al - Ve
Click the rate/type to highlight all the blocks containing this rate/type.

v Discrete Period

[ ] D1 100.0000e-006

The model is running at a discrete rate, therefore it is using a fixed-step solver,
with a sample time of 1e-4 s.
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Use the ee_getHarmonics function to calculate the harmonic order, the
harmonic magnitude, and the fundamental frequency based on the voltage
source currents.

[harmonicOrder,harmonicMagnitude, fundamentalFrequency] = ...
ee_getHarmonics(simlog ee composite rectifier.Voltage Source.I);

Performing an online harmonic analysis using the Spectrum Analyzer block
requires that you specify a value for maximum harmonic order and the resolution
bandwidth (RBW). The RBW depends on the fundamental frequency.

Extract and display the maximum harmonic order and the fundamental
frequency:

disp(['Maximum Harmonic Order
disp(['Fundamental Frequency

', num2str(max(harmonicOrder))])
", num2str(fundamentalFrequency)])

30
60

Determine the peak value of the fundamental frequency. This value is useful for
filtering out negligible harmonics and for verifying the results of the offline
analyses.

Maximum Harmonic Order
Fundamental Frequency

fundamentalPeak = harmonicMagnitude(harmonicOrder==1);
disp(['Peak value of fundamental = ', num2str(fundamentalPeak),' A']l);

Peak value of fundamental = 1945.806 A

Filter out small harmonics by identifying and keeping harmonics that are greater
than one thousandth of the fundamental peak frequency.

threshold = fundamentalPeak ./ le3;

aboveThresold = harmonicMagnitude > threshold;
harmonicOrder = harmonicOrder(aboveThresold)"';
harmonicMagnitude = harmonicMagnitude(aboveThresold)"';

Display the harmonic data in a MATLAB table.

harmonicRms = harmonicMagnitude./sqrt(2);
harmonicPct = 100.*harmonicMagnitude./harmonicMagnitude(harmonicOrder == 1);
harmonicTable = table(harmonicOrder,...
harmonicMagnitude, ...
harmonicRms, . ..
harmonicPct, ...
'VariableNames',{'Order"', '"Magnitude', 'RMS"', 'Percentage'});
display(harmonicTable);

harmonicTable =
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10x4 table
Order Magnitude RMS Percentage
1 1945.8 1375.9 100
5 218.86 154.75 11.248
7 105.83 74.835 5.439
11 85.135 60.2 4.3753
13 57.599 40.729 2.9602
17 50.417 35.65 2.5911
19 37.612 26.596 1.933
23 33.859 23.942 1.7401
25 26.507 18.743 1.3622
29 23.979 16.955 1.2323

Calculate the total harmonic distortion (THD) percentage using the
ee calculate ThdPercent function.

thdPercent = ee calculateThdPercent(harmonicOrder, harmonicMagnitude);
disp(['Total Harmonic Distortion Percentage = ' num2str(thdPercent),' %'1);

Total Harmonic Distortion percentage = 14.1721 %

Perform an Online Harmonic Analysis

1

In the Simulink editor that contains the ee_composite rectifier model, replace
the Scope block with a Spectrum Analyzer block from the Simscape Utilities Library:

a
b

C

Delete the Scope block.
Left-click within the block diagram.

After the search icon appears, type spec, and then from the list, select the
Spectrum Analyzer from the Utilities library.

Connect the Spectrum Analyzer block to the output signal from the Subsystem i.



Perform an Online Harmonic Analysis Using the Simscape Spectrum Analyzer Block

IL

f(x)=0 'f”— - i S DC
L i . 5 MW

\oltage Source Rectifier

AC
5 MW

Composite Three-Phase Rectifier i

1. Explore simulation results using sscexplore =
2. Learn more about this example

2 Configure the Spectrum Analyzer block using the Spectrum Settings panel.

Open the Spectrum Analyzer.
Open the Spectrum Settings panel. On the Spectrum Analyzer toolbar, click the

Spectrum Settings s button.

¢ Configure the parameters on the Main Options pane.

i Configure the block to display the root mean square (RMS) of the frequency.
From the Type dropdown menu, select RMS.

ii  Determine the value to specify for the resolution bandwidth (RBW) using this
equation:

RBW = NENBW*f'
N
where,

» NENBW is the normalized effective noise bandwidth, a factor of the
windowing method used. The Hanning (Hann) window has an NENBW
value of approximately 1.5.
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* fis the fundamental frequency.
* N s the number of periods.
* RBW is the resolution bandwidth in Hz.

For a fundamental frequency of 60 Hz over 10 periods, using a Hann
window,

1.5*60H2

10 = 9Hz

RBW =

For RBW (Hz), specify 9.

d Expand the Windows Options pane and specify an Overlap (%) of 90.
e Specify the maximum number of peaks for the analyzer to display. In the menu

bar, select Tools > Measurements > Peak Finder. Alternatively, in the

Spectrum Analyzer toolbar, select the Peak Finder L.l button. In the Peakfinder
pane, in the Settings section, for Max Num of Peaks, enter 30. This value is
based on the maximum harmonic order as indicated by the offline analysis.

f  Set the number of harmonics to use for measuring harmonic distortion. Specify a

number that captures the largest harmonic order that the offline analysis
captures. In the menu bar, select Tools > Measurements > Distortion
Measurements. Alternatively, in the Scope toolbar, click the Distortion

Measurements 4 button. Scroll as required to see the Distortion
Measurements pane.

In the Distortion Measurements pane, for Num Harmonics, again enter 30.
Simulate the model.

sim(model)



Perform an Online Harmonic Analysis Using the Simscape Spectrum Analyzer Block

YY VY WY WY

* ¥ Spectrum Settings
¥ Main options
Type
Sample rate (Hz)
RBW (Hz)
Samples/update

» Window options

» Trace options

* ¥ Peak Finder

¥ Settings

Peak Threshold
Max Mum of Peaks
Min Peak Distance

Peak Excursion

Label Format

» Peaks

* ¥ Distortion Measurements

Distortion

¥ Harmonics

. Harmonics: [

M Label harmonics
Freq. (kHz) Power (Wrms)
0.059988 1375.89
Freq. (kHz) Power (dBc)
0113977 -1375.89 [« |
0.179964 -1375.86
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0.29994 -1221.15
0.353929 -1375.88
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0.593881 -1375.88 [~ |
THD -16.97 dBc (14.17%)
SNR. 33.89 dBc
SINAD 16.89 dBc
SFDR: 18.98 dBc
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The THD percentage is 14.17% and the fundamental peak power is 1375.89 Vrms at
0.06 kHz (60 Hz). These results agree with the results from the offline harmonic
analysis.

See Also

Blocks
PS-Simulink Converter | Selector | Spectrum Analyzer

Functions
ee calculateThdPercent | ee _getHarmonics | ee plotHarmonics

Related Examples

. “Harmonic Analysis of a Three-Phase Rectifier”
. “Choose a Simscape Electrical Function for an Offline Harmonic Analysis” on page
7-30

. “Data Logging” (Simscape)



Perform a Load-Flow Analysis Using Simscape Electrical

Perform a Load-Flow Analysis Using Simscape Electrical

In this section...

“Network Requirements for a Simscape Electrical Load-Flow Analysis” on page 7-43
“Essential Blocks for a Load-Flow Analysis” on page 7-44

“Performing a Load-Flow Analysis” on page 7-45

“Machine Parameterization and Variable Initialization” on page 7-48
“Troubleshooting Load-Flow Analysis and Initialization Issues” on page 7-48

Simscape Electrical can perform a power-flow, or load-flow, analysis for an AC electrical
power transmission system modeled using the Simscape three-phase electrical domain. A
load-flow analysis allows you to determine the voltage magnitudes, voltage phase angles,
active power, and reactive power of the electrical system in steady-state operation.

For a given steady-state operating point, the load-flow data reveals the:

* Voltage magnitude and voltage phase angle at each bus
* Active and reactive power generation for each generator that supplies the grid
* Active and reactive power that flows to each load that places demand on the grid

You can use the data to determine ideal operating conditions or estimate the response of
your system to hypothetical situations. For example, if you know the active and reactive
power in each transmission line, you can determine if the remaining lines can handle the
extra load that occurs when one or more transmission lines go offline.

You can also use the data to calculate transmission line or system losses and examine the
overall voltage profile of the network. Investigating these attributes can help you
determine if the system needs reactive compensation to overcome low voltage levels.

Network Requirements for a Simscape Electrical Load-Flow
Analysis

To determine the steady-state load-flow solution for a three-phase network using
Simscape Electrical, your model must be:

» Compatible with and configured for the Simscape frequency and time simulation
mode. For more information, see “Frequency and Time Simulation Mode” (Simscape)
and Solver Configuration.
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* Load balanced. The level of approximation of the load-flow analysis depends on how
balanced the system is and the level of harmonics that are present.

* Enabled for Simscape data logging. For complex models or long simulation runs, you
can improve simulation performance by enabling data logging for selected blocks by
using local solver settings. For a load-flow analysis, data logging is required only for
Busbar blocks. For more information, see “Enable Data Logging for the Whole Model”
(Simscape) and “Log Data for Selected Blocks Only” (Simscape).

Essential Blocks for a Load-Flow Analysis
Bus Bar Connectors

In an electrical transmission system, a bus bar connector, or bus, is a vertical line that
connects power components such as generators, loads, and transformers. To represent
buses, the Simscape > Electrical > Connectors & References library provides the
Busbar block.

Three-Phase Voltage Sources

You need to select the right three-phase voltage source for your model to conduct a load-
flow analysis. Which source you choose depends on whether you want to prioritize
simulation accuracy or performance. The balance between simulation accuracy and
performance depends, in part, on the blocks that you use to represent the voltage sources
in your analysis model. Simulation accuracy is a measure of model fidelity, that is, how
closely the simulation results agree with mathematical and empirical models. As model
fidelity increases, so does the computational cost of simulation. As computational cost
increases, simulation speed, decreases. Conversely, as model fidelity decreases,
simulation speed increases.

Prioritize Model Fidelity by Using Machine Blocks

To prioritize model fidelity over simulation speed, represent voltage sources by using
induction or synchronous machine blocks. For modeling induction machines, the
Simscape > Electrical > Electromechanical > Asynchronous Machines library
provides both the Induction Machine Squirrel Cage and Induction Machine Wound Rotor
blocks. For modeling synchronous machines, the Simscape > Electrical >
Electromechanical > Synchronous Machines library provides both the library
contains the Synchronous Machine Model 2.1, Synchronous Machine Round Rotor, and
Synchronous Machine Salient Pole blocks.
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Prioritize Simulation Speed by Using Load Flow Source Blocks

For a faster simulating, but lower fidelity model, represent the voltage sources in your
analysis model by using a Load Flow Source block from the Simscape > Electrical >
Sources library. The Load Flow Source block supplies either an idealized or a current-
dependent voltage source. The voltage can contain series impedance or can act as a
source for a swing, PV, or PQ bus.

Performing a Load-Flow Analysis

To examine load-flow data for a three-phase Simscape Electrical transmission system
model that is compatible with frequency-time simulation mode:

Enable Simscape data logging.
Parameterize the voltage sources.

At the beginning of a load-flow analysis, the equation variables for transmission line
losses are unknown. While the unknown variables are being solved, the buses
balance the losses by providing or absorbing active and reactive power. For each bus
there are four variables:

* P — Active power

* (@Q — Reactive power
+ V — Voltage

* 0 — Phase angle

Two of the variables are known and two are unknown. Which variables are known
and which are unknown depends on the actively controlled three-phase sources and
loads that are connected to the bus bar. The voltage source block configurations
determine which bus types are used in load-flow analysis. You can include more than
one bus type in your model. Bus type options are:

* Swing bus — A swing, slack, or reference, bus balances the active and reactive
power in a system. The slack bus serves as an angular reference for other buses in
the system. The phase angle of a swing bus is 0° and the voltage magnitude is
specified. A typical value is 1 pu. At the beginning of the load-flow analysis, P and
Q are the unknown variables for this bus.

* PV bus — A PV (or generator) bus balances the active and reactive power in a
system by supplying a constant, active power and voltage. At the beginning of the
load-flow analysis, 8 and Q are the unknown variables for this bus.

7-45



7 simulation and Analysis of Power Engineering Systems

7-46

PQ bus — A PQ (or load) bus determines the amount of active and reactive power
that is consumed. At the beginning of the load-flow analysis, V and 0 are the
unknown variables for this bus.

If your model contains one or more:

Load Flow Source blocks — For each block, for the Source type parameter, set
the bus type to one of these options:

* Swing bus
¢ PV bus
* PQ bus

Specify the related parameters, which differ depending on which bus type you
choose.

To avoid a simulation issue due to a nonoptimal minimum for PV or PQ buses, in
the Expected Ranges settings, specify minimum and maximum values for the
Internal source phase search range parameter.

Induction machine blocks — For each block, specify the priority and beginning
values for the block using the Variables settings. In the Main settings, set the
Initialization option parameter to Set targets for load flow
variables. In the Variables settings, select a Priority and specify a Beginning
Value for:

o Slip
* Real power generated
* Mechanical power consumed

For more on information on setting initial target values by using the Variables
settings, see “Set Priority and Initial Target for Block Variables” (Simscape).

To fully specify the initial condition, you must include an initialization constraint in
the form of a high-priority target value. For example, if your induction machine is
connected to an Inertia block, the initial condition for the induction machine is
completely specified if, in the Variables settings of the Inertia block, the Priority
for Rotational velocity is set to High. Alternatively, you could set the Priority to
None for the Inertia block Rotational velocity, and instead set the Priority for
the induction machine block Slip, Real power generated, or Mechanical power
consumed to High.



Perform a Load-Flow Analysis Using Simscape Electrical

5

Synchronous machine blocks — For each block, specify the bus type and
beginning values using the Initial Conditions settings. The available parameter
targets depend on whether the block is configured for a swing, PV, or PQ bus. In
the Initial Conditions settings:

a  Set the Initialization option parameter to Set targets for load flow
variables.

b  Select a bus for the Source type parameter.

¢ Specify values for the related bus parameter.

d To avoid a simulation issue due to a nonoptimal minimum, in the Expected
ranges settings, specify minimum and maximum values for the Internal
source phase search range parameter.

Configure each Busbar block:

Set the Number of connections to 2, 3, or 4.

Specify the voltage and frequency to match the specified values of the connected
voltage source block.

To view the load-flow data using a Scope block, expose the optional measurement
ports on the Busbar block:

* To expose ports Vt and ph, set Measurement ports to Yes.
* To expose ports P and Q, set Measurement ports to Yes.

Connect the Busbar and Scope blocks.

Configure the Solver Configuration block. Set Equation formulation to Frequency
and time.

Simulate the model.

After simulating, you can view the load-flow results in the Busbar block annotation and in
the Simscape logging data that the model outputs to the MATLAB workspace.

For examples that show how to perform a load-flow analysis, see:

2-Bus Loadflow
IEEE 9-Bus Loadflow
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Machine Parameterization and Variable Initialization

You can use the data from your load-flow analysis to correctly initialize three-phase
induction and synchronous machine blocks. For examples, see:

* Induction Motor Initialization with Loadflow

* Synchronous Machine Initialization with Loadflow

Troubleshooting Load-Flow Analysis and Initialization Issues

If you encounter issues when simulating a load-flow model, apply these troubleshooting
measures. Testing your load-flow model incrementally can help you avoid specifying
nonphysical load-flow requirements.

Internal Load-Flow Source Impedance

Including internal source impedance for a Load Flow Source block when the Source type
parameter of the block is set to Swing bus, PV bus, or PQ bus can prevent initialization
convergence. To resolve any convergence issues, use one of these methods:

* Limit the solution range by specifying a value for the Internal source phase search
range parameter.

* Neglect source impedance.

* Model the impedance externally from the Load Flow Source block.

Field-Circuit Transient or Initial Rotor Acceleration

If you initialize a synchronous machine block for a load-flow analysis, the block solves all
Park-transformed flux variables and mechanical variables for steady state. However,
incorrect initialization of an automatic voltage regulator (AVR) or governor can result in a
field-circuit transient or an initial rotor acceleration. To resolve these issues:

1 Determine the initialization values for the torque and field voltage.

a  Run the load-flow analysis by using approximated values for the AVR and
governor and settings.

b  Make a note of these values in the load-flow results reported by the adjacent
Busbar block:

* Voltage magnitude
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Phase angle
Generated real power
Generated reactive power

¢ For the synchronous machine block, in the Initial Conditions settings, set the
Initialization option parameter to Set real power, reactive power,
terminal voltage, and terminal phase.

d  Specify these parameters using the values from the load flow results:

Terminal voltage magnitude
Terminal voltage angle
Terminal active power
Terminal reactive power

e Print the required initial conditions for the AVR and governor to the MATLAB
workspace. Right-click the machine block and, from the context menu, select
Electrical > Display Associated Initial Conditions. The relevant data are the
field circuit voltage, si_efd0, and the mechanical torque, si torque0.

2 Specify the AVR and governor initial conditions using the calculated initial condition

values.

For example, the table shows the annotated data for the Busbar block that is next to the
Synchronous Machine Salient Pole block in ee loadflow _sm_initialization, the
model for the “Synchronous Machine Initialization with Loadflow” example. If you open
the Synchronous Machine Salient Pole block, click the Initial Conditions settings, and
set the Initialization option parameter to Set real power, reactive power,
terminal voltage, and terminal phase, you can observe that the specified
parameter values are equal to the load-flow simulation values.

Note The specified parameter values have already been entered to match the load flow
results for this model.
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Physical Quantity

Load-Flow
Simulation Value

Synchronous
Machine Block
Initial Conditions
Parameter Name

Synchronous
Machine Block
Initial Conditions
Parameter Value

Voltage magnitude 1.020 pu Terminal voltage 13.8*1.02 kV
magnitude
Phase angle 0.00 deg Terminal voltage 0 deg
angle
Generated real 31.2 MW Terminal active 31.2e6 V*A
power power
Generated reactive 10.4 Mvar Terminal reactive 10.4e6 V*A

power

power

If you print the data to the command line, the si torque0 and si_efd0 data are printed
under the Initial conditions required for steady-state (SI):

Initial conditions required for steady-state (SI):

si efd0 =
si ifdo =
si torque0@ =
si PmO =

85.4468 : Vv
1168.87 : A
828709 : Nm

3.12416e+07 : W

o® o° o o°

Field circuit voltage
Field circuit current
Mechanical torque
Mechanical power

To initialize correctly, specify 85.4468 V as the value for the field voltage source, and
828709 Nm as the value for the Shaft torque Constant block that is connected to the
Ideal Torque Source block.

Multiple Load-Flow Simulation Solutions

There are often multiple solutions to the set of load-flow targets specified when
initializing an AC electrical network. For example, for a PV bus source where you specify
the active power and voltage, there are two solutions for the reactive power. For the
desired solution, the magnitude of the reactive power is typically less than the specified
active power magnitude. For the undesired solution, the reactive power magnitude is

much larger than the active power magnitude.

If the initialization returns the undesired solution, reconfigure the Load Flow Source or
synchronous machine block and increase the value for the minimum boundary of the
Internal source range search range parameter. For the Load Flow Source block, the
parameter is in the Expected Ranges settings. For synchronous machine blocks, the
parameter is in the Initial Conditions settings.




See Also

Nonoptimal Local Minimum

The simulation can stop and generate an error if, to satisfy the active and reactive power
demands, the optimization decreases the Busbar block voltage, to the point where the
solution is closer to an undesired local minimum around zero busbar voltage than to the
desired load flow solution. To prevent this type of issue, reconfigure the Load Flow Source
or synchronous machine blocks and increase the value of the Minimum voltage (pu)
parameter. For the Load Flow Source block, the parameter is in the Expected Ranges
settings. For synchronous machine blocks, the parameter is in the Initial Conditions
settings.

Frequency and Time Simulation Mode Incompatibility

You can only perform a load-flow analysis by using the frequency and time simulation
mode. Replace any blocks that are not compatible with the frequency and time simulation
mode. For more information, see “Frequency and Time Simulation Mode” (Simscape).

See Also

Simscape Blocks

Busbar | Induction Machine Squirrel Cage | Induction Machine Wound Rotor | Load Flow
Source | Synchronous Machine Model 2.1 | Synchronous Machine Round Rotor |
Synchronous Machine Salient Pole

Functions

Related Examples

. 2-Bus Loadflow

. IEEE 9-Bus Loadflow

. Induction Motor Initialization with Loadflow

. Synchronous Machine Initialization with Loadflow
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Prepare Simscape Electrical Models for Real-Time
Simulation Using Simscape Checks

8-2

If you have a Simulink Real-Time license, you can optimize your model for real-time
execution using the Execute real-time application activity mode in the Simulink
Performance Advisor. This mode includes several checks specific to physical models. For
example, the Simulink Performance Advisor identifies Simscape Solver Configuration
blocks with settings that are suboptimal for real-time simulation. For optimal results,
Solver Configuration blocks should have the Use local solver and Use fixed-cost
runtime consistency iterations options selected.

The checks are organized into folders. You can use the checks in the Simscape checks
folder for all physical models. Subfolders contain checks that target blocks from Simscape
Electrical and other add-on products such as Simscape Driveline and Simscape
Multibody.

Before you run the checks, use the processes described in “Real-Time Model Preparation
Workflow” (Simscape), “Real-Time Simulation Workflow” (Simscape), and “Hardware-In-
The-Loop Simulation Workflow” (Simscape).

To run the Simulink Real-Time Performance Advisor Checks:

1 In the Simulink Editor menu bar, select Debug > Performance Advisor.

2 In the Performance Advisor window, under Activity, select Execute real-time
application.

In the left pane, expand the Real-Time folder, and then the Simscape checks folder.

Run the top-level Simscape checks and the Simscape Electrical checks. If your model
contains blocks from other add-on products, also run the checks in the subfolder
corresponding to that product.

See Also

More About

. “Model Preparation Objectives” (Simscape)
. “Real-Time Model Preparation Workflow” (Simscape)



See Also

“Real-Time Simulation Workflow” (Simscape)
“Use Performance Advisor to Improve Simulation Efficiency” (Simulink)
“Create and Use Code Generation Reports” (HDL Coder)
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* “Generate HDL Code from Simscape Models” on page 9-2
* “Deploy Simscape™ Plant Models to Speedgoat FPGA I/O Modules” on page 9-14

* “Troubleshoot Conversion of Simscape DC Motor Control to HDL-Compatible Simulink
Model” on page 9-27

* “Troubleshoot Conversion of Simscape™ Permanent Magnet Synchronous Motor to
HDL-Compatible Simulink Model” on page 9-38

* “Validate HDL Implementation Model to Simscape Algorithm” on page 9-55

* “Improve Sampling Rate of HDL Implementation Model Generated from Simscape
Algorithm” on page 9-64
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Generate HDL Code from Simscape Models

9-2

This example uses a halfwave rectifier model to illustrate how you can develop your plant
model in Simscape™ and use Simscape HDL Workflow Advisor to generate HDL code for
your model.

Why Generate HDL Code?

To perform hardware-in-the-loop (HIL) simulation with smaller timesteps and increased
accuracy, you can deploy the plant models to the FPGAs on board the Speedgoat I/O
modules. By using the Simscape HDL Workflow Advisor, you can generate an HDL
implementation model. You can then generate HDL code for the implementation model
and deploy the generated code onto the FPGA platforms. Using this capability, you can
model and deploy complex physical systems in Simscape that previously took long time to
model by using Simulink™ blocks.

Simscape Example models for HDL Code generation

For HDL code generation, you can design your own Simscape algorithm or choose from a
list of example models that are created in Simscape. The example models include:

* Boost Converter

» Bridge Rectifier

* Buck Converter

* Halfwave Rectifier

* Three Phase Rectifier

* Two Level Converter Ideal

* Two Level Converter Igbt

All examples are prefixed with sschdlex and postfixed with Example. For example, to
open the Boost Converter model, in the MATLAB™ command window, enter:

load system('sschdlexBoostConverterExample')
open_system('sschdlexBoostConverterExample/Simscape system')

Restrictions for HDL Code Generation from Simscape Models
HDL Coder™ does not support code generation from Simscape networks that contain:

* Events
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* Mode charts

* Delays

* Runtime parameters

* Periodic sources

* Simscape™ Multibody™ blocks

» Simscape Electrical Specialized Power Systems blocks

Guidelines for Modeling Simscape for HDL Compatibility

1. Create a Simscape model by using switched linear blocks. Switched linear blocks are
blocks such as diodes and switches. These blocks are defined by a linear relationship such
as V = IR where R can switch between two or more values depending on the state of the
diodes or switches. Add Simulink-PS Converter blocks at the input ports and PS-Simulink
Converter blocks at the output ports.

2. Configure the solver options for HDL code generation by using a Solver Configuration
block. In the block parameters of this block:

* Select Use local solver.

* Use Backward Euler as the Solver type.

* Specify a discrete sample time, Ts.

3. Enclose the blocks inside a Subsystem and provide the test inputs.

4. Configure the model for HDL code generation by running the hdlsetup function.
hdlsetup configures the solver settings such as using a fixed-step solver, specifies the
simulation start and stop times, and so on. To run the command for your

current _model:

hdlsetup('current model")

5. Verify Simscape model compatibility by using the simscape.findNonLinearBlocks
function. This function detects nonlinear blocks in your Simscape model. Provide the path
to your Simscape model as an argument to this function. It returns the names of nonlinear
blocks.

For example: To verify presence of nonlinear blocks in Half Wave Rectifier Model, in the
MATLAB command window, enter:

simscape.findNonlinearBlocks('sschdlexHalfWaveRectifierExample")

9-3
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The Halfwave Rectifier Model

To open the half-wave rectifier model, in the MATLAB Command Window, enter:

open_system('sschdlexHalfWaveRectifierExample')

Save this model locally as HalfWaveRectifier HDL to run the workflow.

load system('HalfWaveRectifier HDL')
open_system('HalfWaveRectifier HDL/Simscape system')
set param('HalfWaveRectifier HDL', 'SimulationCommand', ‘'update');

:@{ doubla 01

‘ Vdiode

doubla 01

o0y

IR

‘ LDP— doubde [H

lout

flx)=10

The Simscape model uses switched linear blocks such as Diodes and Resistors to model
the design. The model has Simulink-PS Converter blocks at the input port and PS-
Simulink converter blocks at the output ports. To verify that you configured the solver
settings correctly, open the Solver Configuration block.

At the top level of the model, you see a Simscape system block that models the half-
wave rectifier algorithm. The model accepts a Sine Wave input, uses a Rate Transition
block to discretize the continuous time input, and has a Scope block that calculates the
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output. To see the input stimulus and the output from the model, connect the Sine Wave
input to the Scope block.

open_system('HalfWaveRectifier HDL")

doubla 01
IR g
_ IR
_ |doubde Con R O |doutle 01 ] dhoubla 01
*Yin e _ I in lout L
@ o lout
double 01
Viiode — |
Simscape_systemn
= Copyright 2018 The MathWorks, Inc.

To configure the half-wave rectifier model for HDL compatibility, in the MATLAB
command window, enter:

hdlsetup('HalfWaveRectifier HDL")
Simulate and Verify Functionality of Simscape Algorithm
To see the simulation results, simulate the model and then open the Scope block.

sim('HalfWaveRectifier HDL'")

This figure shows simulation results with the sine wave input and the outputs from
Simscape system.
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Y Scope
File  Tools  View  Simulation  Help
@- O P® | == Q- L-F-

Sample based | T=0.0005

Ready

Open Simscape HDL Workflow Advisor

To generate an HDL implementation model from which you can generate code, use the
Simscape HDL Workflow Advisor. To open the Advisor, run this command:

sschdladvisor('HalfWaveRectifier HDL")

Updating Model Advisor cache...
Model Advisor cache updated. For new customizations, to update the cache, use the Advi

This command updates the model advisor cache and opens the Simscape HDL Workflow

Advisor. To learn more about the Simscape HDL Workflow Advisor and the various tasks,
right-click that folder or task, and select What's This?.
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See also Simscape HDL Workflow Advisor Tasks.

Run Simscape HDL Workflow Advisor

To run the workflow, in the Simscape HDL Workflow Advisor, right-click the Generate
implementation model task and select Run to Selected Task.

model

A4 I._a Simscape HDL Workflow Advisor

v L_a Code generation compatibility
0 Check solver configuration
0 “Check switched linear

hd L_a State-space conversion
@ Etract equations
0 Discretize equations

v L_a Implementation model generation
o Generate implementation model

Solver Settings
Solver method: Iterative Number of solver iterations | 3
Implementation Model Settings

Floating-point predision

@ Single
() Double
O Single coeffident, double computation What's This?

Verification Settings

[] Generate validation lagic for the implementation model Validation logic tolerance | 1e-1
Run This Task
Result: 0 Passed

Passed

Generated implementation model 'gmStateSpace HDL_HalfWaveRectifier HDL'

If the task passes, you see a link to the implementation model.

How to Change This?

Help Apply

In some cases, your Simscape algorithm may not be compatible for generating an
implementation model using the Simscape HDL Workflow Advisor. In such cases, running
certain tasks in the Advisor can result in the task to fail. To learn how you can make it
HDL compatible, see

* Troubleshoot Conversion of Simscape DC Motor Control to HDL-Compatible Simulink

Model.

» Troubleshoot Conversion of Simscape Permanent Magnet Synchronous Motor to HDL-
Compatible Simulink Model.
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Open HDL Implementation Model

To see the implementation model, in the Generate implementation model task, click
the link.

open_system('gmStateSpaceHDL HalfWaveRectifier HDL"')
set param('gmStateSpaceHDL HalfWaveRectifier HDL', 'SimulationCommand', 'Update')

Interface System

PS-Simulink Converter! F

¥ 3

Simulink-P5 Conyartar + P3-Samulink Convert

PS-Simulink Converter2 £

The model contains two subsystems. The Subsystem block contains the Simscape
algorithm that you modeled. From and Goto blocks inside this Subsystem provide the
same Sine Wave input to the HDL Subsystem.

The HDL Subsystem models the state-space representation that you generated from the
Simscape model. The ports of this Subsystem use the same name as the Simulink-PS
Converter and PS-Simulink Converter blocks in your original Simscape model. If you
navigate inside this Subsystem, you see several delays, adders, and Matrix Multiply
blocks that model the state-space equations.

open_system('gmStateSpaceHDL HalfWaveRectifier HDL/HDL Subsystem/HDL Algorithm')
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single D1
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State Delay Mode Selection
Valid Out

To simulate the HDL Implementation model, enter this command:

sim('gmStateSpaceHDL HalfWaveRectifier HDL')

Open the scope block to view results.

single [3x1]
[3x1)

Cutput
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4 Scopel — O >
File  Tools  View  Simulation  Help o
@- O P® | == Q- L-F-

nulink Converter1, PS3-Simulink Converter, PS-Simulink IZ:.

Ready Sample based | T=0.0005

The simulation results from the HDL implementation model matches that of the original
plant model. Therefore, we can verify that the plant simulation model is correctly
transformed into an HDL implementation model.

HDL code is generated for the HDL Subsystem block inside this model.
Generate HDL Code and Validation Model

The HDL model and subsystem parameter settings are saved using this command:
hdlsaveparams('gmStateSpaceHDL HalfWaveRectifier HDL');

%% Set Model 'gmStateSpaceHDL HalfWaveRectifier HDL' HDL parameters

hdlset param('gmStateSpaceHDL HalfWaveRectifier HDL', 'FloatingPointTargetConfiguratior
, 'LatencyStrategy', 'MIN')

);

hdlset param('gmStateSpaceHDL HalfWaveRectifier HDL', 'MaskParameterAsGeneric', 'on');
hdlset param('gmStateSpaceHDL HalfWaveRectifier HDL', 'Oversampling', 60);
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% Set SubSystem HDL parameters
hdlset param('gmStateSpaceHDL HalfWaveRectifier HDL/HDL Subsystem', 'FlattenHierarchy'

hdlset param('gmStateSpaceHDL HalfWaveRectifier HDL/HDL Subsystem/HDL Algorithm/Mode S¢

The model uses single data types and generates HDL code in native floating-point mode.
Floating-point operators can introduce delays. Because the design contains feedback
loops, for the model transformation advisor to allocate enough delays for the operators
inside the feedback loops, the model uses clock-rate pipelining in conjunction with a large
value for the Oversampling factor. An Oversampling factor of 100 and the clock-rate
pipelining optimization is saved on this model.

For more information, see:

* Clock-Rate Pipelining
* Oversampling Factor
* Allocate Sufficient Delays for Floating-Point Operations

Before you generate HDL code, it is recommended to enable generation of the validation
model. The validation model compares the output of the generated model after code
generation and the original model. To learn more, see Generated Model and Validation
Model.

Run these commands to save validation model generation settings on your Simulink
model:

HDLmodelname = 'gmStateSpaceHDL HalfWaveRectifier HDL';

hdlset param(HDLmodelname, 'TargetDirectory', 'C:/Temp/hdlsrc');
hdlset param(HDLmodelname, 'GenerateValidationModel', ‘'on');

To generate HDL code, run this command:

makehdl('gmStateSpaceHDL HalfWaveRectifier HDL/HDL Subsystem');

The generated HDL code and validation model are saved in C: /Temp/hdlsrc directory.
The generated code is saved as HDL_Subsystem tc.vhd. To open the validation model,

click the link to gm_gmStateSpaceHDL HalfWaveRectifier HDL vnl.slx inthe
code generation logs in the Command Window.
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Open the Compare block at the output of HDL Subsystem vnl Subsystem of the
validation model. Then, open the Assert Outl block. To see the simulation results after
HDL code generation, open the Compare: Outl Scope block:

4. compare: Outl h — O x

File Teools  View  Simulation  Help o

G- O = Q- EFEH-

Ready Sample based T=0.0005

The top graph represents the output of the generated model, and the middle graph
represents the output of the implementation model. Since the output generated by both
the models are exactly matching, the error between them is zero, which is represented in
the last graph.
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Optionally, you can deploy the HDL code on a Hardware platform. For more information,
see Deploy Simscape plant models to Speedgoat FPGA 10 modules.

See Also

Functions
checkhdl | makehdl

More About

. “Getting Started with Simscape Electrical”

. “Troubleshoot Conversion of Simscape DC Motor Control to HDL-Compatible
Simulink Model” (HDL Coder)

. “Validate HDL Implementation Model to Simscape Algorithm” (HDL Coder)
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Deploy Simscape™ Plant Models to Speedgoat FPGA 1/0
Modules

This example shows how you can deploy the Simscape plant models on Speedgoat FPGA
I/0O modules by using the HDL Workflow Advisor. This workflow is a two-step process.

1  Develop the Simscape model and convert it into an implementation model by using
the Simscape HDL Workflow Advisor. HDL code is generated from this
implementation model. For more information, see Generate HDL Code from Simscape
Models.

2  Deploy HDL code to a Speedgoat I/O module by using the HDL Workflow Advisor.
Why Deploy a Simulink Model to Speedgoat FPGA Modules

You can use the HDL Workflow Advisor to deploy the Simulink™ model to Speedgoat
FPGA 1/0 modules. Simulating the plant model on the FPGA provides:

* Real-time Simulation: Hardware-in-the-loop provides real-time simulation of your
Simscape plant model.

% i b

VERIFICATION

@0

TEST SUITE

Hardware

n Under  Cirl @ PLANT MODEL

Test

Cmd S =

* Hardware Acceleration: The speed of simulating physical systems increases by
implementing it on hardware as reconfigurable FPGAs provide rapid hardware
prototyping. You can use this capability to model complex physical systems.

Set Up and Configuration

To deploy the Simscape plant models onto Speedgoat FPGA modules:

1. Install Xilinx Vivado®
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Speedgoat FPGA 10333-325K uses Xilinx Vivado. If it is not already present, install Xilinx
Vivado v2018.2. Then, set the tool path to the installed Xilinx Vivado 2018.2 executable.
To set the tool path, use the hdlsetuptoolpath function.

hdlsetuptoolpath('ToolName', 'Xilinx Vivado', 'ToolPath','C:\Xilinx\Vivado\2018.2\bin\vi:
2. Set Up I/O Module

To run the simulation of the Simscape plant model in real time on hardware, you must set
up the I/O module. For information on setting up the I/O module, see Xilinx HDL Software
for Speedgoat 1/O Hardware.

HDL Workflow Advisor

The HDL Workflow Advisor guides you through the stages of generating HDL code for a
Simulink subsystem and the FPGA design process, such as:

* Checking the model for HDL code generation compatibility and automatically fixing
incompatible settings.

* Generating HDL code, a test bench, and scripts to build and run the code and test
bench.

* Synthesis and timing analysis through integration with third-party synthesis tools.

* Completing the automated workflows for deployment on hardware platforms such as
System-on-Chip(SoC), FPGAs, and Speedgoat I/O modules.

This example shows how to use the HDL Workflow Advisor to deploy HDL code on
Speedgoat 10333-325K module that uses Xilinx Vivado. For example, to open the HDL
Workflow Advisor for a Subsystem inside the model, enter:

load _system('sschdlexTwoLevelConverterIghtExample')
hdladvisor('sschdlexTwoLevelConverterIgbhtExample/Simscape system')

For more information, see hdladvisor.

In the HDL Workflow Advisor, the left pane lists the folders in the hierarchy. Each folder
represents a group or category of related tasks. Expanding the folders shows the
available tasks in each folder. From the left pane, you can select a folder or an individual
task. The HDL Workflow Advisor displays information about the selected folder or task in
the right pane. The contents of the right pane depends on the selected folder or task. For
some tasks, the right pane contains simple controls for running the task and a display
area for status messages and other task results. For other tasks that involve setting code
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or test bench generation parameters, the right pane displays several parameter and
option settings.

To learn more about each individual task, right-click that task, and select What's This?.

v [ HDL Workflow Advisor
hd [@ 1. Set Target
=] ~1.1. Set Target Devi Run All
=] 1.2. set Target Frequ Reset
hd F‘_p 2. Prepare Model For HDL
=] 2.1. Check Global Seti
=] ~2.2. Check Algebraic Loops
=] ~2.3. Check Block Compatibility
=] ~2.4. Check Sample Times
hd F‘_p 3. HDL Code Generation
[?'_,u 3.1. Set Code Generation Optons
=] ~3.2. Generate RTL Code and Testbench

What's This?

For more information, see Getting Started with the HDL Workflow Advisor.
Two Level Ideal Converter Model

This example uses a Two-Level Ideal converter Simscape plant model. To open this model,
enter:

open_system('sschdlexTwoLevelConverterIdealExample')
Save this model locally as TwoLevelConverter HDL.slx to run this workflow.

open system('TwolLevelConverter HDL")
set param('TwoLevelConverter HDL', 'SimulationCommand', 'update')
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open_system('TwoLevelConverter HDL/Simscape system')
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The Simscape subsystem receives six-switch controlling pulses as input. The Simscape
subsystem acts as a generator that uses a two-level, carrier-based PWM method to:

1 Sample a reference wave.
2 Compare the sample to a triangular carrier wave.

3  Generate a switch-on pulse if a sample is higher than the carrier signal or a switch-off
pulse if a sample is lower than the carrier wave.

Generate HDL Implementation Model

To generate an implementation model, use the Simscape HDL Workflow Advisor. Enter:

sschdladvisor('TwoLevelConverter HDL"')
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v Li Simscape HOL Workflow Advisor
Li Code generation compatibility
Li State-space conversion
A Li Implementation model generation
o Generate implementation model

model
Solver Settings

Solver method: Iterative

Implementation Model Settings
Floating-point predision
@ Single
() Double

O Single coeffident, double computation

Verification Settings

[] Generat:

logic for the i

Number of solver iterations How to Change This?

What's This?

ion model Validation logic tolerance | 1=-12

Run This Task
Result:

0 Passed

Passed

Generated implementation model 'gmStateSpaceHDL_Twol evelConverter HDL"

Help Apply

To generate the implementation model, in the Simscape HDL Workflow Advisor, keep the
default settings for all the tasks, and then run the tasks. You see a link to the model in the
Generate implementation model task.

To learn more about the Simscape HDL Workflow Advisor, see:

* sschdladvisor

* Generate HDL code from Simscape Models

The Implementation Model

To open the implementation model, enter:

open_system('gmStateSpaceHDL TwolLevelConverter HDL')
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HDL Subsystem

The model contains two subsystems. The HDL Subsystem models the state-space
representation that you generated from the Simscape model. The ports of this subsystem
use the same name as the Simulink-PS Converter and PS-Simulink Converter blocks that
you use in your original Simscape model. If you navigate inside this Subsystem, you see
several delays, adders, and Matrix Multiply blocks that model the state-space equations.
From and Goto blocks inside this subsystem provide the same input as that of the original
model to the HDL Subsystem.

Deploy Two Level IGBT Converter Model to Speedgoat 10333-325K Module

This example shows how to deploy the implementation model of Two Level IGBT
Converter to Speedgoat 10333-325K FPGA module by using the HDL Workflow Advisor.
The Speedgoat 10333 FPGA module uses Xilinx Vivado and IP Core Generation
Infrastructure. Before you run the Workflow Advisor, make sure that you have specified
the path to the installed Xilinx Vivado executable.

1. Open HDL Workflow Advisor

To open the HDL Workflow Advisor for the Implementation model, enter:

hdladvisor('gmStateSpaceHDL TwolLevelConverter HDL/HDL Subsystem')

2. In Set Target Device and Synthesis Tool task, set these parameters and select Run
This Task:

* Target workflow as Simulink Real-Time FPGA I/0
* Target platform as Speedgoat I0333-325K
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* Synthesis tool as Xilinx Vivado

1.1. Set Target Device and Synthesis Tool
Analysis (*Triggers Update Diagram)

Set Target Device and Synthesis Tool for HDL code generation
Input Parameters

Target workflow: | Simulink Real-Time FPGA 1/0
Target platform: | Speedgoat 10333-325K
Synthesis tool: | Xilinx Vivado

Family: | Kintex?

Package: |fig200

Project folder: | hdl_prj

- Launch Board Manager
* | Tool version: | 2017.4 Refresh
Device: |xc7k325t
Speed: -2
| Browse...

3. In Set Target Reference Design task, select a value of x4 for the parameter PCIe
lanes, and select Run This Task.

1.2. Set Target Reference Design

Analysis ( ~Triggers Update Diagram)

Set target reference design options
Input Parameters

Reference design: | Speedgoat I0333-325K-06-V001
Reference design tool version: | 2017.4

Reference design parameters

Ignore tool version mismatch

Parameter Value

PCle lanes x4

4. In Set Target Interface task, map the Input and Output single data type ports to
PCIe Interface and select Run This Task.
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1.3. Set Target Interface
Analysis ("~ Triggers Update Diagram)
Set target interface for HDL code generation
Input Parameters

ProcessorfFPGA synchronization: | Free running i

Target platform interface table

Port Name Port Type Data Type Target Platform Interfaces Bit Range / Address [ FPGA Pin
Simulink-P5 Converte...  Inport single PCle Interface ¥ | x"1007
Simulink-PS Converte__. | Inport single PClIe Interface ¥  x"108"
Simulink-P5 Converte...  Inport single PCle Interface v | x"1047
Simulink-P5 Converte_..  Inport single PCIe Interface ¥ | x"10C"
Simulink-P5 Converte...  Inport single PCle Interface ¥ | x"1107
Simulink-PS Converte_..  Inport single PCIe Interface v | x"1147
PS-Simulink Converter | Outport single (3) | PCle Interface v | x"1207
PS-Simulink Converte... | Outport single (3) | PCle Interface v | x"1407
PS-Simulink Converte... | Outport single PCle Interface ¥ | x"1187

5. In Set Target Frequency task, select a target frequency that is within the range. If the
target frequency is set to higher values, it results in a failure to generate the bitstream
when you run task Build FPGA Bitstream. This example has Target Frequency set to
50 MHz.

1.4. Set Target Frequency
Analysis

Set Target Frequency
Input Parameters

Target Frequency (MHz): |50

Default (MHz): 100 Restore Default

Frequency Range (MHz): | 10-200
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6. Right-click Generate RTL Code and IP Core task and select Run to Selected Task.
This step generates a warning if the model uses vector data types. Click the link in the
warning, select Scalarize vector ports, and rerun the task.

7. Run the workflow to the Generate Simulink Real-Time interface task. In Create
Project task, you can open the Vivado project and see the implemented design.

4.1. Create Project
Analysis
Create project for embedded system tool
Input Parameters

Embedded system tool: | Xilinx Vivado with IP Integrator
Project folder: | hdl_prj\vivado_ip_prj
Synthesis objective: -

Enable IF caching

Run This Task

Result: 0 Passed

Passed Create Project.

8. When the Generate Simulink Real-Time interface task passes, you see a link to
open the Simulink Real-Time Interface Model. Select this link.
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5.1. Generate Simulink Real-Time interface

Analysis

Generate Simulink Real-Time interface

Run This Task

Result: Q Passed

Passed Generate Simulink Real-Time Interface.

Generating new Simulink Real-Time Interface model:

om_omStateSpace HDL Twolevel Converter HIII

slrt

Simulink Real-Time Interface model generation complete.

Generated by HOL Workflow Advisor on 28-Jun-2018 14:38:06

Interface System
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Converteri Conwarter! PS-Simublnk Converisr
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Sirnulink-PS | l Simubnk-PE.
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= Converlend
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Export HDL Workflow to Script

Optionally,
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See Also

» Save the HDL Workflow Advisor settings to script and run the script using command
line.

* Import the settings to modify it and rerun it using the HDL Workflow Advisor User
Interface.

Export an HDL Workflow Script

In the HDL Workflow Advisor, configure and run all the tasks.
Select File > Export to Script.

In the Export Workflow Configuration dialog box, enter a file name and save the
script.

The script is a MATLAB® file that you can run from the command line.
Import an HDL Workflow Script

1 In the HDL Workflow Advisor, select File > Import from Script.
2 In the Import Workflow configuration dialog box, select the script file and click Open.

The HDL Workflow Advisor updates the tasks with the imported script settings.
Simulink Real-Time FPGA 1I/0 Workflow Example
This example shows how to configure and run an exported HDL Workflow script.

To generate an HDL Workflow script, configure and run the HDL Workflow Advisor with
your Simulink design, then export the script.

This script is a Simulink Real-Time FPGA I/0 workflow script that targets the
Speedgoat I0333-325K module, which uses the Xilinx Vivado synthesis tool.

To edit the exported script in MATLAB command window, enter:
edit('hdlworkflow slrt.m")

For more information, see Run HDL Workflow with a Script

See Also

Functions
checkhdl | makehdl
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More About
. “IP Core Generation Workflow for Speedgoat I/O Modules” (HDL Coder)
. “FPGA Programming and Configuration” (HDL Coder)

. “Troubleshoot Conversion of Simscape DC Motor Control to HDL-Compatible
Simulink Model” (HDL Coder)

. “Simscape HDL Workflow Advisor Tasks” (HDL Coder)
. “Validate HDL Implementation Model to Simscape Algorithm” (HDL Coder)
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Troubleshoot Conversion of Simscape DC Motor Control
to HDL-Compatible Simulink Model

This example shows how to modify a Simscape™ plant model to generate an HDL-
compatible Simulink® model with HDL Coder™. HDL code is then generated from this
Simulink model.

Introduction

The Simscape plant model is converted to an HDL-compatible Simulink model by using
the Simscape HDL Workflow Advisor. To run the Advisor, you run the sschdladvisor
function for the model.

The Simscape HDL Workflow Advisor generates an HDL implementation model from
which you generate HDL code. Before you generate the implementation model, make sure
that the Simscape plant model is compatible for generation of the implementation model
using the Simscape HDL Workflow Advisor. For more information, see Generate HDL
Code from Simscape Models.

In some cases, the Simscape plant model may not be compatible for generation of the
implementation model using the Simscape HDL Workflow Advisor. For HDL compatibility,
you modify the Simscape plant model and then run the Simscape HDL Workflow Advisor.
This example illustrates the DC Motor Control plant model. The model contains a
nonlinear Friction block. You can use the approach in this example to convert Simscape
models with few nonlinear blocks to a HDL-compatible Simulink model.

DC Motor Control Model

The DC Motor Control model is a physical model developed in Simscape. The model
contains nonlinear elements and requires certain modifications for implementation model
generation.

open_system('ee dc motor control')

Enclose the DC Motor and Friction block inside a Subsystem and save the model as
ee dc motor control original.

open_system('ee dc motor control original')
set param('ee dc motor control original', 'SimulationCommand', 'Update’)
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3. Learn more about this example

DC motor control is used as a speed control structure. A PWM controlled four-quadrant
Chopper is used to feed the DC motor. The DC motor consists of Rotational
Electromechanical Converter, Resistor, Inductance, Friction block and an Inertia block.
The control subsystem includes the outer speed-control loop, the inner current-control

loop and the PWM generation.

sim('ee dc_motor control original')
open_system('ee dc motor control original/Scope')
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Make DC Motor Model HDL-Compatible

To convert the model to a model that is compatible for conversion with Simscape HDL
Workflow Advisor:

1. Detect presence of nonlinear components or blocks in the model. To verify the presence
of nonlinear blocks in Simscape plant model, enter:

simscape.findNonlinearBlocks('ee dc motor control original')

Found network that contains nonlinear equations in the following blocks:
'ee_dc_motor control original/DC Motor/Friction'

The number of linear or switched linear networks in the model is 0.
The number of nonlinear networks in the model is 1.

ans =
1x1 cell array

{'ee_dc_motor control original/DC Motor/Friction'}

The Simscape plant model has a nonlinear block, which is the Friction block.

2. For HDL compatibility, the model must not contain nonlinear elements. Remove the
Friction block from the model.

3. To simulate the model faster and to reduce the time that the Simscape HDL Workflow
Advisor takes to extract the state-space equations, reduce the stop time of this model. In
the Simulink Toolstrip, on the Simulation tab, change Stop Time to 1.

Save the changes into a new model as ee_dc_motor control modified.

open_system('ee dc motor control modified')
set param('ee dc motor control original', 'SimulationCommand', 'Update')
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1. Modify model parameters
2. Explore simulation results using sscexplore

3. Learn more about this example

Scope

To see the simulation results of the modified model, run these commands:

sim('ee dc_motor control modified')
open_system('ee dc motor control modified/Scope')
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Run Simscape HDL Workflow Advisor and Verify Simulation Results

To open the Simscape HDL Workflow Advisor, run the sschdladvisor for your model.
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sschdladvisor('ee dc motor control modified')

To generate the implementation model, in the Simscape HDL Workflow Advisor, leave all
tasks to the default settings and then run the tasks. You see a link to the model in the

Generate implementation model task.

2 Simscape HOL Workflow Advisor — O =
File Edit Run Help
G te impl ion model
hd [i Simscape HDL Workflow Advisor X
X o Solver Settings ~
hd [i Code generation compatibility
@ Check solver configuration Solver methed | Iterative Mumber of solver iterations 3
'0 “Check switched linear i .
v [i State-space conversion Implementation Model Settings
@ Estract equations Fioating-point precision
'0 Discretize equations @ Single
hd [i Implementation model generation o e
uble
o Generate implementation model
O Single coefficient, double computation
What's This?
Verification Settings
|:| Generate validation logic for the implementation model Validation logic tolerance | 1e-12
Run This Task
Result: 0 Passed
Passed
Generated implementation model 'gmStateSpaceHDL _ee_dc_motor_control_maodifie'.
v
Help Apply

Click the link to open the implementation model.
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Simulate Implementation model and Generate HDL code

Before you can generate HDL code from the model, you must change the sample time and
specify certain settings that make the model compatible for HDL code generation. The
sample time of modified plant model is Ts and the number of solver iterations to compute
the modes is 3. Therefore, you must change the sample time of the model. To specify the
HDL-compatible settings:

1

In the Configuration Parameters dialog box:

On the Solver pane, set Fixed-step size (fundamental sample time) to Ts/3 and
select Treat each discrete rate as a separate task.

On the Diagnostics > Sample Time pane, set Multitask rate transition and
Single task rate transition to error.

Add a Rate Transition block in your Simscape model that is placed inside the
Subsystem block in your implementation model as illustrated in figure below.
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To simulate the model, run this command and then open the Scope block to see the
results:

sim('gmStateSpaceHDL ee dc _motor control modifie')
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You see that the output generated by the modified Simscape plant model matches the
output generated by the implementation model.

Generate HDL Code and Validation Model

Before you generate HDL code, it is recommended that you enable generation of the
validation model. The validation model compares the output of the generated model after
code generation and the modified Simscape plant model. To learn more, see Generated
Model and Validation Model.
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To save validation model generation settings on your Simulink model, run this command:

hdlset param('gmStateSpaceHDL ee dc motor control modifie', 'GenerateValidationModel',
To generate HDL code, run this command:

makehdl('gmStateSpaceHDL ee dc motor control modified/HDL Subsystem')

By default, HDL Coder generates VHDL code. To generate Verilog code, run this
command:

makehdl('gmStateSpaceHDL ee dc _motor control modifie/HDL Subsystem', 'TargetLanguage',

The generated HDL code and the validation model is saved in the hdlsrc directory. The
generated code is saved as HDL Subsystem tc.vhd. You can also verify the simulation
results by running the validation model

gm gmStateSpaceHDL ee dc motor control modifie vnl.slx.

See Also

Functions
checkhdl | makehdl

More About

. “Generate HDL Code from Simscape Models” (HDL Coder)

. “Getting Started with Simscape Electrical”

. “Simscape HDL Workflow Advisor Tasks” (HDL Coder)

. “Validate HDL Implementation Model to Simscape Algorithm” (HDL Coder)
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Troubleshoot Conversion of Simscape™ Permanent
Magnet Synchronous Motor to HDL-Compatible Simulink
Model

9-38

This example shows how to modify a Simscape™ plant model that is continuous-time and
contains nonlinear elements to generate an HDL-compatible Simulink™ model. You can
then generate HDL code for this Simulink model.

Introduction

The Simscape HDL Workflow Advisor converts the Simscape plant model to an HDL-
compatible implementation model from which you generate HDL code. In some cases, the
Simscape plant model might not be compatible for implementation model generation. In
such cases, you first modify the Simscape plant model and then run the Advisor.

This example illustrates how to modify a permanent magnet synchronous motor model for
compatibility with Simscape HDL Workflow Advisor. The model is continuous time and
contains many nonlinear components. You modify this model to a discrete-time switched
linear model and then run the Simscape HDL Workflow Advisor.

Permanent Magnet Synchronous Motor Model

The permanent magnet synchronous motor model is a physical system in Simscape. To
open the model, run this command:

open_system('ee pmsm drive')
Save this model as ee_pmsm _drive original.slx

open_system('ee pmsm drive original')
set _param('ee pmsm drive original', 'SimulationCommand', 'Update')
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1. Explore simulation results using sscexplore
|E| 2. Learn more about this example

The model contains a Permanent Magnet Synchronous Machine (PMSM) and inverter-
sized that you can use in a typical hybrid vehicle. The inverter is connected to the vehicle
battery. To see how the model works, simulate the model.

sim('ee pmsm drive original')
open_system('ee pmsm drive original/Scope')
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This model is a continuous time system. To use this model with Simscape HDL Workflow
Advisor, convert the model into a discrete system. Then you modify the model to use
blocks that are compatible for the Simscape to HDL workflow.
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Convert Continuous-Time Model to Fixed-Step Discrete Model

1. Configure the solver options for HDL code generation by using a Solver Configuration
block. In the block parameters:

» Select Use local solver.

* Use Backward Euler as the Solver type.

* Specify a discrete Sample time, Ts.

2. Modify the Solver settings of the model. On the Modeling tab, click Model Settings.
On the Solver pane:

* Set Solver selection type to Fixed-Step.
* Set Solver to discrete (no continuous states).
* Set Fixed-step size (fundamental sample time) to Ts.

* In the section Tasking and sample time options, clear Treat each discrete rate as
a separate task.

3. Modify the display settings of your model. On the Debug tab, select Information
Overlays > Sample Time > Colors. Review the Sample Time Legend for blocks that
have a sample time other than Ts, or run at a continuous time scale. Double-click the
Step block and set the Sample time to Ts.

4. For faster simulation, ignore the zero-sequence parameters of the PMSM. Double-click
the Permanent Magnet Synchronous Motor block and set Zero Sequence to Exclude.

The model is now a fixed-step discrete system. Simulate the model and compare the
Torque Demand and Motor Torque signals in the Simulation Data Inspector. The
signals differ by more than the tolerance levels toward the end of simulation but are
within acceptable limits.
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You use a two-step process to convert the Simscape plant model to a HDL-compatible
implementation model:

1. Implement a Simulink model that replaces the nonlinear part of the Simscape
algorithm by using equivalent Simulink blocks.

2. Modify this model to use blocks that are compatible for Simscape to HDL workflow.

Replace Nonlinear Simscape Blocks with Equivalent Simulink Implementation

1. To make the Simscape plant model HDL-Compatible, identify the presence of any
nonlinear components or blocks in the model:

simscape.findNonlinearBlocks('ee pmsm drive original')
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Found network that contains nonlinear equations in the following blocks:
'ee_pmsm_drive original/Permanent Magnet Synchronous Motor'

The number of linear or switched linear networks in the model is 0.
The number of nonlinear networks in the model is 1.

ans =
1x1 cell array

{'ee_pmsm drive original/Permanent Magnet Synchronous Motor'}

The Simscape plant model has a nonlinear block, which is the PMSM block.

2. Replace the PMSM block, Encoder block, Gmin resistor, and Motor & Load Inertia
block with Simulink blocks that perform the equivalent algorithm.

The ee_pmsm_drive singleSL model illustrates how you modify the Electrical
Interface and Permanent Magnet Synchronous Motor (Simulink) subsystems. To
implement the Electrical Interface block, you use Controlled Current Sources.

load_system('ee pmsm drive singleSL")

set param('ee pmsm drive singleSL', 'SimulationCommand', 'update')
open_system('ee pmsm drive singleSL/Electrical Interface')

9-43



9 Simscape to HDL Workflow

o1 Simulink-FS

doubla 01 =

dioublal H—g [dou
-‘I —
-

iabc

Simulink-FP3

: OF—

Controlled Current
Source A

S
Controlled Current
T Source B

I

doubla 01

S

PS-Simulink couble
Vab

va_LL

doubly 01

S Y

PS-Simulink

E Ve

The interface to the PMSM is isolated from the implementation. To implement the PMSM
by using Simulink blocks, you use Electrical Equations and Mechanical Equations. Inside
the Park Transform and Inverse Park Transform blocks, eliminate the Sine and Cosine
blocks.

open_system('ee pmsm drive singleSL/Permanent Magnet Synchronous Motor (Simulink)"', 'f
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Electrical | Equations

= EMIED‘
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Mechanical Equations

Modify Simulink Model for Compatibility with HDL Implementation Model
Generation

1. To save resource usage on the target hardware, add Data Type Conversion blocks to
convert the model to use single data types.

2. Add a Digital Clock with Sample time Ts at the top level of the model. Connect the
clock to a Display block.

3. Replace the Three-Phase Current Sensor Simscape block by feeding the controller with
three-phase currents coming from the PMSM model.

This figure illustrates the top level of the model with the above changes.

open_system('ee pmsm drive singleSL")
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1. Explore simulation resulis using sscexplore
2. Learn more about this example

4. To reduce the FPGA area footprint for the:

* Park Transform block, you add Clarke Transform and Clarke to Park Angle Transform
blocks.

* Inverse Park Transform block, you add Inverse Park to Clarke Angle Transform and
Inverse Clarke Transform blocks.

open_system('ee pmsm drive singleSL/Permanent Magnet Synchronous Motor (Simulink)/Park
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Run Simscape HDL Workflow Advisor

To open the Simscape HDL Workflow Advisor, run the sschdladvisor function for your

model:

sschdladvisor('ee pmsm drive singleSL")
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Generate implementation model

bl [i Simscape HDL Workflow Advisor .
X o Solver Settings

hd [i Code generation compatibility

@ check solver configuration Solver method: Iterative

o “Check switched linear

How to Change This?

MNumber of solver iterations |4

Implementation Model Settings

hd [ﬁ State-space conversion

o Extract equations Floating-point predsion

o Discretize equations @ Single
hd [i Implementation model generation O .

Generate implementation model o
O Single coeffident, double computation
What's This?
Verification Settings
Validation logic tolerance | 1=-12

|:| Generate validation logic for the implementation model

Run This Task
Result: o Passed
Passed
Generated implementation model 'gmStateSpaceHDL _ee_pmsm_drive singleSL'.
W
>
Help Apply

To generate the implementation model, in the Simscape HDL Workflow Advisor, leave the
default settings and then run the tasks. To open the implementation model, in the

Generate implementation model task, click the link.
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Reconfigure Implementation Model for HDL Code Generation

Save this model as gnStateSpaceHDL ee pmsm drive GenerateHDL. To reconfigure
the single-precision implementation model for HDL code generation:

1. Run the hdlsetup function on the model.
hdlsetup('gmStateSpaceHDL ee pmsm drive GenerateHDL'")
2. Modify the Fixed-step size to Ts/4 because the default Number of Iterations is 4.

3. Remove the PMSM Controller and Permanent Magnet Synchronous Motor (Simulink)
subsystems from the Subsystem that contains the original Simscape model. Remove this
Subsystem and place the PMSM Controller subsystem with the HDL Subsystem at the top
level of the model.

model name = 'gmStateSpaceHDL ee pmsm drive GenerateHDL';

dut _name = 'gmStateSpaceHDL ee pmsm drive GenerateHDL/HDL Subsystem';
open_system(model name)

set param(model name, 'SimulationCommand', 'Update")
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4. Inisde the HDL Subsytem, the HDL Algorithm Subsystem has a Valid Out signal. Place
the Permanent Magnet Synchronous Motor (Simulink) subsystem inside an Enabled
Subsystem and connect the vs LL input port to the Valid Out signal.

open_system(dut _name)
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5. Inside the Permanent Magnet Synchronous Motor (Simulink) subsystem, several
Discrete-Time Integrator blocks have the sample time as Ts. Change the sample time of
these blocks to - 1. The Integrator with Wrapped State (Discrete or Continuous) block is
not compatible for HDL code generation. Replace the Integrator with Wrapped State
(Discrete or Continuous) with this Wrapped State DTI Subsystem.

open_system([dut _name,'/Enabled Subsystem/Permanent Magnet Synchronous Motor (Simulink
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6. Simulate the model. If the simulation displays errors that indicate a rate mismatch, add
Rate Transition blocks between the ports that resolve this mismatch. Inside the Out
Signals Subsystem, to provide the output signals to the Scope block at the same rate,
place Rate Transition blocks.

open_system([model name,'/Out Signals'])
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Generate HDL Code

Before you generate HDL code, to compare the output of the generated model after code
generation with the modified Simscape plant model, specify validation model generation.

hdlset param(model name, 'GenerateValidationModel', 'on');

To learn more, see Generated Model and Validation Model.

To generate HDL code, run this command:
makehdl('gmStateSpaceHDL ee pmsm drive GenerateHDL/HDL Subsystem')

By default, HDL Coder generates VHDL code. To generate Verilog code, run this
command:

makehdl('gmStateSpaceHDL ee pmsm drive GenerateHDL/HDL Subsystem', 'TargetLanguage', '

The code generator saves the generated HDL code and the validation model in the
hdlsrc folder. The generated code is saved as HDL Subsystem tc.vhd. To see the
resource usage information of your design, view the Code Generation Report.
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To open the validation model, after you generate HDL code, open the
gm _gmStateSpaceHDL ee pmsm drive GenerateHDL vnl.slx model.

See Also

Functions
checkhdl | makehdl

More About

“Generate HDL Code from Simscape Models” (HDL Coder)

“Deploy Simscape™ Plant Models to Speedgoat FPGA I/O Modules” (HDL Coder)
“Validate HDL Implementation Model to Simscape Algorithm” (HDL Coder)
“Simscape HDL Workflow Advisor Tips and Guidelines” (HDL Coder)

“Getting Started with Simscape Electrical”
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Validate HDL Implementation Model to Simscape
Algorithm

If you design your algorithm by using Simscape switched linear blocks, you can run the
Simscape HDL Workflow Advisor to generate an HDL implementation model. The HDL
implementation model represents the Simscape algorithm by using Simulink blocks that
are compatible for HDL code generation.

Before you prototype the implementation model on an FPGA or target Speedgoat FPGA
[/O modules, you can verify the functionality of your design in the Simulink modeling
environment. To verify the functionality, specify insertion of validation logic in the HDL
implementation model when you run the Simscape HDL Workflow Advisor. This logic
verifies whether the numeric results of the HDL implementation model match the original
Simscape algorithm.

In some cases, there can be a mismatch in simulation results between the Simscape
algorithm and the corresponding HDL implementation. Such mismatches generate
warnings or assertions when you simulate the implementation model. To resolve the
warnings, use a combination of various settings in the Generate implementation model
task as illustrated below.

Bridge Rectifier Model

This example uses the bridge rectifier model to illustrate how to generate an
implementation model with validation logic inserted in the model, and how you can
resolve any assertions that may be generated when you simulate the implementation
model.

1 Open the bridge rectifier model. In the MATLAB Command Window, enter:

open_system('sschdlexBridgeRectifierExample")
open_system('sschdlexBridgeRectifierExample/Simscape system')

Inside the Simscape_ system, you see four diodes arranged in a bridge
configuration. For both positive and negative input values, this configuration provides
a positive, rectified output.
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2 Open the Simscape HDL Workflow Advisor for your model:

sschdladvisor('sschdlexBridgeRectifierExample')

3 Right-click the Get state-space parameters task and select Run to Selected Task
to run all tasks in the Advisor except for the Generate implementation model task.

4 Inthe Generate implementation model task, select the Generate validation
logic for the implementation model check box. Leave the other options with their
default values and select Run This Task.
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Gei te implementation model

W Li Simscape HDL Workflow Advisor
b Li Code generation compatibility
o Check solver configuration
o “Check switched linear
v Li State-space conversion
o Extract equations
o Discretize equations
b Li Implementation model generation
o Generate implementation model

Solver Settings

Solver method: Iterative Mumber of solver iterations | 3

Implementation Model Settings
Floating-point predision
@) Single
() Double
() Single coeffidient, double computation What's Thic?

Verification Settings

Generate validation logic for the implementation model

Run This Task
Result: o Passed

Passed
Generated implementation model 'gmStateSpaceHDL. _sschd

How to Change This?

Validation logic tolerance

lexBridgeRectifierExam’.

Help

Apply

After running this task, keep the UI window for this task open. If simulating the HDL
implementation model generates warnings, you modify the settings in the Generate
implementation model task and then rerun this task. You do not have to modify or

rerun other tasks.

5 Click the link to open the HDL implementation model. You see a Validation

Subsystem that compares the simulation results of the Simscape model to the HDL
implementation model. Simulate the implementation model.
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Validabion

You see that simulating the model generates multiple assertions indicating a mismatch in
the simulation results. If you open the Diagnostic Viewer, you see this message:

Assertion detected in
‘gmStateSpaceHDL BridgeRectifier HDL SimMismatch/Validation/Check
Static Rangel' at time 0.04186 [4982 similar]

The message indicates that the Simscape™ algorithm does not match the equivalent HDL
implementation. To resolve the validation mismatch, you can modify various settings in
the Generate implementation model task until the HDL implementation model
matches the Simscape algorithm. In most cases, to resolve the numeric mismatch, you
may want to use a combination of these settings.

Increase Validation Logic Tolerance

Conversion of a Simscape algorithm to an equivalent HDL implementation leads to
rounding errors. By default, the Validation logic tolerance is set to 1e-12. This
tolerance value is relatively small and can be difficult to achieve especially with single-
precision data types in the HDL implementation model. To resolve the mismatch:



Validate HDL Implementation Model to Simscape Algorithm

Start by increasing the Validation logic tolerance to an initial value such as le-4.

Select Generate validation logic for the implementation model and run the task
to generate the HDL implementation model that includes validation logic.

3 Simulate the model and check whether the simulation displays assertions in the
Diagnostic Viewer. If the simulation results produce warnings, proceed to the next
step to increase the number of solver iterations.

Increase Number of Solver Iterations

For each mode in the physical system, the switched linear workflow arrives at a state-
space representation. The solver method is iterative and performs multiple computations
to determine the correct mode for the next time step. After a certain number of iterations,
the output value from the next time step becomes the same as the value from the previous
time step. This consistency in the output value indicates the correct number of solver
iterations.

To improve the numeric accuracy of the generated HDL implementation model and
resolve the mismatch, increase the number of solver iterations. This flowchart illustrates
how to change the Number of solver iterations.
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assertions?

h 4

Yes

Note When you increase the number of solver iterations, the code generator changes the
sample time of the generated HDL implementation model. A large number of iterations
can increase the simulation time significantly.
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Use Larger Floating-Point Precision

You can use the Floating-point precision setting in the Generate implementation
model task to specify the floating-point data type you want to use for the algorithm inside
the HDL Subsystem. Specify whether you want to store the matrix coefficients in
single or double data types and whether to use single or double when performing

the computations.

Floating-Point Precision

Description

Double Using double floating-point precision increases the
numerical accuracy of the generated model. Using
double data types in your model can increase the area
consumption and reduce the target frequency.

Single This is the default setting for floating-point precision.

Single coefficient,
double computation

This mode offers a tradeoff between Single and
Double modes of floating-point precision. To save
memory usage, the coefficients that are stored in
single. The matrix computations are then performed
in double for improved accuracy.

This flowchart illustrates how to change the Floating Point Precision and improve the
numeric accuracy of the generated HDL implementation model.
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Note Double-precision operations have large latencies and require a large
Oversampling factor to allocate sufficient delays for the floating-point operations, which
reduces the sampling frequency. For a tradeoff between accuracy and precision, use
Single coefficient, double computation asthe Floating Point Precision.
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After specifying double data types, if the simulation results still produce warnings:

1  Proceed to the first step to further increase the validation logic tolerance. Use a
tolerance value of 1e-03 and then simulate the model to see if the numeric accuracy
requirements are met.

2 Increase the number of solver iterations if you still see warnings in the Diagnostic
Viewer. Continue iterating between these steps till the HDL implementation model
numerically matches the Simscape algorithm.

For the bridge rectifier model, to resolve the warnings, set the Validation logic
tolerance to 1le-4 and specify the Floating Point Precision as double. After you
generate the implementation model with the validation logic, you see that simulating the
model does not display warnings in the Diagnostic Viewer.

See Also

Functions
simscape.findNonlinearBlocks | sschdladvisor

More About

. “Generate HDL Code from Simscape Models” (HDL Coder)

. “Simscape HDL Workflow Advisor Tasks” (HDL Coder)

. “Simscape HDL Workflow Advisor Tips and Guidelines” (HDL Coder)

. “Deploy Simscape™ Plant Models to Speedgoat FPGA I/O Modules” (HDL Coder)
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Improve Sampling Rate of HDL Implementation Model
Generated from Simscape Algorithm
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If you design your algorithm by using Simscape switched linear blocks, you can run the
Simscape HDL Workflow Advisor to generate an HDL implementation model. When you
open the HDL implementation model, you see the HDL algorithm that models the state-
space representation by using Simulink blocks that are compatible for HDL code
generation. To learn more about the Simscape HDL Workflow Advisor, see “Simscape HDL
Workflow Advisor Tasks” (HDL Coder).

Sampling Frequency

When you generate HDL code and deploy the plant model onto an FPGA, you may want to
improve the sampling frequency. The sampling frequency depends on these parameters:

* FPGA clock frequency
* Oversampling factor
* Number of solver iterations

Sampling Frequency = FPGA clock freguency | (Oversampling factor = Number of solver iterations)

To improve the sampling rate, you want to maximize the FPGA clock frequency, and
minimize the oversampling factor and number of solver iterations. As you improve the
sampling rate, make sure that the updated sampling frequency is equivalent to the fixed
sample time that you specify for your original Simscape model by using the Solver
Configuration block. To learn more about how this block is used in your model before
running the Simscape HDL Workflow Advisor, see “Generate HDL Code from Simscape
Models” (HDL Coder).

The preceding section uses the boost converter model as an example to illustrate how you
can modify the oversampling factor and the number of solver iterations to improve the
sampling rate.

Boost Converter Model

This example uses the boost converter model to illustrate the change in sample time in
the generated HDL implementation model and the oversampling factor that is saved on
the model.
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\- doul r

Open the boost converter model. To learn how the boost converter is implemented,

open the Simscape system Subsystem. To open the boost converter model, in the
MATLAB Command Window, enter:

open_system('sschdlexBoostConverterExample')
open_system('sschdlexBoostConverterExample/Simscape system')
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You see that the model runs at a sample time 1e-6. The sample time of 200e-9
corresponds to the sample time of the sources that drive the Simscape algorithm.

Open the Simscape HDL Workflow Advisor for your model:

sschdladvisor('sschdlexBoostConverterExample')

Run the workflow to the Generate implementation model task.

After running this task, you see a link to the generated HDL implementation model.
Click the link to open the HDL implementation model.

Simulate the HDL implementation model. When you navigate the model to the HDL
Algorithm Subsystem, you see that the model uses single data types and runs at a
sample time 200e-9, which is 5 times faster than the original Simscape model.
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5 Run this command to see the HDL parameter settings that are saved on the model:

hdlsaveparams('gmStateSpaceHDL sschdlexBoostConverterExamp')

%% Set Model 'gmStateSpaceHDL BoostConverter HDL' HDL parameters

hdlset param('gmStateSpaceHDL BoostConverter HDL', ...

'FloatingPointTargetConfiguration', hdlcoder.createFloatingPointTargetConfig('NativeFloatingPoint'
, 'LatencyStrategy', 'MIN') ...

)
hdlset param('gmStateSpaceHDL BoostConverter HDL', 'HDLSubsystem', 'gmStateSpaceHDL BoostConverter HDL');
hdlset param('gmStateSpaceHDL BoostConverter HDL', 'MaskParameterAsGeneric', 'on');

hdlset param('gmStateSpaceHDL BoostConverter HDL', 'Oversampling', 60);

% Set SubSystem HDL parameters
hdlset param('gmStateSpaceHDL BoostConverter HDL/HDL Subsystem', 'FlattenHierarchy', 'on');

% Set SubSystem HDL parameters
hdlset param('gmStateSpaceHDL BoostConverter HDL/HDL Subsystem/HDL Algorithm/State Update/Multiply State',
'SharingFactor', 1);

The HDL parameters that are saved indicate that the model has the native floating-point
mode enabled and uses an Oversampling factor of 60 and has Latency Strategy set to
MIN. This default combination of HDL parameters offers an optimal trade-off between
oversampling factor and the target FPGA clock frequency and improves the sampling
frequency. If you want to further improve the sampling frequency, you can reduce the
number of iterations and the oversampling factor as illustrated below.

Reducing Number of Solver Iterations

For each mode in the physical system, the switched linear workflow arrives at a state-
space representation. The solver method is iterative and performs multiple computations
to determine the correct mode for the next time step. After a certain number of iterations,
the output value from the next time step becomes the same as the value from the previous
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time step. This consistency in the output value indicates the correct number of solver
iterations.

To improve the sampling rate, you want to reduce the number of solver iterations. The
number of solver iterations depends on various factors such as the complexity of your
design, the number of modes in the design that the workflow must calculate, and so on.

In the Generate implementation model task of the Simscape HDL Workflow Advisor:

Start by reducing the Number of solver iterations to a value such as 3

2 Select Generate validation logic for the implementation model, and then
generate the HDL implementation model.

3 Simulate the HDL implementation model and open the Diagnostic Viewer to verify
that the model does not display warnings or assertions.

If you see warnings or assertions, it indicates a simulation mismatch because the number
of solver iterations that you specified is not adequate to compute the required number of

modes in the state-space design. To learn how to resolve the mismatch, see “Validate HDL
Implementation Model to Simscape Algorithm” (HDL Coder).

Note To resolve the mismatch, it is recommended that you do not change the Floating-
point precision to double. Double-precision operations have large latencies and require
a large Oversampling factor to allocate sufficient delays for the floating-point
operations, which reduces the sampling frequency.

Using Oversampling Factor and Latency Strategy

The Oversampling factor specifies the factor by which the FPGA clock rate is a multiple
of the HDL implementation model base sample rate. The HDL implementation model
contains feedback loops and performs multiplication of large matrices that have floating-
point data types inside the feedback loops. To accommodate the large latency introduced
by these floating-point operations inside the feedback loops, the code generator uses a
large value of oversampling factor in conjunction with the clock-rate pipelining
optimization on the model. For more information, see “Strategy 1: Global Oversampling”
(HDL Coder).

You vary the oversampling factor and latency strategy of the floating-point operator in

conjunction. The default oversampling factor of 60 and minimum latency strategy gives
an optimal sampling frequency. To achieve the maximum FPGA clock frequency, use the
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maximum latency strategy. When you specify this latency strategy, the floating-point
operations introduce the maximum number of delays. To allocate these delays, increase
the oversampling factor. If the increase in FPGA clock frequency outweighs the increase
in oversampling factor, you achieve a higher sampling frequency.

To change the latency strategy and oversampling factor in conjunction from the
Configuration parameters dialog box:

1 Onthe HDL Code Generation > Floating Point pane, change the Latency
Strategy to Max .

2 Onthe HDL Code Generation > Global Settings pane, increase the
Oversampling factor to a value such as 100 depending on the complexity of your
HDL design.

For the boost converter model, the default settings of Number of solver iterations set
to 5, Oversampling factor set to 60, and Latency Strategy set to Min provides the
optimal sampling frequency.

See Also

Functions
simscape.findNonlinearBlocks | sschdladvisor

More About

. “Solvers for Real-Time Simulation” (Simscape)

. “Simscape HDL Workflow Advisor Tips and Guidelines” (HDL Coder)

. “Latency Considerations with Native Floating Point” (HDL Coder)

. “Deploy Simscape™ Plant Models to Speedgoat FPGA I/O Modules” (HDL Coder)
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